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Preface

The purpose of this manual is to provide users with instructions on using the VistA Imaging
Background Processor (BP) V. 3.0 software and system components. It includes explanations of
the options and controls available from the VistA Imaging Background Processor. Instructions
are provided about how to perform various system tasks.

Note: Additional information about the various VistA Imaging components such as servers,
workstations, Remote Procedure Call (RPC) Broker software, and OTG-Disk Extender jukebox
software can be found in the VistA Imaging Installation Guide.

The VistA Imaging System documentation suite includes...
e Release Notes

e Installation Guides

e Security Guide

e Technical Manual

e User Manuals

This manual is also available at: http://vaww.va.gov/imaging

Terms of Use

Use of the Background Processor is subject to the following provisions:

|
*”" Caution: Federal law restricts this device to use by or on the order of either a licensed
practitioner or persons lawfully engaged in the manufacture or distribution of the product.

|
*” No modifications may be made to the software workstation without the express written
consent of the VistA Imaging National Project Manager.

Intended Audience

This software should be maintained by trained Imaging Coordinators who have IT experience
and a thorough knowledge of the Imaging product.

Conventions
This document uses the following conventions:
e Change bars in margins indicate content added or updated since the last revision.
e Controls, options, and button names are shown in bold.
e Keyboard key names are shown in bold and in brackets <>.
e Sample output is shown in monospace.
e  When this document is used online, hyperlinks are indicated by blue text.
e Useful or supplementary information is shown in a Tip.

e Required or important information is shown with the word Note or Important.
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|
e Critical information is indicated by % .
Related Information
The VistA Imaging System documentation suite includes:

e Release Notes

Installation Guides

Security Guide
Technical Manual

Note: Additional information about the various VistA Imaging components such as servers,
workstations, Remote Procedure Call (RPC) Broker software, and OTG-Disk Extender Jukebox
software can be found in the VistA Imaging Installation Guide.

VistA Imaging Support

If you encounter any problems using VistA Imaging Background Processor, which cannot be
resolved follow your local, VISN, or regional procedures for problem resolution/escalation.
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Chapter 1 Introduction

1.1. What is the Background Processor?

The VistA Imaging System is an extension to the Veterans Health Information System
Technology Architecture (VistA) hospital information system that captures clinical images,
scanned documents, motion images, and other non-textual data files and makes them part of the
patient's electronic health record (EHR).

The VistA Imaging Background Processor (hereafter, referred to as the Background Processor or
BP) is a component in the VistA Imaging System. The BP runs on a Windows file server. The
Background Processor ensures the archiving of DICOM and clinical images from Tier 1
(configured in RAID groups) onto the Tier 2 shares for long-term storage. These images are
stored indefinitely on the archive device.

1.1.1. Background Processor Applications
The Background Processor consists of three applications:

e BP Queue Processor
The Queue Processor moves image data between Tier 1 and Tier 2 or remote location.
e BP Verifier

The Verifier maintains location integrity and checks data integrity between the VistA
database and the storage media.

e BP Purge
The BP Purge removes image files from the Tier 1 Image shares based on file dates.

The combination of these applications ensures that users can access the images for display and
analysis in an efficient and timely manner. The three applications are explained in the chapters
that follow.
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1.2. VistA Imaging and the Background Processor

The diagram below shows a network configuration of the VistA Imaging system. The system
requires a minimum bandwidth of 100MB/sec.

Typically, the Clinical workstations and EKG systems are on this span.

The VistARad workstations, Tier 1, and Tier 2 are required to reside on a span that has a
1GB/sec bandwidth.

This high bandwidth results in faster viewing times for studies on those VistARad workstations.

VistA Imaging Network Topology
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PP P RS U

Fast Ethernet

EKG Management System and EKG Carts

Imaging File Servers

Shat Term Lefg Tearm
Storage Archive

DIcom Background
Procassor®

Main hospital backbone

- | Lo . Lo . e ' | :
T T T .
CROR CRIDR CRDR T

DICOM-compliant Acquisition Madalities

1.3. VistA Imaging Functional Flow

The diagram below shows the functional flow of the VistA Imaging system related to the
Background Processor products. Images originate from a variety of sources and are stored for the
short term on Tier 1. The Background Processor's Queue Processor copies these images to Tier
2, where they are stored permanently. The Background Processor's Purge application manages
free space on Tier 1 by deleting older images. The Queue Processor can restore these images to
Tier 1 when requested by the display workstations. The Background Processor's Verifier

Vista Imaging Functional Flow
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application maintains the integrity of image records, including location pointers, stored in the
VistA database.
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1.4. Features of the Background Processor

The Background Processor provides the following features:

Manages image storage on various shared network devices
Migrates image files between magnetic VistA Imaging shares and jukebox storage units
Maintains adequate free storage space on VistA Imaging shares

Copies image files to the VistA Imaging shares whenever they are requested by image
display workstations

Validates VistA Imaging network file references

Verifies the integrity of the location of image files on Imaging shares recorded in the
VistA database

Configures local VistA Imaging site parameters
Manages error recovery

Logs activities and errors

Imports images into VistA Imaging

Exports images from VistA Imaging.

1.5. The Background Processor Usage and Maintenance of RAID Groups

A RAID Group is a group of one-to-many shares that will be recognized as a unit within the
Imaging storage network. Its purpose is to reduce the number of active storage shares to facilitate
quicker tape backups (both incremental and full). Newly acquired images are distributed evenly
among all the shares within a RAID Group.
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Visual example of a RAID GROUP with Group C set as the current write location.
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1.5.1. RAID Group Guidelines
¢ Distribute the shares among multiple RAID Groups.

e Fill the shares in each group to the Server Size, then switch the current RAID group to
the next.

e New image files will be distributed over all the shares assigned to that group.

¢ Nightly incremental tape backups as well as monthly/quarterly tape backups must be
done only on active RAID Groups.

e When it has reached capacity, a final full backup should be done on all the shares and
nightly incremental tape backups and monthly/quarterly tape backups started on the next
current write group.

1.5.2. Scheduling a RAID Group Advance

A RAID Group Advance can be scheduled, as follows:

You may choose to establish a pattern to utilize your entire RAID by scheduling a weekly RAID
Group Advance and coordinating this with a scheduled purge followed by weekly backup of the
RAID Group that was most previously active. See section 3.5.3, RAID Group Advance Settings,

for details.

An automatic RAID Group Advance occurs, as follows:

When the used space on all the shares in a RAID Group exceeds the high-water mark, the
software will change the current write RAID Group to the next one in sequence. This event will
be captured in the BackProc.log file. See section 3.2.2.1 Storage Functions Settings, for more
details.

A diagram of the changing of a RAID Group follows.

Auto-Purge Breached
When the % Server Reserve
within the RAID Group nage Group C
multiplied by the Purge Factor Iage Group & <::| (.;Z;ML.
has been breached, an Group)

Alto-Purge is triggered for the

next RAID Group. % 5[

The Purge Factoris a number
that can be adjusted by the site
to offset the length of time a
purge will take. Default = 1.
Setitto 2 once you populate
the next RG.

Imagqe Group B
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1.5.3. Additional Maintenance of Tier 1
The following utilities support the Background Processor:

e MagDexter used to create summary and detail platter reports containing platter
information such as the name, serial number, and status of each jukebox platter

e MagKat used to backfill specific fields in the IMAGE file (#2005) in the VistA database
using data from the text files associated with images

e MagUtility used to report and resolve problems with “orphan” files, delete obsolete or
incorrect entries from the NETWORK LOCATION file (#2005.2), update the VistA
database with image information, and copy images and text files

For details, see the Storage Utilities User Manual.
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Chapter 2 Setting Up Your BP System

e Software Requirements

e Hardware Requirements

e Setup Requirements -Security
e Installing the BP software

e Configuring BP Servers

This chapter provides all the steps necessary to set up your Background Processor system.

Note: Configuration information that applies to site requirements is explained in Chapter 3
Configuring the Application.

2.1 Software Requirements

The Background Processor software, MagBPSetup.exe, is distributed with the VistA Imaging
system. Three components are included in this file: the Queue Processor, the Verifier, and the
Purge software.

The Background Processor software presumes the presence of the proper Imaging KIDS package
installed on VistA. Refer to the most recent Imaging Patch Description for the Background
Processor for compatibility information. Once they are installed, the executables for the
Background Processor applications are in the Program Files\Vista\Imaging\BackProc directory
and are named:

Patch 214
e Magbtm.exe - Queue Processor

e MagVerifier.exe -Verifier

MagPurge.exe - Purge.

2.2 Hardware Requirements
e 20 GB local disk space (minimum)
e 1 GB RAM (minimum)

e Server class machine (The BP can be run on Image servers. However, the Schedule and
Auto events (Verifier & Purge) only execute on a Server class machine.) To run patch
MAG*3.0*214 executables, the minimum must be Windows 2012 server.

e 100MB/sec network bandwidth or better

e Local or remote archive device — jukebox, storage grid, etc. (when possible).
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2.3 Setup Requirements

There are some initial checks that must be done on the server/client where the BP will run and on
the VistA system where Caché will exist. The following sections describe the setup requirements
on each platform.

2.3.

232

1

Windows Security

Use the established Windows Imaging Administrator (VHAxxxIA) account for accessing
the Background Processor.

The Imaging Administrator account is a domain account that has READ/WRITE
permissions to the Imaging Tier 1 and Tier 2 shares. This account will be used to log into
the BP Server.

Remote IMPORT share permissions must match the Windows OS login on the server
running the BP software.

Remote EXPORT share permissions must match the Windows OS login on the server
running the BP software.

The Imaging Administrator account is a domain account that has READ/WRITE
share/folder/file permissions on the Imaging Tier 1 shares and Tier 2 shares (see the
Imaging Installation Guide) to the Windows account that will log into the BP Server.

VistA Security

The Background Processor requires authentication to VistA via a Broker connection to
function. This account must have the following permissions:

MAG SYSTEM security key
All MAG* RPC's [MAG WINDOWS] secondary menu option.

Since it is essential that the Background Processor can continue to perform its function,
without human interaction, a site can establish a special “service account” for which the
access and verify codes will not expire. When a Background Processor loses a network

connection because of an interruption, it is important that the Background Processor have
access to a continuously available service account to reestablish connectivity without user
interaction. See the section 5.3 in the DICOM Gateway Installation Guide for information

on how to initially set up this account if not done already.

The VistA Imaging service account for VistA should be assigned one account per
division. This is required because each division is defined by an entry in the IMAGING
SITE PARAMETERS file (#2006.1).

Note: When an end-user signs into the VistA database, the user’s default division is used
or the Division selected at log-on when an end-user has multi-divisions assigned.

The credentials for the VistA Imaging service account for VistA should be entered into
the following fields in the IMAGING SITE PARAMETERS file (#2006.1). They are the
Service account Access/Verify codes.

o DICOM GATEWAY ACCESS CODE (field #124)

o DICOM GATEWAY VERIFY CODE (field #125)
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2.3.2.1 Security Keys, RPCs, and Menu Options in VistA
Both the primary and Service accounts should have the security access listed.
e MAG SYSTEM as a security key
e All MAG* RPCs
e MAG WINDOWS as a Secondary Menu Option.

2.4 Installation

Follow the information contained in the Patch Description document for installing both the
KIDS and the client software. Both installations are mandatory for operating the BP software.

2.4.1 Client Requirements

Desktop Icons used in Patch 214

oy ez oy
VB p VB ; VB I;

Purge Verify

Magbtm.exe MagPurge.exe MagVerifier.exe

Version control will change when the MAG*3.0%214 KIDS is installed. The supported BP Client
versions will be: Patch 135, Patch 196, Patch 198, Patch 214.

Note: When a user enters invalid Access/Verify Codes while logging into VistA, the system
gives them an error message.

Error I

[0] Mot a valid ACCESS CODE/VERIFY CODE pair,

In Patch 214, the Error message is hidden under the main Vista Sign-on window. The user has to
move the VistA Sign-on window, then click 'OK' in the Error message window to be able to
continue. A fix for this issue is scheduled for a future Background Processor patch.

Important: Any Background Processor applications that are running must be stopped and
closed prior to the installation of the KIDS and Client software. Any image capture application
(Clinical Capture and DICOM Gateway processing) can continue to run during the installation.
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2.5.1

2.5.2

2.5 Configuring BP Servers
Guidelines

It is necessary to configure a BP Server only if the site is capturing images for storage on
VistA Imaging servers.

At least one BP Server must be present to perform utility functions such as copying
image files to and from Imaging servers (the Tier 1 shares) and Tier 2 (a jukebox/storage
grid).

The software does not permit redundant assignments of BP activities. For example, you
cannot specify that more than one BP Server perform the JUKEBOX task.

The JUKEBOX and DELETE tasks must be run on the same server. If not, the Deletes
may be processed in advance of their being written to the Jukebox. In this case, the image
may be lost before it is archived and the Delete will eventually fail. These Failed Deletes
must be Re-Queued.

The IMPORT and ABSTRACT tasks should be run on the same server. There will be
occasional archived FULL files that do not have abstracts. If these ABSTRACT tasks are
failing, the JBTOHD task should be added to server running the IMPORT/ABSTRACT
task. Please note the IMPORT can execute on a single server.

If the Verifier and Purge are to be run on servers other than those running the Queue
Processor tasks, a BP Server must be configured for those servers.

When PREFET is added to the VistA Imaging display workstation configuration, this
activity must be checked on the BP Server configuration window in order to have these
queue types processed.

A directory can be created on the Tier 1 shares or remote storage location to archive BP
log files for later reference.

Adding a BP Server to the VistA Imaging System

Most sites will find that a single BP Server provides adequate performance; however, the product
does provide the capability for adding additional BP Servers. Adding additional BP Servers will
improve performance by allowing the distribution of tasks among the newly assigned BP
Servers.

10
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To set up a BP Server application:

1. From the Windows Start > Programs menu, select VistA Imaging Programs >
Background Processor > Queue Processor.

2. Enter the Access/Verify code for the BP account with the VistA security properties listed
in section 2.3.2 VistA Security.

The BP Queue Processor application window opens.

— ™
#9 BP Queue Processor - BP Server: GEKGFE - VACOLTKIRINGA - Site: SALT LAKE CITY - iEr cuser names e o5 ]

File Edit View Help
Visth Storage <patch #> |1I]:5:12AM |

Network Location Name |Storage Type |IEN |Free Space |Disk Size

D Start ()] Stop |

Queue | Active | Failed |

<[ b

Background Processor Event Log

Event Time Process: Queue IEN |Process Status |~

3. From Queue Processor menu bar, select Edit > BP Servers.

| Edit | View Help

Irmaging 5ite Parameters

Mail Messages

Mail Groups

Purge / Verifier / RG Settings

BP Servers

Queue Manager »
Metwork Location Manager

Refresh Queue Counts

Set Queue pause (delay)

The BP Server Parameters window enables you to create a unique server name for a
server and assign tasks to that server. The properties on these servers enable you to
specify the location of the log files for each application and the file’s size limit (described
in section 2.5.5, Specifying the Log File Location and Size).
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et { * BP Server Parameters (=]
Imaging Site Parameters | Mail Messages | Mail Groups | Purge fVerifier / RG Settings ‘ BPF Servers ‘ Queue Manager

Background Processor Servers
L) ABSTRACT
] BAF
El] Unassigned Tasks
] PURGE

-] SCHEDULED VERIFY
4 JUKEBOX
-] JBTOHD

(4 DELETE

Add New BP Server |

' OK | X Cancel | & Aply | ? Heln |

4. Click the Add New BP Server button at the bottom of the tree pane.

5. In the BP Server Add dialog box displayed, enter a logical name for the BP Server, for
example, BP1.
Note: The name must be at least three characters in length and can contain alpha and
numeric characters and must be unique. Once the name is saved, it cannot be renamed. It
can only be deleted when all the tasks assigned to it are de-assigned.

‘_I 'BP Server Add [ [O] x|
BP Server edits

Logical Name (ie BP1) |

© arvr Naens | {senernamel

BR add +% Cancel

If the name is not valid, an error message is displayed. Correct the name and repeat the
steps.

2.5.3 Assigning Tasks (Queues) to a BP Server

By default, no tasks are assigned to BP Servers. The tasks will need to be assigned for that
function of the BP software to operate. Assign tasks based on the needs of your facility. As
previously mentioned, a queue name identifies the task that the Queue Processor performs. All
queues are available to assign to a BP Server, except EVAL.

Note: Assign Purge as well as the Scheduled Verify to BP Servers. These features help maintain
the system without operator monitoring and control.
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1. Drag and drop a task from the Unassigned Tasks in the tree pane (shown) to the server that is
designated to run that task.

7 f SALT LAKE CITY * BP Server Parameters

Imaging Site Parameters | Mail Messages | Il

Background Processor Servers

i3] PURGE

4] SCHEDULED VERIFY
i ABSTRACT

il JUKEBC,

i3 JETOHD

i3] PREFET

i IMPORT

- GCC

i3] DELETE

Note: The priority of tasks running on the same server is set internally and cannot be
changed. The functions of each task are:

1)

2)

3)

4)

5)
6)
7)
8)

JBTOHD - populates the VistA Imaging shares with images that have been deleted
from the Tier 1 shares through the Purge function.

PREFET — populates the VistA Imaging shares with images that were requested
based on VistA Imaging Display workstation configuration parameters.

ABSTRACT - creates ABS derivative thumbnail files from FULL/BIG files when
the file type is missing on the Tier 1 shares and Tier 2 (jukebox)

IMPORT - provides a means for external applications to archive images in the VistA
Imaging environment.

JUKEBOX — copies images to the long-term archival storage device
DELETE - removes images from the VistA Imaging shares.
GCC — exports images to a share that is external to the local VistA Imaging network.

PURGE - This assignment includes both the auto purge and the scheduled purge
tasks. Refer to the purge section of this document for more details.
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9) SCHEDULED VERIFY - automatically runs the Verifier at the assigned time to
check the integrity of the Image records in VistA with the file locations on Tier 1 and

Tier 2 storage. Only the most recent unchecked IENs are verified.

2. Click Apply to save the changes or OK to save the changes and exit.
2.54 Removing a BP Server from the VistA Imaging System
1. From the Queue Processor menu bar, select Edit > BP Servers.
2. In the tree pane, right-click the server name and select Delete BP Server from the pop-up

menu displayed.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

Background Processon Servers

L[F‘

4 D Delete BF Sen.re_r
U G Server Properties
il SAF

#-cf) Unassigned Tasks

The selected BP Server is removed from the tree pane.
Note: This same name can be added later.

2.5.5 Specifying the Log File Location and Size

1.

14

Click a BP Server name in the tree pane and select Server Properties from the pop-up menu

displayed.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

Backgiound Frocessol Servers

Wi

+ l__u D

iy G
il SAF

-l Unassigned Tasks

Delete BE Server
Server Properties

The BP Server Properties dialog box is displayed.

ﬁ BP Server Properties * BPT * fuxernamef [_ O[]
Client Executable Yersion :  30.1.39.23
Client Distribution Date:  DEC 23, 2009
BPOS: ‘in Server5.2.3790
Last Execution Date:  MAR 11, 2010

Log file Size (MB) :

MNetwork Log file location I‘ J

g/ OK | x Cancel | {} Lpply | ? Help

Enter the size in megabytes in the Log File Size field.
The default log file size limit is 2 MB.
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3. Specify the Network Log file location on a local machine or a remote network location.

Note: By default, the log files are created on the local drive in the directory Program
Files\VistA\Imaging\BackProc\Log. If a remote network location is entered, the Background
Processor must have Read and Write access to it. Use the \\computer name\share name
format and do not use a letter drive.

4. Click OK to save the information and close the window.

2.6 New Server Installation

MAG*3.0*214 contains all the Background Processor and Background Processor utility
applications. It will install on a new server that hasn’t had a previous BP installed.

Desktop shortcuts for the Purge, Verifier and Background Processor Queue Processor are
automatically created on the desktop.

When installing the BP Queue Processor, BP Verifier, and BP Purge on a 64-bit operating
system such as Windows 2012 Server, “Run as administrator” must be manually set using the
check box in the Advanced Properties window on each of the desktop shortcuts and the
menu options. Do this for all three client applications.

If the MAG*3.0*214 Background Processor client is installed before installing the
MAG#*3.0*214 KIDS, when the client is run, a message will display that states the versions of
the Background Processor client and the version of the VistA Imaging host system are not
compatible. The user will be prompted to install compatible versions of the Background
Processor client and the VistA system host software. If such a message displays, complete the
following steps:

1) Shut down the Background Processor client.
2) Install the MAG*3.0*214 KIDS.
3) Now run the MAG*3.0*214 Background Processor client.
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Chapter 3 Configuring the Application

Configuring the Imaging Site Parameters

Configuring Mail Messages

Configuring Mail Groups

Configuring the Purge, Verifier, and RAID Group Advance Settings
Configuring the Queue Manager

Configuring the Network Location Manager

3.1 Introduction

All the parameters for running the BP applications (Queue Processor/Verifier/Purge) are
managed through the Queue Processor GUI. There are multiple parameter windows to change
settings for each BP application. The parameter windows are accessed through the Edit menu on
the BP Queue Processor application menu bar.

3.1.1

Edit | View Help

Imaging Site Parameters |
Mail Messages l
Mail Groups |
Purge / Verifier / RG Settings

BP Servers

Queue Manager 2
Metwork Location Manager -
Refresh Queue Counts

Set Queue pause (delay) |

Overall Guidelines

The three BP applications (Queue Processor, Verifier, and Purge) are installed with a
default configuration. However, each of these applications will need to be configured
depending on how/when/where they are to be run. When the BP is first installed, review
the parameters to insure the products are set up according to your site’s needs.

A BP Server will need to be defined for each Windows server that will be running a task
and/or the Purge and/or Verifier.

A specific task (JUKEBOX, JBTOHD, IMPORT, etc.) on the Queue Processor can be
run only on one server.

A task must be assigned to a BP Server before that task will run when the Queue
Processor starts.
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Some parameter windows have Apply buttons. Be sure to click the Apply button to
commit changes to the database. (Cancel resets any changed parameters.) The windows
that do not have Apply buttons are committed when the change is made. The OK button
also commits the changes and closes the main parameter window.

3.2 Configuring the VistA Imaging Site Parameters

The parameters on the Imaging Site Parameters window control activities within the Queue
Processor as well as the DICOM Gateways, Clinical Capture, Clinical Display and VistARad.
The site parameters can be configured for these functionalities:

3.2.1

Access to the image shares
Service account login information
Routing share configuration
Display and capture workstations
DICOM Gateways

Jukebox configuration

RAID Groups configuration.

Imaging Site Parameters Window

The Edit > Imaging Site Parameters menu on the Queue Processor menu bar opens the Imaging
Site Parameters window used to modify entries in the VistA database. Each of the boxed areas in
the window i1s described below.

18
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Imaging Site Parameters

~Administrative

Current Namespace

—Clinical Workstation

Wyindows Timeaouts:

ISTORGFE Display |120 Capture I]gg VistARad I

Generic Carbon Copy
IHEC Use Capture Keys |+ Default MUSE Site # I'I
Current RAID Group IRG-GO]

Tier 1 Write Location

IpERCree Seanty (@ Site Code Ir Default User Preference ICAMP,E\GHTYE\GH(SE'I_I'INGU j

Associated Institutions YistARad Grouping
SALT LAKE DOM |

—Service Accounts

Windows Usermame |usemame

Wyindows Password
—Storage Functions

Tier 2 Write Location

YWistd Access
ILOCALJEIOX SALT LAKE CITY j

Wistd Verify
% Tier 1 Reserve I] ¥ Tier 2 Reserve ID
Auto Write Location Update ™

~DICOM interface
Multiple Mamespace File Types DICOM Gateway Write Location

|DM |T><T -
IE

DICOM Gateway Interface Switch Update [
Retention Days HL? - Modality Warklists |999

% Free Space DICOM Messages I
Retention Days DICOM Messages I

~Tel q
elereader

Met Site Service IVISTASITESERVICE

Timeout TeleReader I

3.2.2 Administrative Settings

—Administrative

Current Mamespace IGD

Tier 1 YWrite Location I j

Generic Carbaon Copy I j

Current RAID Group IRG—GDZ j

Import Queue Sacurity [ Site Code IQQQ

Associated Institutions WistARad Grouping

SALT LAKE DO ALBAMNY, MY
WASHIMNGTON, DC

September 2018 Background Processor User Manual, Rev 17

VistA Imaging MAG*3.0%¥214



20

Field or Checkbox

Descript ion

Current Namespace

Each VHA facility has its own unique 3-character designator.
The Current Namespace file is used to store this 3-letter facility
designator. It is used in Imaging as the first 3 characters of the
14-character name given to image files captured at this site. The
VistA Imaging development and support teams maintain a
central database with each site’s 3 letter designator. The Current
Namespace field is not configurable. This is necessary to ensure
that image file names across VHA are unique.

Tier 1 Write Location

All images from the gateways, Capture, etc. will be written to
this share. The selected Current RAID Group determines which
shares are listed on this dropdown list.

Generic Carbon Copy | Remote share where files will be exported. The share
permissions must match the login credentials for the BP Server.

Current RAID Group | The current active RAID Group includes the Tier 1 Write
Location (described above). When new images are processed,
they are stored on the Tier 1 Write Location share within this
group. The RAID Groups are set up with the Network Location
Manager.

Import Queue Checks users Imaging security keys for permission to capture

Security images.

Site Code Three-letter acronym for the site location. This is used for
AutoRouting and MUSE.

Associated This set of institution values will allow users from other

Institutions institutions to access local images.
Note: Right-clicking this field displays an Add/Delete pop-up
menu that can also be accessed from the keyboard by using
Shift + F10.

VistARad Grouping | The radiologist can lock/interpret exams for other divisions

(including the Parent Institution or other Associated

Institutions), when those divisions are included in this set of

institutions. Note that this setting controls exam locking and

updating, as well as filtering of the UNREAD Exams lists to

show only the Institutions that are defined here.

Note: Right-clicking this field displays an Add/Delete pop-up
menu that can also be accessed from the keyboard by using

Shift + F10.
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3.2.2.1 Storage Functions Settings

Storage Functions
Tier 2Write Location || OCALIBOX  SALT LAKE CITY -

% Tier1 Reserve 1 % Tier 2 Beserve |0

Auto rite Location Update W

Multiple Namespace File Types

F

Field or Checkbox Description

Tier 2 Write Location Tier 2 share where newly acquired images are currently
being written.

% Tier 1 Reserve The purpose of the reserve is to provide a significant
amount of reserved primary storage to allow time for
corrective action to create more space on the shares. Enter
an integer between 1 and 50. The system defaults to 5 if
the integer is outside the normal range.

When the used space on a share exceeds the specified
percentage, then actions are taken within the BP (mail
message sent, auto purging initiates (if scheduled).). In
addition, the AutoWrite Location Update will be disabled
and images will be written to that share until the free
space is exhausted.

% Tier 2 Reserve The default value is 5%. The values can be set in the
range 0-50%. When the allocated space does not meet this
watermark, then no JUKEBOX queues will be processed
and Tier 2 retrieval requests may be compromised,
depending on the Tier 2 technology.

Auto Write Location Update | At the interval of every 20 minutes or 100 images written
to a share, the Queue Processor will determine which
share within a group has the most space and will use that
share as the current write location for newly acquired
images.

To manually select a Tier 1 Write Location, uncheck the
Auto Write Location Update box. Images will be written
to the selected Tier 1 share until it is filled or manually
changed to another share.
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Field or Checkbox Description

Multiple Namespace List of all the legacy namespaces that have been used at a
site and are reflected in the filenames on Tier 1 and Tier 2
shares.

Note: Right-clicking this field displays an Add/Delete
pop-up menu that can also be accessed from the keyboard
by using Shift + F10.

File Types File extensions outside of the standard extensions that the
BP products will recognize and treat as a standard
extension file. These files will be copied from Tier 1 to
Tier 2 with the execution of a JUKEBOX Queue, and
copied from Tier 2 to Tier 1 with execution of a JBTOHD
of the parent file(s), FULL or ABS. They will be purged
from Tier 1 once the FULL file has purged.

TXT is a recommended member of this list.

Note: Right-clicking this field displays an Add/Delete
pop-up menu that can also be accessed from the keyboard

by using Shift + F10.
3222 TeleReader Settings
Telereadet
MNetSite Senvice  IvISTASITESERVICE] |
Timeout TeleReader  [1ap
Field or Checkbox Description
Net Site Service Used by the Remote Image Views application

to gain access to remote sites.

Timeout TeleReader The number of minutes that the TeleReader
application will remain active before closing
due to inactivity.
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3223 Clinical Workstation Settings

Clinical Workstation

Windows Timeouts:

Display 20 Capture 120 YistARad

Use Capture Keys W Default MUSE Site & |1

Default User Preference  |[CAMP.EIGHTYEIGH (SETTING 1) j

Field or Checkbox

Description

Use Capture Keys

Check users’ Imaging security keys for permission to
capture images.

Timeout Windows Display

Number of minutes until the Imaging Display
application will close due to inactivity. The default
setting is 120 minutes (Range 6 to 600).

Timeout Windows Capture

Number of minutes until the Imaging Capture
application will close due to inactivity. The default
setting is 120 minutes (Range 6 to 600).

Timeout VistARad

Number of minutes until the Imaging VistARad
application will close due to inactivity. There is no
default setting.

Default MUSE Site #

MUSE site number that the Imaging Display
application will connect to. Site numbers are usually
1,2, 3, .... If left empty, the field defaults to 1.

Default User Preference

A specified user’s parameter settings will be used for
first-time users of the Imaging system.

3224 Service Accounts Settings

These credentials are shared among the DICOM Gateway, Image cluster, Jukebox Server, and

Background Processor.

—Service Account

Wigtd Access
"igkd, ey

Windows Username I {oemain named*, fusemame}

Windows Pazsword I
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Field or Checkbox

Description

Windows Username

Domain account used to access the Imaging shares on
Tier 1 and Tier 2 (jukebox) shares. Both the Tier 1
and Tier 2 (jukebox) shares must have
READ/WRITE permission to this account.

Windows Password

Domain password used to access the Imaging shares
on the Tier 1 and Tier 2 (jukebox) shares.

VistA Access

Encrypted access code for the Imaging Service
Account in VistA. This account will be used to
automatically re- log into the application when there
is a loss of connectivity between the BP product and
the Broker (VistA).

Note: The Imaging Service Account must have the
MAG SYSTEM security key and secondary menu
option All MAG* RPC's [MAG WINDOWS].

VistA Verify

Encrypted verify code for the Imaging Service
Account in VistA. This account will be used to
automatically re-log into the application when there
is a loss of connectivity between the BP product and
the Broker (VistA).

3.2.2.5 DICOM Interface Settings

~DICOM interface

DICOM Gateway Write Location

DICOM Gateway Interface Switch Update [
Fetention Days HL? - Modality YWorklists |999999
% Free Space DICOM Messages |1 0

Retention Days DICOM Messages |1 5

[

Field or Checkbox Description
DICOM Gateway Write Tier 1 share where newly acquired images are currently
Location being written.
DICOM Gateway Interface Indicates presence of a DICOM Gateway on the system.
Switch Update
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Field or Checkbox

Description

Retention Days HL7 —
Modality Work Lists

This field is used as the default value, in days, by the
DICOM Text Gateway for three different user menu
driven purges:

e This field is used by the Purge Old Modality Worklist
Entries menu option to determine the number of
retention days from the date of creation of Modality
Worklist Entries.

e This field is used by the Purge Old DICOM Message
Files menu option to determine the number of
retention days from the date of creation of DICOM
messages that were sent to commercial PACS.

e This field is used by the Purge Old HL7 Transaction
Global Nodes menu option to determine the number
of retention days from the date of creation of HL7
messages sent from VistA to the DICOM Text
Gateway.

Note: This value may be overridden by the user when

executing any of these menu options.

% Free Space DICOM

Minimum percentage of free disk space for DICOM HL7

Messages messages on the text gateway. A typical value is 25%.
Retention Days DICOM Number of days to retain DICOM HL7 messages on the
Messages text gateway, 30 days is recommended.

3.3 Configuring Mail Messages

When the BP products are running, they generate various alerts and informational messages.
These messages/alerts are formatted into mail messages and can be sent to different levels of
management within a facility. The Mail Message subject lines describe the condition with the
content of the message containing the specific information. The recipients for each Mail Message
Subject type can be set up using the Mail Message Manager.

3.3.1 Mail Messages Window

The Edit >Mail Messages menu on the Queue Processor menu bar opens the Mail Messages
window used to set up recipients for each message type. The tab Mail Messages can also be

selected.

September 2018 Background Processor User Manual, Rev 17 25
VistA Imaging MAG*3.0*214




¥ 7 R v —— v — : o [ 3]
Imaging Site Parameters ‘ Mail Messages ‘ Mail Groups | Purge{ Verifier/ BG Settings | BP Servers | Queue Manager

rKernal Mail Group WistA Imaging Mail Groups
5] ‘;‘ Ad_Hoc_Image_Site_Usage NAME -
B4 Application_process_failure hAG SERVER
3] ‘é‘ Auto_RAID_group_purge MAGDERROR
B4 GCC_Copy_Enmor MAG_GE_Ad_Hac_Image_Site_Us
& MAG_GB_Auto_RAID_group_pury | GRP MAG_GB_aApplication_process_
& MAG_GD_GCC_Copy_Error: GRP MAG_GE_Auto_RAID_group_purg
& IMAGPROVIDERONETHREE ONETHREE : Mem MAG_GB_GCC_Copy_Errar
0 Get_Mext_PAID_Group_failure taG_GE_Get_Next_RAID_Group_ -
04 INSTALLATION S | _»l_l

7.4 Image_Cache_Critically_Low ~Mail Users

[

[

[

B4 Image_Fils_Sizs_Variance
-4 Imaging_Integrity_Check

& Q Imaging_Site_Verification_lssue
-4 Monthly_Image_Site_Usage

3 ‘Q Photo_|_D_Action

3 'Q Scheduled_Purge_failure 1 1 1

B S P e Click here to view Mail users
5 ‘;‘ Scheduled_Werifier_failure

B4 Site_report_task_was_restarted
[ |_BP_Ewal_Cueue

[ |_BP_Queue_Processor_failure
[

1
q GV
qg
e

~Security Keys Holders

NAME ﬂ

MAG CAPTURE

MAG DELETE

MAG EDIT

MAG NOTE EFILE

MAG PAT PHOTO ORLY

Mrm PREFFTrH | _'Ll
4 »

v OK 7 Help
3.3.1.1 Displaying Mail Users

The list of the hospital users in the Mail Users section is not displayed until you click in the area
shown in the previous screen image. The list may take a few minutes to appear, depending on the
number of end-users defined in the site’s VistA database. The following is an example of a
displayed list of mail users.

Mol Ugarn -

NAME =]
BAAGFROMOERONE THREE OMETHREE
BAAGERCVDERONE THRE EFIVE OHE THREEFIVE
BAAGFROVIDE R THREEFNWVE.OMETHREEFIVE
AAAGPRONVIDE RONE THREE FIVENINE ONE THREEFTY
BEAAGFROMVIDE RONETHREEFTVER ETHREEFTVER
PAGFROVICERONE THREEFIVE S, DNE THREEFTVESIX
SMAGFROVDERONETHREEFIVES
EAAGFROVIDERDNE THREEFD
B

‘)Th.‘.F'P:r WANIERNNFE THRFENHE OMF THREFNMNE '
[ ] "

3.3.1.2 Adding Names

To select a name and associate it with a Mail Message type, drag the name from one of the
windows on the right to the Mail Message Manager window on the left. The change will be
stored in VistA when the name is dropped into the Mail Message category. Add as many names
as needed to each Mail Message on the left.

3.3.1.3  Removing Names

When a user no longer wishes to receive a specific warning/alert, the user’s name can be
removed from that message list at any time. VistA will be automatically updated to reflect the
change.

1. Locate the warning/alert message and right-click the username under the message title.

2. Select Delete from the pop-up menu displayed.
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VistA will automatically be updated to reflect the change.
33.14 Notification Intervals

The mail messages are sent out to the designated users at specific intervals (default is 6 hours).
These intervals can be adjusted per message name. To change a notification interval for a Mail
Message, follow the steps below.

?—-“Mail Message Properties - Application_process_Failure

Tranzmizzion frequencylin bours]: I

Last Meszage:

\/ 0k | x Cancel | {7 Lol | ? Help

1. Right-click a message name and select Properties from the pop-up menu displayed
2. Change the Transmission frequency (in hours) to the new value.
3. Click OK to close the window.

VistA will automatically be updated to reflect the change.
3.3.1.5  Field Descriptions
The fields for the Mail Message Manager are described below.

Field Description

Kernel Mail Groups Alert/ informational message names

VistA Imaging Mail Complete list of the Imaging mail groups defined in the VistA

Groups database. Users in the selected Mail Group will be sent the
alert/informational message.

Mail Users Complete list of users with mailboxes defined in the VistA
database.

Security Key Holders Complete list of the Imaging security keys in the VistA
database. Users that have the selected key will be sent the
alert/informational message.

3.4 Configuring Mail Groups

Users can be added to existing mail groups using the Mail Groups window. These Mail Groups
can be used to send alerts and informational messages to users through the Mail Message
Manager window.
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34.1 Mail Groups Window

The Mail Groups window can be opened using the Edit >Mail Groups menu on the Queue
Processor menu bar.

I {site} - Mail Group Manager ; B [
Imaging Site Parameters ‘ ail Groups | Purge [ Verifier | RG Settings | BP Servers | Queus Manager

Mail Groups rUsers
B4 MaG SERVER =

----- Q IMAGPROVIDERONETHREEFIWE ONETHREEFIVE : Mem
& GIMAGING DEVELOPMEMT TEAM@FORUM WA GOV Rem Mer
} MAGDERROR
¥ MAG_GB_Ad_Hoc _Image_Site_Us
b MAG_GE_Application_process_
MAG_GB Auto_FAID_group_purg . . .
¥ MAG_GB_GCC_Copy_Error Click here to view Mail users
MAG_GB_GEI MNest_RAID_Group_
} MAG_GE_INSTALLATION
MAG?GB,ImagE?Ca:he,Crit\ca\
MAG?GB,Image?F\Ie?E\zef\/ar\
MAG?GB,Imag\ngjntegmyfch
MAG_GB_Imag\ng_S\te_\/ermc
MAG_GB_MUﬂthly Image_Site_LJ
MAG_GB Photo_|_D_Action
b MAG_GBE_Scheduled _Purge_fail -
b MAG_GB_Scheduled_RAID _Group Mail Groups
$MAG _GB_Scheduled_Verifier_f MAME
Eﬁ‘é G B vl o as SERVER

MAGDERROR
FMAG _GE_vI|_BP_Queue_Processo MAG_GB_Ad_Hoc_Image_Site_Us 1=
MAG_GB werifier_Scan_Error_ MAG_GE_Application_process_
F MAG_GO_Ad_Hoc_Image_Site_Us MAG_GB_Autn_RAID_group_purg

|»

F MAG_GO_Application_process_ MAG:GB GCC_Copy_Errar
FMAG GO_Auto_RAID_group_purg MAG_GB_Get_Mext RAID_Group_
FMAG_GO_GOC_Copy_Ermor MAG_GE_INSTALLATION

'(.\\‘.\\'.\\'.\\3@@QQQQQQ@QQQ@QQQQQQ@

b MAG_GO_Get_MNext_PiAID_Group_ MAG:GEI

Image_Cache_Critical

| MAG_GB_Image_File_Size_“ari

hAG_I \mage Cache Critical = MIAG GE_Imaging_Integrity_Ch , _'Ll

L 1L L AT AT T e T N I e e = ;
|L|_I

« OK 7 Help

Field or Checkbox | Description

Mail Groups List of the existing Imaging Mail Groups defined in the VistA
database.

Users box

Name Complete list of users with mailboxes defined in the VistA database.

34.1.1 Displaying Mail Users

The list of the hospital users in the Mail Groups section is not displayed until you click in the

area shown above. The list may take a few minutes to appear depending on the number of end-
users defined in the site’s VistA database. The following is an example of a displayed list of mail
users.

Mo Ulgarn -
NAME =]
BAAGFROMOERONE THREE OMETHREE
BAAGERCVDERONE THRE EFIVE OHE THREEFIVE
BAGFROVIDER FEEFVE. OMETHREEFIVE
AAGPRONVICIERONE THREE FIVENINE, ONE THREEFTVERINE
BASGFRODE F\-ZIH‘.;TI-'F-'!I-I-I-N'I; {0 i

.:f—u.»c-l:nf' r"n-d:cuu

‘1']1.-?--'.F'F:r W R I THIRF FONE DME THREFNRE &
- ] [
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3.4.1.2 Guidelines on Adding Mail Groups

e Only active VistA users can be added as members to mail groups. An active user has an
“IN” basket defined in VistA.

e Important: When adding a new member to a mail group, use the same email address as
the one in the domain, which may or may not be the same as the user’s *@va.gov
address.

e This group is initialized during the install process.
e The installer is automatically added as a local member.

e The G.IMAGING DEVELOPMENT TEAM@FORUM.VA.GOV is added as a required
remote recipient to comply with the Food and Drug Administration requirements.

e It is recommended that the local VistA Imaging APACs Administrator, Imaging
Coordinator, and any Imaging managers be added as a member as well as any network
administrators who are responsible for the support of the VistA Imaging system.

e [t is recommended that a local text pager recipient be added as a remote member. The
pager service needs to provide email pager response. The standard email addressing
format is supported by this system: “name@mail _domain”.

¢ Only individuals with the MAG SYSTEM security key will be displayed in the lookup
dialogue for the local mail group.

34.13 Adding Members to Mail Groups

1. From the Queue Processor menu bar, select Edit > Mail Messages to open the Mail
Groups window or select the Mail Messages tab.

2. Drag and drop selected VistA users from the right list boxes to the Mail Groups list box.
VistA will automatically be updated to reflect the change.

34.14  Adding Remote Members to Mail Groups

1. Right-click a mail group and select Add Remote Mail Member from the pop-up menu
displayed.
Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

.'_‘ﬂ b ain Site Parameters | .'_‘ﬂ b all M ezzages || tail Groupz |

ET] Grn:lups

CL q(;i IMAGPRO fdd Remote Mail Member OOMEFOUR © Mem
MAG_GE_kor Delete Group Member

M-‘f'"-G GE_Phc Propetties

Mﬁ.G_GE_F’D T ITT=T_PCLTET

M.&G_GB_\-"I_BF'_Dueue_F'ru:u:essu:u

- B
‘3@@@

2. Inthe Adding Remote Member dialog box displayed, type the following:
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Email username or phone number, followed by the “@” sign, followed by the domain

The system uses SMTP Protocol.

?-‘Adding Remote Member - MAG_GB_Imaging_Site_Yerific

emailid@verizon.net (for remote email) or
EXAMPLES

333-333-9990 0+t st net (for & text message system)

\/ k. | x Eancell {]? Ay | ? Help |

3. Click OK.
34.1.5 Deleting Members from Mail Groups

When a user or group of users no longer wishes to receive mail messages for a specific alert, that
user/user group can be removed using the following steps:

1. From the Queue Processor menu bar, select Edit > Mail Messages to open the Mail
Groups window or select the Mail Messages tab.

2. Right-click a user/mail group and select Delete Group Member from the pop-up menu.
VistA will automatically be updated to reflect the change.

34.1.6 Specifying Properties for Mail Groups

1. From the Queue Processor menu bar, select Edit > Mail Messages to open the Mail
Groups window or select the Mail Messages tab.

2. Right-click a mail group and select Properties from the pop-up menu displayed.
Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

f_'ﬂ Main Site Parameters | r_'ﬂ Mail Mezzages || Mail Groups |

hail Groups

o - add Remaoke Mail Member OOMEFOUR - Merm
MaG_GE_Mor Delete Group Member
J‘ MG _GE_Phe Properties
g k&G _GE_PostCTream_sogusr
£ MAG_GB_Y|_BP_fueue_Processo

When the Mail Group (properties) dialog box is displayed, enter the data.
4. Click OK in the dialog box and then Apply in the Mail Groups window.
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7 # Mail Group: MAG_GB_INSTALLATION

Description

This defines the recipients of Image installation messages.

Organizer:  [MAGPROVIDEROMNE TWOSIK ONE TWOS!K

Type: public

Festrictions: Unrestricted

MEMBER

IMAGPROYIDERONETWOS M ONETWOSEK

MEMBER GROUP MNAME

MAG SERVER

REMOTE MEMBER

X Cancel 3 Al ? Help
Field or Checkbox Description
Description Describes the purpose of the mail group (Editable).
Organizer The organizer is the person who set up/created the mail group.
Type Public: Can receive mail from anyone.
Private: Can only receive mail from a predefined Public group.
(Display only)
Restrictions Unrestricted: Used when creating a Public mail account. Anyone
can mail to this account.
Organizer Only: An organizer can add new members to a
"Private" mail group. (Display only)
Member Lists the users in the mail group.
Member group Name | The parent group name for this mail group.
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Field or Checkbox Description

Remote Member E-mail address of a VA user who is external to the site but part of
the domain.

3.5 Configuring the Purge, Verifier, and RAID Group Advance Settings

The Purge / Verifier / RAID Groups window is used for setting up the Scheduled Verifier,
Scheduled Purge and RAID Group Advance activities. In addition, the parameters for the Purge
activity are set up through this window.

Selecting the Edit > Purge > Verifier > RG Settings menu on the Queue Processor menu bar
opens the Purge / Verifier / RAID Groups window.

; ,

Imaging Site Parameters | Mail Messages | Mail Groups | | Purge /Verifier/ RG Settings! | BP Servers | Queue Manager

Purge
Fietertion Days Retention Dates Y LastWerify BP Server: GERGFE
|| FullFiles ’20— 772018  Date Accessed Scheduled Verifer
" Date Created ¥ Active
Big Files 450 B13/2017

© Deb Mz I~ Check TextFiles

Ahstract Files 20 7izna

Photo IDs/Ad Direct |33393 07

LastYerifier Date:  2/22/2018

Frequency (in days): |1

Auta Purge ¥ Purge Factor : ,17 MNesxt Werifier Date: ’W @
Last Purge BP Server: GEKGFE Werifier Time: ,125?‘7 ﬂ
Express Purge Scheduled RAID Group Advance
Active [ Purge Rate 100000 Aciive -
Scheduled Purge Last RAID Advance :
Active v
LastPurge Date: 722018 RpmuEmzy b ]
Frequency (in days) : ’17 MNext Advance Date : li @
MNext Purge Date : W @ Advance Time: li @

Purge Time: |[1556 (&)

o 0K ‘ X Cancel

g ey |

i ]
IT
o
=

3.5.1 Purge Settings

The Purge process is used to remove image files from Tier 1 when the free space is low or when
older and/or not recently viewed image files can be purged to allow room for newly acquired
images. It is important to note that no file is purged from Tier 1 shares if it has not been verified
and confirmed as saved on the Tier 2.

The Purge can be run manually in standalone mode or as a part of the Queue Processor. The
Purge Parameters are used to control the purge activities in auto, manual and scheduled modes.

32 Background Processor User Manual, Rev 17 September 2018
VistA Imaging MAG*3.0*214



3.5.1.1 Guidelines for Setting Retention Days on Files for the Purge

General guidelines:

Determine the span of dates of images that will be preserved on the Imaging shares.

The shorter the timeframe, the more space will be free on the disk when the purge
completes.

Multiple purges may be required to determine the retention days. It is advisable to start
with one share with a large retention day’s value.

Not all sites capture all the file types specified in the parameter list.

If the frequency and the results of purging are acceptable, then it is not advisable to
change the purge values.

If there is still not enough free space after the purge, decrease the Purge Parameters (BIG
and FULL files, in particular) and repeat the purge until the desired free space is
obtained.

Factors that determine the best set of purge parameters for an individual site are:

The frequency of purges

The volume of image acquisition rate
The volume of image file retrieval
The use of Pre-Fetch

The capacity of disk space for VistA Imaging shares

Some sites have extended their Tier 1 capacities and are able to maintain five or more years of
images on the shares. These sites may only need to purge once per year to purge off the latest
year of images (year 6). Others who have smaller Tier 1 sets must purge more frequently and can
only have a limited number of images on their shares.

For your site, strive to keep the shares between 80% and 90% full (or between 10% and 20% free
space). When the Purge process completes and the resulting free space is more than this value,
adjust the parameters accordingly.
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3.5.1.2 Configuring the Retention Days Settings

—Furge

— Retention Days Fetention Dates

FulFiles [333 91502012

BigFiles [2091 8142008
AbstractFiles [39933  10/31/1739
Photo IDsfAd Direct [39333  10/31/1739

Field or Checkbox | Description

Retention Days and Retention Dates box

Full Files Source: Images from the DICOM Gateways, Clinical Capture
workstations and Imports.

File extensions: 756, ASC, AVI, BMP, BW, DCM, DOC, HTM,
HTML, JPG, MHT, MHTML, MP3, MP4, MPEG, MPG, PAC,
PDF, RTF, TGA, TIF, WAV

Range: 0 - 99,999 (number of days back from the current date that
files should be retained)

Big Files Source: Images from the DICOM gateway and Clinical Capture
workstations.

File extensions: BIG

Range: 0 - 99,999 (number of days back from the current date that
files should be retained)

Abstract Files Source: Images from the DICOM gateways, Clinical Capture
workstations and Imports. Abstract files are derivatives of the
TGA/BIG format files.

File extensions: ABS

Range: 0 - 99,999 (number of days back from the current date that
files should be retained)

Recommended: 99999

Photo IDs / Source: Patient photo images from the Clinical Capture

Advance Directives | workstations /Advance Directives

File extension: JPG

Range: 0 - 99,999 (number of days back from the current date that
files should be retained)

Recommended: 99999
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1. Enter the number of days that each file type should remain on the shares based on the 3 file
date purge criteria described in section 3.5./ Purge Settings (Date Accessed, Date Created,
and Date Modified).

Note: The FULL and BIG files are typically larger file sizes and consume more free space on
the shares than the abstracts and photo IDs /Ad Direct.

2. Due to their size, set the retention days to fewer days to free more space.

3. Because the abstracts and photo IDs/Ad Direct are smaller files, set the retention days for
purging these two types of files to a higher value than the values for the FULL/BIG file
retention days.

4. Because the abstract files are viewed as thumbnails on the Clinical Display workstation, set
the retention days to retain a minimum of 5 years (1,825 days) on the shares regardless of the
capacity of Tier 1 to make viewing on the Clinical Display workstations more efficient.

3.5.13 Configuring Scheduled/Express Purge Settings
Auto Purge Furge Factar: |1

Last Purge BF Server: GERGFE

Express Purge

Active T Purge Rate 100000

Scheduled Purge
Active v

Last Purge Date : 7/2/2018
Frecuency (in days): |1
MNext Purge Date : [2/27/2015 ]
Purge Time: |1558 @

Field or Checkbox Description

Auto Purge Enables the Purge to run when the high-water mark is reached
on a RAID Group.

Last Purge BP Server | BP Server on which the last purge was run.

Purge Factor Multiple of the % Server Reserve. When the free space falls

below this value, a purge is initiated on the. next available
online RAID Group. The default value is 2.

Express Purge Section

Active Enables an Express Purge.
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Field or Checkbox Description

Purge Rate When the number of image entries that have been evaluated
for purging (based on the date criterion), without deletion, the
purge process for that share will cease.

The default Purge Rate value is 100,000.

Scheduled Purge Section

Active Enable scheduled purges.

Last Purge Date: Date when the last purge was run.

Frequency (in days) The number of days added to the Last Purge Date to determine
the next Scheduled Purge Date. This occurs at the end of a
Scheduled Purge.

If this field is left blank, the Scheduled Purge can be scheduled
for a single event. When the event takes place, the Next Purge
Date is cleared.

Next Purge Date Next scheduled Purge date.

Purge Time Time of day for the next scheduled Purge.

Note: Before an automatic purge is set up, a manual purge should be run on a share to make
sure the Purge Parameters are set properly.

The automatic purge will use these same Purge Parameters and if not set properly, will result
in unsatisfactory results. As the volume of images increases from the gateways, etc., these
parameters should be adjusted to compensate for the increase.

Scheduled purges typically are set up monthly, but this will vary per site. The goal is to keep
the shares between 80% and 90% full. Some adjustments in scheduling will need to be made
after a scheduled purge cycle has completed.

Enabling Express Purge will greatly enhance the purging process by eliminating unnecessary
file traversals that are not candidates for purging and thus significantly decrease the time to
purge a share. The Purge Factor is set to control when the purge on a share is terminated.
When the number of files that are traversed and not deleted has exceeded the number in the
Purge Factor, the purge stops on that share and begins purging the next share (automatic
mode).

3.5.1.4  Configuring Purge Date Criteria Settings

Furge Critenia———
{* [Date Accesszed

" Date Created

" Date Modified

Purge Criteria

Date Accessed Date when the file (image) was last viewed on a VI
workstation.

Date Created Date when the file was copied to the current disk share.
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Date Modified Date when the file was last changed. On the initial save, the
Date Created will be the same as the Date Modified.

Any of the three-file date/times can be used (date accessed, date modified, date created) to purge
the shares. There have been instances where third party utilities have changed the access dates on
all the files it “touched” to the same recent date.

When the purge is activated, no files are deleted as none of the file access dates are purge
candidates. It is recommended that the Date Modified be used. This date is retained when files
are moved across storage media and is a reliable date for purging.

3.5.1.5  Running the Scheduled Purge

The Scheduled Purge option is used when the Purge is to be run at periodic intervals, for
example, weekends (when activity is low at a site) or when images are to be kept on Tier 1 for a
certain period, for example annual removal of images older than 5 years. The application that
runs for the Scheduled Purge is the same as the Manual Purge. Reference the Manual Purge
(above) for specific information about the GUI and log files.

Note: Set the Purge Retention Days and Purge By as the Scheduled Purge process uses those
parameters.

1. Select Edit > BP Servers.

2. Drag the PURGE task to the BP Server where the purge is to be run (Best if run on an
Imaging server).

3. Click OK to close the window.
4. Select Edit > Purge / Verifier /RG Settings tab.
5. Set the following fields:

Field Setting

Auto Purge Unchecked

Express Purge | Active Checked

Scheduled Purge | Active | Checked

%Server Reserve (not used for this option)

Purge Factor (not used for this option)
Frequency (in days) (select interval in days)

Next Purge Date (starting date)

Purge Time (time of day the Purge will run)

6. Click OK to close the window.

When a Scheduled Purge starts, the time is recorded in the VistA database in the field Last
Purge Date. The Last Purge Date and the Next Purge Date are kept in synch, while the
scheduled purge is active to prevent additional scheduled purges from being activated. When the
scheduled purge is complete the Frequency is added to this date to determine when the purge
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will start next. All online Tier 1 shares in the next RAID Group will be purged when this
scheduled application runs.

Important: The Queue Processor must be in the running state on the server where the Purge is
scheduled for it to run i.e. the Start button on the Queue Processor GUI must be clicked.
3.5.1.6 Running the Auto Purge
There are two configurations where the Auto Purge is used:
e In the first configuration, all the Tier 1 shares are in the same RAID Group.

¢ In the second configuration, the shares are distributed into two or more RAID Groups.
The setup is the same for both groups except that the Purge Factor must be set for the
second configuration.

The application that runs for the Auto Purge is the same as the manual purge. Reference the
Manual Purge (above) for specific information about the GUI and log files.

Important: If the PC that has Scheduled or Auto events is not a server class, the task will not
start.

Note: The Auto Purge process uses these parameters: Purge Retention Days and Purge By.
1. Select Edit > BP Servers.

2. Drag the PURGE task to the BP Server where the purge is to be run (best if run on an
Imaging server).

Click OK to close the window.
4. Select Edit > Purge / Verifier /RG Settings tab.
5. Set the following fields:

Field Setting

Auto Purge Checked

Express Purge | Active Checked

Scheduled Purge | Active Unchecked

YoServer Reserve (use the current value that is set on your site)
Purge Factor 2 (used only with multiple active RAID Groups)

6. Click OK to close the window.

When any share in a single RAID Group configuration has less than the %Server Reserve free
space, the Purge will start and process all the active shares in that group. On the multiple RAID
Group configurations, the Purge will start on the next selectable RAID Group when the free
space on any share in the current RAID Group falls below the Purge Factor times the % Server
Reserve. This Purge Factor is set to allow time for the purge to complete on that next RAID
Group before the Queue Processor changes the Current RAID Group to that group.

The Express Purge setting (described in a previous section) will dramatically lower the time it
will take to purge a share/ RAID Group.
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Note: The Queue Processor must be in the running state for the Auto Purge to run on the
designated server; i.e., the Start button must be clicked.

3.5.2 Verifier Settings

The Verifier validates image storage pointers in VistA by checking the physical locations of
those pointers to ensure the file(s) exist on the specific storage media. To maintain a valid
database, corrective action is taken when these physical files are not found on the media. In
addition to these file checks; the Verifier examines the integrity of the imaging records in VistA.
Any corruption is reported in the log files.

3.5.2.1 Scheduled Verifier Settings

LastVerity BF Serer: BP2
Scheduled Yerifer

v Active
[~ Check TextFiles

LastWerifier Date:  2/22/20148

Frequency (in days): |1

MNext Yerifier Date: IW &
Verifiar Tima:  [1257 ()
Field or Checkbox | Description
Last Verify BP BP Server on which the Verifier was last run (Display only, set
Server by application)
Scheduled Verifier
Active Enables scheduling the Verifier
Check Text Files Read text files on the Tier 1 shares and determine if:
1) the file is binary or unreadable
2) there are unprintable characters in the file
3) The SSN does not match the one in VistA
4) SOP Instance UID mismatch with VistA
5) Study Instance UID mismatch with VistA
6) SOP Instance UID and/or Study Instance UID are blank
7) SSN in the top part of the text file does not match the
bottom.
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Field or Checkbox | Description

Frequency (in days) | Number of days added to the date of the last time the Verifier
application ran to determine the next time the Scheduled Verifier
should be run.

Last Verifier Date Date when the Verifier was last run.

Next Verifier Date Date of the next scheduled Verifier will run based on the
Frequency (in days) parameter.

Verifier Time Time of day when the Verifier will run.

3522 Guidelines for Setting Parameters for the Scheduled Verifier

The Scheduled Verifier should be set up to run nightly. It will verify the integrity of any image
records not validated since the previous Verifier run (Manual or Scheduled). It is suggested that
the Verifier be run manually over the entire range of image records before incremental Verifier
runs are started. The application that runs for the Scheduled Verifier is the same as the Manual
Verifier. Reference the Manual Verifier (above) for specific information about the GUI and log
files.

The following guidelines for using the Scheduled Verifier will help maintain the integrity of the
Imaging records in the VistA database.

Important: If the PC that has Scheduled or Auto events is not a server class, the task will not
start.

e Set the Active check box to enable scheduled runs of the BP Verifier. The scheduled runs of
the Verifier will only check the most recent VistA records of new images that have been
created since the last Scheduled Verifier run.

e Do not select the Check Text Files check box. The contents of the text files on Tier 1 will be
compared to the information in VistA. This processing will slow down the Verifier
processing and utilities are not available now to correct any issues that surface.

e The Last Verifier Date field is set by the system and cannot be set by the user.

e When the Active parameter is checked, the Frequency (in days) field setting should be 1 so
that the Verifier runs daily.

¢ [Initially set the Next Verifier Date to today’s date. The scheduling frequency will be based
on this date.

e Set the Verifier Time to an inactive period of the day —typically after hours when image
creation activity is low.

3523 Running the Scheduled Verifier
Use the following steps to schedule the Verifier:
1. Select Edit > BP Servers.

2. Drag the SCHEDULED VERIFY task to the BP Server where the verifier is to be run.

3. Click OK to close the window

4. Select Edit > Purge / Verifier /RG Settings tab
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5. Set the following fields in the Scheduled Verifier box:

Field Setting

Active Checked

Check Text Files Unchecked

Frequency (in days) 1

Next Verifier Date (starting date)

Verifier Time (time of day the Verifier will run — after hours is best)

6. Click OK to close the window.

7. Click Start on the Queue Processor main window. (The Queue Processor must be in the
running state for the Scheduled Verifier to run on the designated server.)

When a Scheduled Verifier starts, the time is recorded in the VistA database in the field Last
Verifier Date. The Frequency is added to this date to determine when the Verifier will run again.

353 RAID Group Advance Settings

RAID groups are used to organize Tier 1 shares into logical groups for easy tape backup and
restore processing. During the install all existing online Imaging shares are placed into the first
RAID Group RG-GO1. This configuration is the same that has been in existence for past years.
The auto update functionality is also the same. At regular intervals, the current write location
will change to the share with the freest space. The Auto-Write function will reset the current
write location to provide load balancing within the RAID group. When the % Server Reserve
within the group has been breached the Auto-Write will set the next RAID group as the current
write group. In addition, when the used space in that RAID Group has reached the high-water
mark, the next RAID Group that has online shares will become the current RAID Group.

3.5.3.1 Configuring the Scheduled RAID Group Advance Settings

—Scheduled RAID Group Advance

Active -

Last RaID Advance:

Frequency [in daysz] : I
Next Advance Date : I @l
Advance Time: I (] |

Field or Checkbox ‘ Description

Scheduled RAID Group Advance box

Active Enable RAID Group Advance scheduling

Last RAID Advance Date when the last scheduled RAID Group Advance occurred

Frequency (in days) Number of days added to the date of the last RAID Group
Advance to determine the next time the RAID Group Advance
will run. If the Frequency parameter is set, the next RAID
Group Advance will be scheduled automatically.
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Field or Checkbox Description

Next Advance Date Date of the next scheduled RAID Group Advance

Advance Time Required. Time of day of the next scheduled RAID Group
Advance

3.5.3.2  Parameter Guidelines for the Scheduled RAID Group Advance
Sites can choose a configuration that suits them best, as follows:

e Use the initial configuration where all the shares are in the same RAID Group. The new
images will be evenly distributed among all the shares.

¢ Nightly incremental tape backups as well as monthly/quarterly tape backups must be
done on a regular basis on all the shares.

¢ Distribute the shares among multiple RAID Groups. Fill the shares in each group to the
Server Size, and then switch the current write group to the next. New image files will be
distributed over all the shares assigned to that group.

e Nightly incremental tape backups as well as monthly/quarterly tape backups must be
done only on that RAID Group.

e When it has reached capacity, a final full backup should be done on all the shares and
nightly incremental tape backups and monthly/quarterly tape backups started on the next
current write group.

3.533 Running the Scheduled RAID Group Advance
This option is applicable when the there are multiple active RAID Groups.
1. Select the Edit > Purge / Verifier /RG Settings tab.
2. Set the following fields in the Scheduled RAID Group Advance box:

Field Setting
Active Checked

Frequency (in days) | Set by determining how long a span of time images will be
written to a set of shares in a Group.

Next Advance Date | Set the starting date when the system will move to the next
RAID Group.

Advance Time Set the starting time of day when the system will move to the
next RAID Group.

3. Click OK to close the window.

4. Click Start on the Queue Processor main window.
(The Queue Processor must be in the running state for the Scheduled RAID Group Advance
to run on the designated server.)
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3.6 Queue Manager

The Queue Processor is tasked by other Imaging products and external sources to perform
various activities with new images emanating from those sources. These tasks are placed on a
queue structure (FIFO with each type of task) in VistA. These tasks are described in section
2.5.3, Assigning Tasks (Queues) to a BP Server.

Note: To execute these tasks, they must be assigned to a BP Server. This can be done using the
BP Servers window which is an option on the main BP window.

The Queue Manager window shows each of the queues that have been assigned to a server. It
displays Failed and Active status categories under each task. The Active branches show
unprocessed entries for new images. The Queue Processor executes each task in a priority order
starting with JBTOHD as the highest. When a queue entry for a task does not complete
successfully, it is placed on the Failed list for that task. The error condition is listed below the
Failed entry in the tree. There can be different reasons for the failure for each task. Each one is
listed in the Queue Manager tree.

The Queue Manager displays the status counts (Active/Failed) for each task as well as details
about the entry. In the Queue Manager the queues are subdivided into a tree structure. The lowest
node of the tree represents an individual queue file entry. You can move the active queue pointer
to entries anywhere in the queue list for a task. The Queue Processor will process entries from
this new location. In addition, you can re-queue Failed tasks and delete tasks from both the
Active and Failed queue lists.
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3.6.1 Queue Manager Operations

The Edit > Queue Manager menu on the Queue Processor menu bar opens the Queue Manager
main window. You can select to display either all queues or a specific queue by choosing the

relevant option from the submenu. The data is loaded in batches preventing failures.

Displaying a specific queue type allows you to limit the data that is displayed preventing large

arrays from causing timeouts or out of memory errors.

T —

File [Edit| View Help

Iraging Site Parameters 3P 196)
Mail Messages
Ne Mail Groups IEN |Free Space ([
. Purge / Verifier / RG Settings
EP Servers
Queue Manager k All
Metwork Location Manager Abstract
Refresh Queue Counts Delete
" Set Queue pause (delay) GCC
Import
JETOHD
Event Time Process: Quel Jukebox
Prefet

To display all queues:

From the main BP Queue Processor window, with the Queue Processor stopped, select

Edit > Queue Manager > All.

7 SALT LAKE CITY - Queue Managerment: ALL
Imaging Site Parameters | Mail Messages | tail Groups | Purge { “erifier / RG Settings | BF Servers | Gueue Manager ‘

B¢ ABSTRACT

<3 Failed: 2

o Active: 17735
# DELETE

& Failed: 0

74 Active: 33

7 EvaL

F Artive: )

b GCC

& Failed: 1

G Active: 0

5 JBTOHD

& Failed: 161641
<F Active:

B4 JUKEBOX

"% Failed:0
w4 Active: 1660
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All queue types display grouped by queue type and status (Failed or Active). Click the plus sign
to display the next level of detail. Hovering on a queue displays a tooltip with details about the
queue.

Site Parameters | Mail Messages

Mail Groups | Furge [Verifier { BG Seftings | BP Servers

Gueus Manager

4 BA1B JUKEBIOK
< EIENNE
€3 5420 JUKEBOK
< 5421 JUKEBCK
& 5422 JUKEBOX
& 5423 JUKEEOX
€F 5424 JUKEBOX
- 5425 JUKEBOX
—€F 5426 JUKEBOK
4 6427 JUKEBOK
<@ 6428 JUKEBOX,
<3 5429 JUKEBCK
< 6430 JUKEBOX,
& 5431 JUKEBOX
& 5432 JUKEBOX
- 5433 JUKEBOX
- 5434 JUKEBOX
& 6435 JUKEBIOX
4 6436 JUKEBCK
<3 5437 JUKEBCK
<} 5438 JUKEBCK
< 5439 JUKEBOX
€ 5440 JUKEEOX
€ 5441 JUKEBOX
- 6442 JUKEBOX
€F 5443 JUKEBOKX
54 5444 JUKEBOX
<@ 6445 JUKEBOX,
<3 6446 JUKEBCK
< 6447 JUKEBOX,
3 5448 JUKEEOX
< 5449 JUKEEOX
- B450 JUKEBOX
- 5451 JUKEBOX

=% NOT_PROCESSED : 819
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SALT LAKE CITY
SALT LAKE CITY
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o OK

? Help I

To select a queue to display:

From the main BP Queue Processor window, with the Queue Processor stopped, select
Edit > Queue Manager > Queue where Queue is the queue type and can be Abstract, Delete,

GCC, Import, JBTOHD, Jukebox, and Prefet.

e T
#5 BP Queue P - - GA - Sit

File |Edit | View Help

Imaging Site Parameters

3P 196)

L Mail Messages
Me Mail Groups IEN |Free Space ([
Purge / Verifier / RG Settings

BP Servers
Queue Manager 3 All
Metwork Location Manager Abstract
Refresh Queue Counts Delete
" Set Queue pause (delay) GCC
Import
JETOHD
Event Time Process: Quel Jukebox
Prefet
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When the queues of the type display, you can carry out certain operations on individual queues
through the shortcut menu. The operations that you can carry out depend on the type and status
of the queue or queues.

The following image shows the Jukebox queues with a failed queue selected. The shortcut menu
is displayed with the two operations available for this queue: Re-Queue and Purge Queue.

< SALT LAKE CITY - Queue Management: JUKEBOX M[=] &3
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3.6.2 Purging a Queue

Circumstances may arise when single or multiple queue entries need to be deleted. One example
involves JBTOHD tasks. When JBTOHD entries have not been processed in a period (a day or
more), the usefulness of retrieving these images diminishes. There may be hundreds of these
queue entries for a study. You can select multiple entries using the Queue Manager and delete
them.

1. Select the entries to be deleted.
2. Right click in the selected area.

3. In the pop-up menu displayed, select Purge Queue.
Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

©x
=
X
=

R
¥
- O

BOASACACAOAOA E

JND USER| M-GR 11, 21028055654 NOT_PROCESSED 8823 FULL
IUNDUSER | MAR 11, 2010@05565( NOT_PROCESSED €823 BIG
JUNDUSE3 | MAR 11, 2010@05565¢ NOT_PROCESSED 8825 ABSTRACT

9JBTDHD b
10JBTOHD
5 11JBTOHD

Purge Queus
Set Queue Partition

4. Acknowledge the verification popup. The entries will be deleted and the Active/Failed queue
count will be changed to reflect the change.
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Confirm

\?/ Do wou wish ko Purge all selecked (4) Active JBTOHD queues ?
-

Mo | Cancel |

3.6.3 Re-Queuing a Failed Image File

The Queue Processor will attempt to process an entry three times to get a successful result. After
the third attempt, the entry is placed in the Failed category. In most cases, the cause of the failure
can be corrected and the Failed entry re-queued with success.

1. Right-click a Failed status and select Re-Queue from the pop-up menu to re-queue the single
queue or all queues with that status, as shown in the example.
Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

g Q Py Re-CQueues d-1
©'% s Purge Queus

i v; A
& : el Queue Parkition

|

Imnpork Quewe Froperhies
L

< N Refresh

E:‘:‘ Active—rrors

2. Click Yes in the confirmation message shown.

@ , Dovou wish to re-queue all Failed(1) JUKEBOY queues 7

Mo | Cancel I

The queue entry will move from the Failed queue to the Active queue for that task. The
queue counts will be updated.
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3.6.4 Refreshing a Queue Display

= ;’i GCC

------ 3 Failed: 0
------ ¢ Active: 0
- IMPORT

; ,}' Failed: 7
------ @ Active: 0

E| 4‘ FElI|

Refresh

- 4‘ WRE ~eue

Furge Quele
Sek Quewe Parkition
Imnpork Quewue Properties

‘Q 148 JBTOHD SALT LAKE CITY UT  IMAGFRD
: @ 149 JBTOHD SALT LAKE CITY UT  IMAGPRO
L3 1N ATOHD SAI T1AKE CITY UT  IMAGPED

CITY UT  IMAGFRO

After working with queues, the state of the queue file will have changed due to real time
captures and possibly activity by the sites’ other Queue servers. The Queue Manager
operator can select the Refresh submenu option to get an updated view of the queue
selected. It would be prudent not to manage queues that are actively being processed by
another queue processor to avoid errors in the updating queues that may no longer be

there.

3.6.5 Setting a Queue Partition

Each queue type has an active queue pointer that designates the next queue to be processed. This
pointer can be manually moved to begin processing at another location in the specific queue
type. A typical situation is when a queue is corrupted. The queue pointer can be moved to the

next queue where processing continues with the rest of the queues of that type.

1. To move the active queue pointer (Set Queue Partition), right-click an active queue.
Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

= 4F JBTOMD
J Faded 0
= o Ackve: 18
<F SJBTOHD (eire}
? §JETOHD (e}

§ 8JBTOHD (sire}
¢ 9JBTOHD {site}
? 10J8TOHD  /se}
2 JBTOHD  foive)

BACKGROUNDUSER | MAR 11, 2010055554 NOT_PROCESSED 8822 ABSTRACT
EAOE)RUL.. JDUSERI MAR 11, 2010005 5654 HDT WDE[SSEP fﬂé‘l FULL

BACKGROUN musgm he sume -40: PROCESSED &R:J ABSTRACT

BACKGROUNDUSER | | comc=c o OT_PROCESSED 6823 FULL
BACKGROUND.USER | mport QLS Propertise NOT_PROCESSED 8823 BIG
BACKGROUNDUSER || Roro NOT_PROCESSED €825 ABSTFACT

2. From the pop-up menu, select Set Queue Partition.

The selected entry and the ones above it will move to the Failed queue.
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= JETOHD
= 4F Faled 3
o T

2 5.BTOHD e} BACKGROUMD USER | MAR 11, 20005565 HNOT_PROCESSED 827 ABSTRACT

émsmﬂn [=ite? BACEGROUND USER | M&R 11, AN@OSEESE NOT_PROCESSED #22 FUL.
p 2 TJBTOHD (it} BACKGROUMDUSER | MAR 11, 2NE@05EE54 NOT_PROCESSED 8322 BIG
B0 Actve 15

¢ BJBTOHD (=iel BACEGROUMDUSER 1 MaR 11, 2N0E0SSE5S NOT_PROCESSED 6823 ARSTRACT
9JATOHD (=ita} BACEGROUNDUSER | MAR 11, 201DR055554 MOT_PROCESSED 6323 FULL

- 10J8TOHD (=ive} BACKGROUND USER | MAR 11, 2002055554 NOT_PROCESSED BIG
1 JaTOHD (wita} BACEGROUND ISER | MAR 11, 2N02055E54 HOT_PROCESSED BRSTRACT
12J8TOHD (et BACEGROUND USER | MAR 11, AN005555%4 NOT_PROCESSED FULL
13 J8TOHD Jeiva BACKGROUND USER | MAR 11, 2102055554 NOT_PROCESSED BIG

14 JETOHD (=ive BACKGROUNDUJSER | MAR 11, 2102055654 NOT_PROCESSED ABSTFACT

§lsmlnub e} BACEGROUND USER | MAR 1, AN0R0S585 NOT_PROCESSED FULL
 16J8TOHD Jita) BACKGROUND USER | MAR 11, 202065554 NOT_PROCESSED BiG

17 JETOHD Uit} BACKGROUND USER | MAR 11, 20102055554 NOT_PROCESSED ABSTFACT
18 JETOHD {eita} BACKGROUNDWSER | MAR 11, 2N0R05S 5554 NOT_PROCESSED FULL
19J8TOHD feire? BACEGROUND USER | MAR 11, AN02055654 NOT_PROCESSED ]
20MBTOHD {=ite} BACEGROUNDJSER | MAR 11, AN020S5254  HOT_PROCESSED BRSTFACT
F 21 J8TOHD iwite; BACKGROUNDUSER | MAR 11, 20055654 NOT_PROCESSED FULL
228T0HD  (=ie/ BACKGROUNDUSER | MAR 11, 20108055654 KOT_FROCESSED BiG

3.6.6

Accessing Import Queue Properties

You can access the failed Import Queue properties by right-clicking a failed IMPORT queue
node and selecting Import Queue Properties.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

= @ MFORT
= & Failed 3
@ MPORT Dequeue Faded on Track : 0
4 IMPORT inprogress : 0
& NOT_PROCESSED 0
= 4 Procedure and

pasents : 2
7] it
& 19356194 MPORT _oire/
= & Visth image Enry deleted 1)
@ 20474062 MPORT  (=ive)
@ Achve 0

Re-Queus

Purge Queue

Seb Queue Parkition

Import Queue Properties

Refresh

5 § BTOHD

20.2010@104208 Procedure erdimaging patents dort meich

04 2010@1531:44 VistA image Entry deleted

2

For details, see section 4.6.3.3, IMPORT Queue Status Report.

3.7 Network Location Manager

The BP processor applications send/receive images to/from physical devices and networks using
different types of media. These types of media need to be recorded in the VistA database. The
information that is stored includes the type of media, the location, online status, security access,
etc. This information can be entered into VistA using the Network Location Manager.
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4 {site} Network Location Manager

ITIEFH TIERZ | Routers | GCC EKG URLs Diagrams

Bt RG-ATGI i
& MAGT4H NETWORK LOC... | IEN| PHYSL.. | TOTAL SPACE | FREE SPACE | OPERATION... | READ ONLY | STORAGE TYPE | HASH SUBDIF
S MAGZH o e o e
S MAG3H

v RG-ATG?2
2 MAGAH
“ MAGSH
e MAGEH

v RG-ATGA
o MAGTH
“ MAGEH
& MAGIH

v RG-ATGA
e MAGTOH
= MAGTTH
% MAGTZH
“# MAGT3H

iy

3

i

q »
—List View Style
New | Add Group | W OK | X Cancel | & oy | ? Help |  List & Report

3.8 Configuring the Network Location Manager

The Edit > Network Location Manager menu on the Queue Processor menu bar opens the
Network Location Manager window. Seven types of entries are displayed using the tabs. They
are described in the table.

Function Description

Tier 1 Tier 1 shares on the Imaging server cluster.

Note: Use “XXX-MAGnH” names for these shares. “n” is a unique
number. “H” indicates the file directory structure is hashed or “XXX-
MAGc-nnH” names for these shares. “c” is the cluster number. “nn” is
the image share.

Tier 2 Cache shares on the archive device (Storage Grid/Archive
Appliance/Jukebox)

Note: Use “WORMOTGn” names for JB and AA. Use “XXX-
GWVO0n-SGnn” for SG locations, where XXX is the site abbrev, n is
the proper number describing the location.

Routers Network shares on remote servers/desktops where new images are
transmitted using the Imaging AutoRouter product.

Security: Access to these locations requires a Windows Username and
Password.

Note: Use meaningful names as these names are used in the routing
rules file (ROUTE.DIC) on the routing gateways.

GCC External network shares where images can be transferred for non-
VistA Imaging usage.

Security: Access to these locations requires a Windows Username and
Password.
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Function

Description

EKG

Remote GE Muse server share locations where the Electrocardiograms
are stored. The EKG strips can be viewed from these remote locations
using the Clinical Display software.

Security: Access to these locations requires a Windows Username and
Password.

URLs

Remote Image Views is a feature of the Clinical Display software that
allows users to view patient images from any VA hospital in the
country. These images are processed through a web service on remote
server. The URL for this web service is stored here.

Diagrams

Annotation diagrams (templates and mark-ups) are stored at these share
locations. The Clinical Display software has a tool that can be used to
edit and save these marked-up diagrams for a patient.

3.8.1.1

Tier 1 Tab

Each site has Imaging Tier 1 storage where images from the gateways, scanners, cameras, etc.
are stored for quick access for display on VistARad and Clinical Display workstations. This
storage resides on the Imaging cluster. Shares can have different capacities for storage. The
physical location for each of these shares is stored under the Tier 1 storage type in the Network

Location Manager.

To edit the properties of a network location, right-click the entry and select Properties on the

pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.
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';-‘ {site}
[TERT | TER?2 | Rouers | Gcc | Exe

B RG-ATG
-2 MAGTIH

52

-

2 s P
-5y RG-ATGE

R MAGAH
g aGsH

MNetwork Location Manager

| URLs ‘ Diagrarms ‘

1H[=] E3

| NETwORK . | IEN

| PHvSICAL ... | TOTALSP... | FREE SPA.. [ oPERATIO.. [ READ ONLY [ STORAGE ... [ HASH SUE.. |

= MAGTH 1

roperties

Network Location Properties

-2 MAGEH | Cache IDs

“# RG-ATG3 | % ghare Name |MA02H

WHAATG...

3094514

120874 On-Line YES TIER1 YES

* Storage Type

j; mig;: i* Network Share TIER1
i MaGaH || WWHAATGCXX AUMAGE2S\
25 RG-ATGY |
- MAGTOH
= MAGTTH Space in Gigabytes
i MAGTEH Capacity. 2363
5 MAGTIH
¥ Operational Status
I Read Only
Hashed
ew Sty
MNew t
W 0K ‘ X Cancel ‘ | ? Help | :_f Froperties 4
Field Description
NETWORK LOCATION Name of a Tier 1 share on the Imaging cluster.
Note: Use “MAGnH” names for these shares. “n” is a
unique number. “H” indicates the file directory
structure 1s hashed or use “XXX-MAGc-nnH” names
for these shares. “c” is the cluster number. “nn” is the
image share.
IEN The record number in VistA for this Network Location.
PHYSICAL REFERENCE The UNC (Universal Naming Convention) containing

the server and share name for the Tier 1 storage.

TOTAL SPACE

Storage capacity for the share.

FREE SPACE Free space remaining on the share.

OPERATIONAL STATUS Logical state of the share (“ONLINE" or “OFFLINE”).

READ ONLY If set, data can be read but not written to this share. In
addition, Purge and Auto Write will not consider this
share as a candidate for purge or new image storage.

STORAGE TYPE “Tier 1” formerly: RAID

HASH SUBDIRECTORY A hierarchal folder structure will be created/used

(default is hashed, display only).
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3.8.1.2

Most sites have local Tier 2 storage

Tier 2 Tab

(jukebox). Some sites have a remote archive where multiple

sites share the same storage. The images that are initially copied to Tier 1 are copied from the
Tier 1 to Tier 2. The Tier 2 devices have one or more shares where the images are copied for
long term storage. For remote consolidated Tier 2 storage, each site has its own share to keep the

images segregated.

To edit the properties of a network location, right-click the entry and select Properties on the

pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

y site, C Network Location Manager |- (O] %]
TIER1 || TIERZ | Routers | GCC EKG URLs | Diagrams
NETWORKLO.. | [EN SPACE SPACE | OPERATIONA . | READONLY | S

73394
73394
73354

ZWORMOTG3
2 WORMOTGY
e wWorMOTGS 1M
2 WORMOTGE
ZWORMOTG?

On-Line
On-Line
Cr-Ling

* Share Name [WORMOTG
* Network Share

EWORMOTGE

* Storage Type

SEWORMOTES |\\VHMMIM MJBTUMAGEJB1$Y} _I e
¥ Operational Status
™ Read Onky
o L
Hashed Sty
Mew |
0K | X Cancal | ‘ 7 Help | _'f Properties
Field Description
NETWORK LOCATION Narpe of a share on the server containing the archive
device.
Note:
Use “WORMOTGn” names for JB and AA. Use
“XXX-GWVO0n-SGnn” for SG locations, where XXX
is the site abbrev, n is the proper number describing the
location.
IEN The record number in VistA for this Network Location.
PHYSICAL REFERENCE The UNC (Universal Naming Convention) containing
the server and share name for the archive storage.
TOTAL SPACE Storage capacity for the share.
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Field Description

FREE SPACE Free space remaining on the share.

OPERATIONAL STATUS Logical state of the share (“ONLINE" or “OFFLINE”)

STORAGE TYPE “Tier 2” formerly Jukebox archive media.

HASH SUBDIRECTORY A flat or hierarchal folder structure will be created/used
(default is hashed, display only).

3.8.1.3 Routers Tab

Some types of images are routed to remote Radiologists using the VistA Imaging AutoRouting

software. These images are written to a share on their remote server using the

Username/Password contained in the properties of this storage type.

To edit the properties of a network location, right-click the entry and select Properties on the
pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

I Location MNetwork Location Manager
TIER1 | TER2 |[Routers|| GOC | EKG

| URLs

- Diagrams

=10ix]

NETWORKLOCATION | N[ Privsica [orerano. [HasH  [as | ;e | Tex| cocou| maxen | svimax|susoe [ ReTen | sTe|
e DR M WWHAS OnrLing
T Location - Network Location Properties =lolx|
Cache 0%
% Share Name [EPEROUTEHASHED A SomouType
* Network Share ROUTER
(WA VMSA00\ROUTEY, _]
Hetwork Credeabals
User Mame | SVROUTETEST
Password r-““*“
Rogtng Parameters
al [~ Abswact ¥ Fenl [~ DICOM g m“’ | 3]
FBG [ Tea ¥ Routag Share
New | Max # Rowyon Consect | Sae [S5S :
Mnx # Ratry on Transmit !—
Fetenson Fenod (Days) i
Sebdwectony
{SuBDIR
g s I X Cancel | | T belp “#* Propenes
Field Description
NETWORK LOCATION Name of a share on the remote Radiologist’s server
Note: Use a name that reflects the location where these
images will be sent. This name is used in the ROUTE.
DIC file on the Routing Gateway.
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Field Description

IEN The record number in VistA for this Network Location.

PHYSICAL REFERENCE The UNC (Universal Naming Convention) containing
the server and share name for the remote storage
location.

OPERATIONAL STATUS Logical state of the share (“ONLINE" or “OFFLINE”).

STORAGE TYPE “ROUTER”

HASH SUBDIRECTORY A flat or hierarchal folder structure will be created/used
(default is hashed, display only).

ABSTRACT Abstract files can be copied.

FULL Full files can be copied.

BIG BIG files can be copied.

DICOM DCM files can be copied.

COMPRESSION Data compression/decompression is used on the files
being sent to the remote server. (Either none or JPEG-
2000, found on the table, not on the properties page,
can be edited by VA Fileman)

USERNAME Windows login Username for the remote server where
the images will be sent. This account must have
READ/WRITE access to the remote share.

PASSWORD Windows login Password for the remote server where
the images will be sent.

MAX # RETRY ON Number of times that will be attempted to get a

CONNECT connection to the remote server using the AutoRouter
software before a failure message is generated.

MAX # RETRY ON Number of times that a copy will be attempted to the

TRANSMIT remote server using the AutoRouter software before a
failure message is generated.

SYNTAX “UNC”.
The connection to the share will be in the format
\\server\share name.(Found on the table, not on the
properties page, can be edited by VA Fileman)

SUBDIRECTORY Name of a subdirectory where files are to be stored.
The value of this field is concatenated to the name of
the network location (the 'physical name') to create the
complete path-name.

RETENTION PERIOD Time in days that image files are kept on the remote
server before they are purged.

LAST PURGE DATE Date/time of last purge on the remote server.

SITE Name of the remote location.

Note: Use a name different from the NETWORK
LOCATION name. This string is displayed in
VistARad in the “RC” column.
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Field Description

TIME OFFLINE Date and time that this server was inaccessible. Set by
the routing application, found on the table, not on the
properties page.

3.8.1.4  GCCTab

Photo ID images, etc. can be sent to a remote location directly from the Queue Processor
software. These images are written to a share on the remote server using the Username/Password
contained in the properties of this storage type.

To edit the properties of a network location, right-click the entry and select Properties on the
pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

=10] x|
TIER1 | TER2 | Rouers |[GCC || EKG | URLs | Diegrams |
| RETWORK LOCATION | €N | PHYSICALREFERENCE | OPERATIONAL STATUS | HASH SUBDRECTORY | USERNAME ___ [PAssworD |
S il e
:f:I' GOC ) ter\vhanrwiA  (Hudden)
ey noecoin .._I GCC
Hotwork Credestials
User Name [—"ﬂ’i—
Poswword [
[« Operabonal Siates
[ Hashed Dw Strectern
Horw I l bt
o X Cancet T by o7 Propetes
Field Description
NETWORK LOCATION Name of a share on the server where the Photo ID, etc.

will be sent.
Note: Use names to reflect the type of transfer for
these shares.

IEN The record number in VistA for this Network Location.

PHYSICAL REFERENCE The UNC (Universal Naming Convention) containing
the server and share name for the remote storage

location.
OPERATIONAL STATUS Logical state of the share (“ONLINE" or “OFFLINE”).
STORAGE TYPE “GCC” for Global Carbon Copy (Displays as:
EXPORT)).
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Field Description

HASH SUBDIRECTORY A flat or hierarchal folder structure will be created/used
User Name IA User Name

Password IA Password

3.8.1.5 EKG Tab

The Clinical Display software has the capability to display EKG strips from local and remote
MUSE servers. When a patient is selected, the software maps to these MUSE locations using the
NET USERNAME field (#50) login in the IMAGING SITE PARAMETERS file (#2006.1) and
looks for the patient data. When it finds the image data, it is copied from the MUSE server to the
Display station and viewed by the user.

To edit the properties of a network location, right-click the entry and select Properties on the

pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

=10l x|
TIER1 | TIERZ | Fouters = GOC _. URLs Diagrams
[RETWORKLOC. LN Lmv‘sm REFE_] oPERATIONAL__ [ USERNAE __]PaSoworo s STES [ Muse versional
ru,[ w _: Cadke iDs - ks
vy A Stare Name JUSESD Py e
*  HNetwork Share MUSE-Ex0
v 0\VOLODEY =
Motwork Credentialy Secunty
Uses Nome | s e Adan
)
[ Operatonnl States
MUSE
ek & Vi #
|} o5 - e |
v X Gance P | Setopenes
Field Description
NETWORK LOCATION Name of a share on the MUSE server where the EKG
data is stored.
Note: Use names to reflect the type of transfer for these
shares.
IEN The record number in VistA for this Network Location.
PHYSICAL REFERENCE The UNC (Universal Naming Convention) containing
the MUSE server and share name.
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Field Description

USER NAME MUSE Network Administrator Name

PASSWORD MUSE Network Administrator password (encrypted)

STORAGE TYPE “MUSE-EKG”

OPERATIONAL STATUS Logical state of the share (“ONLINE" or “OFFLINE”)

MUSE SITE # MUSE EKG network location number. Typically, a site
with a single MUSE server that holds EKGs for one
site would use 1.

MUSE VERSION # MUSE software version

3.8.1.6 URLs Tab

The Remote Image Views functionality in the Clinical Display application uses a Network
Location entry that points to the VistA Site Service to determine the server and port of remote
VistA databases. This Network Location entry is a WEB service running on a centralized

accessible server on the network.

To edit the properties of a network location, right-click the entry and select Properties on the

pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

17 Location ¥ASK Setwork {on sbon “anaeger
TIER1 | TIER2 | Routers | GCC | EKG

2101

|| Diagrams

Cacive i

B L e e e T ey ——— a0l

NETWORK LOCATION | IEN | PHYSICAL REFERE OPERATIONAL STATUS ]

* Noteork Share

* Share Nams S TASITESERVICE T

ey

:ll1 L) SERVE VIS TA MILD VA GOVMVIS

= Operatoasnl Sinkes

Plerw O
v ] X Garcer ] 7t _!_:ﬁwl
Field Description
NETWORK LOCATION The name of this WEB service.
Note: suggested name- VISTASITESERVICE
IEN The record number in VistA for this Network Location
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PHYSICAL REFERENCE URL name of the location of the WEB service.
OPERATIONAL STATUS Logical state of the service (“ONLINE" or “OFFLINE”)
STORAGE TYPE “URL”

3.8.1.7 Diagrams Tab

The Diagram Annotation tool is an optional Imaging component that is accessed from CPRS.
The Diagram Annotation tool is used to annotate online diagram ‘templates’ and then save the
results directly to a patient’s electronic medical record.

To edit the properties of a network location, right-click the entry and select Properties on the

pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

1 Location VAME Setwark Lo slion Meneger -
TER1 | TER2 | Rouers | GGC | EKG | URLs

Drgroms|

[ NETWORK LOCATION | €N | PHYSICAL REFERENCE | OPERATIONML STATUS [ STORAGETYPE |

Cache 10w

i

* Skare Name [DIAGAAMS
* Network Share

OVHAAAAT T I MIAGRAME

r
1
* Operabonnl Statws i
|

rew |
v | momw | | i J—ﬁ“""““'Q
|

Field Description

NETWORK LOCATION The name of this template location.

IEN The record number in VistA for this Network Location.

PHYSICAL REFERENCE The UNC (Universal Naming Convention) containing
the server and share name for the template location.

OPERATIONAL STATUS Logical state of the service (“ONLINE" or
“OFFLINE”).

STORAGE TYPE DIAGRAM
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3.8.2 Adding a New Location to Network Location Manager

Note: The following procedure applies to all the tabs in the Network Location Manager window.

1.

60

From the Queue Processor menu bar, select Edit > Network Location Manager to open the
following window.

The Tier 1 tab is automatically selected.

To add a new network location, click the New button at the bottom. The Network Location
Properties window will be displayed.

[sthe) - Hictwork Location Propertics =0 %]
—Cache |Ds
B orage Type
* Share Hame l e Typ
% Netwaork Share “ TIER1
|  TIER 2
-~ EKG
 GCC
 DIAGRAM
" URL
 ROUTER
o K | X Cancal | S el ‘ 7 Help ETopedies

Type the Share Name.

At the Network Share field, either type the path to the location where images are to be stored,
or click the browse (...) button and specify the path.

Select the appropriate option at the Storage Type field.

Click Apply.

Additional fields relevant to the storage type are displayed. The example below is for Storage
Type Tier 1 only.

Note: The STORAGE TYPE field is preselected depending on the Network Location tab
selected. If the EKG tab is selected, then the STORAGE TYPE will be set to EKG, and so
forth. However, the preselected value can be modified.

Leave the Operational Status check box selected by default setting, or clear it.

Leave the Read Only check box cleared by default setting or select it.
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9. Click Apply to add the changes to the database or click OK to add the changes and exit.
3.8.3 Editing the Properties of a Network Location

To edit the properties of a network location, right-click the entry and select Properties on the
pop-up menu.

Note: This pop-up menu can also be accessed from the keyboard by using Shift + F10.

?-‘ {site} Network Location Manager H[=]
[TERT | TER2 | Rouwers | GCC | EKG | URLs  Disgrams |

O 2% RG-ATGI
5 MAGTAH | NETwORK .. | IEN | PHYSICAL ... | TOTALSP... | FREE SPA.. [ OPERATIO.. [ READ ONLY [ STORAGE ... [ HasH sUE.. |

- = = “= haGTH 1 WWHAATG.. 3094514 120874 On-Line YES TIER1 YES
S A Properties

Network Location Properties

B BG*ATGE * Share Name | 2h * Storage Type
2 MAGTH Network Share TIER1

- MAGEH
i MAGEH | [WYHAATGC XX AUMAGE2$) |

Bt RG-ATGY |
- MAGTIH
= MAGTTH
= MAGTZH
- MAGTIH

SpateTn Gigatytes
Capecity. 2363

¥ Operational Status
I Fead Only

Hashed

' 0K ‘ X Cancel ‘ A | ? Help | C_g Froperties

1. From the Queue Processor menu bar, select Edit > Network Location Manager and select
the appropriate tab.

2. Right-click a row in a table grid and select Properties from the pop-up menu displayed
above.
Note: only the properties applicable to the selected Storage Type are editable.

The Network Location Properties dialog box is displayed. The Share Name and Network
Share are displayed based on your selection.

September 2018 Background Processor User Manual, Rev 17 61
VistA Imaging MAG*3.0*214



?-' SALT LAKE CITY UT - Network Location Properties

Cache IDs

[_ O[]

* Share Name I|MM2

* Siorage Type

* -Network Share
[WSW-IMGOADBMM2$,

‘ TIER 1

¥ {Operational Status;
™ Read Only

Hashed

' OK | X Cancal | ¥ Apply |

7 Help < Propeties

3. Modify any of the enabled settings.

4. Click Apply and OK to add the changes to the database and exit or click OK to add the

changes and exit.
3.84
L.

Adding a RAID Group

following window.

The Tier 1 tab is automatically selected.

From the Queue Processor menu bar, select Edit > Network Location Manager to open the

[ TiER | TIER 2 | Fiuters | GCC | EKG
(5w RGATGT |

‘ LIRLs | Diagrams ‘

22 MAGTIH

NETWORK LOC I IENl PHYSI | TOTAL SPACE' FREE SPACE | OFERATION READ OMNLY
-2 MAGEH

STORAGE TYPE

ZEMAGTH 1 WwHA. 3084574 120562 OrrLine TES

MAGIH
RG-ATG2

-2 MAGIH
-2 MAGEH
=2 MAGEH
-2 RG-ATGS

-2 MAGIH
-2 MAGEH
-2 MAGEH
-2 RG-ATGY

= MAGTIH
-2 MAGTTH
-2 MAGTZH
- MAGTIH

l

HASH SUBDIF

TIER1 YES

List Wiew Style
New | Add Group | " OK | X Cancel | T Aty | 7 Help |  List % Report

2. Click the Add Group button at the bottom.

A new RAID group is added to the tree. For this example, the name would be RG-ATGS.
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3.8.5 GCC Queue for PhotolD

The GCC has a method for exporting photo IDs to a designated share as a post-capture process.
Its implementation requires an entry in the IMAGE ACTIONS file (#2005.86). Its purpose is to
export the files to a site specified print server or share either within the local area network or
external to the local area network.

This protocol was requested by Indian Health Service (IHS) and called for the exported file to
have the patient’s DFN included in the file name so that the operator could correctly assign a
patient photo IDs.

To activate this functionality, create one or more GCC locations to receive the exported photo
IDs using Network Location Manager. Edit the protocol in the IMAGE ACTIONS file
(#2005.86) using Fireman.

Example:

VA FileMan 2<.0
Select OPTION: ENTER OR EDIT FILE ENTRIES
INPUT TO WHAT FILE: 2005.86 IMAGE ACTIONS
(2 entries)
EDIT WHICH FIELD: ALL// ACTIVE
THEN EDIT FIELD: TAG
THEN EDIT FIELD: ROUTINE
THEN EDIT FIELD: TYPE (multiple)
EDIT WHICH TYPE SUB-FIELD: ALL//<enter>
THEN EDIT FIELD: EXPORT LOCATION
THEN EDIT FIELD: <enter>
STORE THESE FIELDS IN TEMPLATE: <enter>

Select IMAGE ACTIONS NAME: PHOTO-ID COPY

ACTIVE: NO// Y YES

TAG: PID//<enter> **

ROUTINE: MAGQBGCC//<enter>**

Select TYPE: PHOTO ID//< enter>

EXPORT LOCATION: GCC21 <<<this field points to the NETWORK LOCATION (#2005.2) file, select
the network location to receive the exported image file.

**the TAG and ROUTINE fields are predefined by VistA Imaging patch MAG*3.0%39 with the
routine to be used by the HIS. The files created at the exported location will be named using
the patient DFN. If a site wishes to change this, they can use a locally defined routine.
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Chapter 4 Queue Processor

Application Description

Setting up

Tasking

Understanding Processing
Starting/Running the application
Reports

4.1 Application Description

The Queue Processor application is the main application in the BP product suite. It processes all
the I/O operations between the Tier 1 shares and the Tier 2 device (jukebox). It is important that
this process be monitored daily and kept running continuously. It performs the following tasks:

64

Copies new images from the Tier 1 to Tier 2.

Retrieves images from Tier 2 to Tier 1.

Triggers Purge events (automatic and scheduled).

Triggers Verifier events (scheduled).

Manages disk space consumption specified by the Imaging Coordinator.
Processes queue entries.

Creates abstract files from Full/BIG files.

Processes images from remote cameras and capture device in Clinical procedures.
Copies images to remote destinations outside of Imaging.

Watermarks images associated with a Rescinded Advance Directive with the text
“Rescinded”.

4.2 Setup Guidelines

Once the Queue Processor is installed, one or more BP Servers are required for
processing.

Tasks are assigned to each BP Server. One task cannot be assigned to multiple servers;
however, a task can be assigned to any server to change the priority of processing.

In addition to setting up the task assignments, there are various parameters that need to be
set up as described in this document.

Once the parameters are set up, the Queue Processor can be started to process active
queue entries.
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Note: The Queue Processor runs without operator intervention and should operate continuously
to keep pace with the workload. It should be monitored daily and it is highly recommended to
task the BP Monitor utility. For details, see Chapter 7 System Monitoring.

4.3 Tasking

The Queue Processor has a set list of tasks that it performs. The specific requests for each task
originate on the local Queue Processor or from another VistA Imaging product.

The process is as follows:

1. These requests are sent to the VistA database and are stored on FIFO lists called queues.

2. The Queue Processor dynamically checks these queues to determine if there is work to be
completed.

3. When an entry is found, the processing is started based on the queue type.

4. When the processing is successfully completed, the queue count is decremented and the
Queue Processor waits for another task to be sent.

5. When the processing fails the entry is re-queued twice before it is placed on a failed
queue for that task. Failed IMPORT queues must be manually re-queued; there is no
retry.

Note: You will be required to investigate and determine the reason for the failure and re-
queue the item once the problem is resolved.
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When all the tasks are assigned to one server, the queues are processed in the following order of
priority:

e JBTOHD (jukebox to hard drive) restores images to the Tier 1 shares from the Tier 2 device
based on requests for viewing these images on display workstations or creating missing
abstract files.

Note: images can only be viewed from the Tier 1 shares.

JBTOHD Queue

Clinical Display Workstations, VistaRad, and/or the Abstract queue add a request to the
JBTOHD queue to copy image files from the Jukebox to VistA Imaging Shares for the
Clinical Display Workstations or VistARad to access.

VistA Display
Workstations

7\

JBTOHD T — __
y VistA Imaging
Shares (RAID)

ABSTRACT
Queue
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e PREFET (pre-fetch) populates the Tier 1 shares with images that were requested on display

workstations by users with the MAG PREFETCH security key.

PREFET Queue

Note: Only for users who have the MAG PREFETCH security key

VistA Display
Workstations

PREFET

Clinical Display Workstations and VistARad add a request to the PREFET queue to copy image files
from the Jukebox to VistA Imaging shares for VistA Display Workstations and VistARad to access.

VistAImaging
Shares (RAID)

)

e ABSTRACT creates thumbnail files with the .abs file extension, when this file type does not
exist for an image set. These file derivatives only exist for certain types of files and can only
be created when the Full or BIG files are present for an image set. See Chapter 9 for

additional information about the Abstract/Thumbnail maker.
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ABSTRACT Queue

VistA Capture Workstations and/or the Import Queue add a request the ABSTRACT queue to create

thumbnails (AB S derivatives) of images.

IMPORT
Queue N
ABSTRACT
Queue
VistA Capture
Workstations

&
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e IMPORT provides a means for external applications to store images in the VistA Imaging

environment using the IMPORT API. It also watermarks images associated with a Rescinded

Advance Directive with the text “Rescinded”.

IMPORT Queue

External applications add a request to the IMPORT queue to capture external images (typically,
clinical procedures, Veteran ID Cards, and iMed Consents)in the VistA Imaging environment.

T My ony
Queue

External
Apps
VistAlmaging
Shares (RAID)
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JUKEBOX copies images from a Tier 1 share to Tier 2.

VistA Display
Workstations

JUKEBOX Queue

When capture applications such as VistA Display Workstations acquire new images, they add a
requestto the JUKEBOX queue to copy these images from VistA Imaging shares to the Jukebox
for long-term archival storage. Failed images are re-queued for archival.

JUKEBOX
TR > i <
<:| VistA Imaging
Jukebox Shares (RAID)
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e DELETE removes images from the VistA Imaging shares. The DELETE queue is set when
an end-user, who has the MAG DELETE security key, selects an image to be deleted in the

Clinical Display software. Typically, these are images that are of poor quality or saved
against the wrong patient.

DELETE Queue

VistA Display Workstations add a request to the DELETE queue to remove any image files from the
VistA Imaging shares that are poor in quality or contain the incorrect identity of a patient. After a copy of
the image file is verified on the Jukebox, the file is deleted from the VistA Imaging shares. The
verification process of the image on the Jukebox will create a JUKEBOX copy if not currently on the
Jukebox.

MNote: Users must have a MAG DELETE security key.

VistA Display
Workstations

|

Shares (RAID)

e GCC (generic carbon copy) copies images to specified remote locations.

GCC Queue

Capture applications such as VistA Imaging Clinical Capture can add a request to the Generic
Carbon Copy (GCC) queue to exportimages to a Windows share on an external commercial system.

VistA Capture
Applications

Text and

Graphic

Generic Carbon Images
Copy Queue

VistA Imaging

Shares (RAID)
External D
Share <
Location
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e EVAL entries are initiated by the DICOM Gateways to facilitate auto routing of images to
remote display workstations.
Note: The EVAL queue is not processed by the BP Queue Processor but may be purged
using the Queue Management by Type option.

EVAL Queue

Stage 1: A site can set up routing rules that determine if an image meets certain criteria for exporting to external
locations, ex: to route CT scans to a particular physician. If a DICOM Gateway is configured as part of a routing
environment, as it accepts images from modalities, the DICOM Gateway adds a request to the EVAL queue to
evaluate an image to see if it is a candidate for routing. The image is then routed to a remote VistARad workstation
for the physician to view.

(remote)
VistARad

CT scan from DICOM
a modality Gateway ﬂ
: : Requests EVAL e ‘\N‘n
NN

— Queue \ \I’{b

Stage 2: If there are no active routing processors, requests (entries) in the EVAL queue can grow to a large
number of entries. To resolve this, the Queue Manager can be used to periodically purge the requests. In addition,
the gateway parameters must be changed to turn off Auto Routing. See the Image DICOM Gateway User Manual.

Accumulating
Requests

Queue Manager AR EVAL
Queue

4.4 Understanding Processing

When the BP Server tasks are set up and the parameters are set to the values determined by the
site, click the Start button to start processing queue (task) entries. The processing steps for a
typical JUKEBOX request are described below:

1. When an image is processed by the DICOM Gateway or Clinical Capture workstation,
the image file is copied to a Tier 1 share. The VistA record for that image is updated with
the Tier 1 share location.

2. The Clinical Workstation application or DICOM Image Gateway then requests that an
image be saved to the jukebox by creating an entry in the JUKEBOX queue file on
VistA. The queue entry identifies the file path, the origination of the file and other
pertinent data that the Queue Processor will need to successfully complete the processing.

3. When the JUKEBOX queue entry is processed, the image file is copied from the Tier 1
share to the Tier 2 device (Jukebox) and the queue entry is deleted from the queue file.
The queue count for the JUKEBOX queue is decremented to reflect the number of
remaining queue entries to be processed.
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4.5 Starting/Running the Application
4.5.1 Starting the Application and Analyzing the Activity

1. From the Windows Start > Programs menu, select VistA Imaging Programs > Background
Processor > Queue Processor.

2. Log into the application using a valid VistA access and verify code.
Note: The secondary menu option All MAG* RPC's [MAG WINDOWS] is required for
access to the Queue Processor.

The Queue Processor application window opens.

’ BP Queue Processor - BP Server: GEKGFE - VACOLTKIRINGA - Site: SALT LAKE CITY -

File Edit View Help

Visth Storage <patch #> 10:5:12 AM |

MNetwork Location Name  |Storage Type |IEN |Free Space |Disk Size

@ Start @ Stop

Q | Active | Failed |

< [ 3

Background Processor Event Log

Event Time Process: Queue IEN |Process Status o

3. Click the Start button in the upper right-hand corner.

If the Queue Processor is not properly configured, the application will send alert messages.
Review the steps in section 2.5 Configuring BP Servers.

4. After one or two minutes, click the Stop button and view the populated fields.
If no queues have entries, only the storage statistics are displayed in the VistA Storage
section of the window.
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The following example shows a sample output of processed activity. The queues being

processed are displayed under the Start button.

-
#% BP Queue Processor - BP Server: GEKGFE - VACOLTKIRINGA - Site: SALT LAKE CITY -

User | <user names sl

File

VistA Storage

Edit View Help

MNetwork Location Name

RG-GO3

RG-GO2
RG-GO1

<patch #> 10:31:01 AM
° | O Start @

Storage Type ‘IEN ‘Frcc Space ‘Disk Size +
Queue | Active | Failed |

GRP o0 0 ABSTRACT 0 14

GRP 78 0 0 JUKEBOX 43 4
JBTOHD 0 s

GRP 77 1] 1] DELETE 0 0
IMPORT 0 6

GRP 76 349269 hg5112

r

BP Event Log - C:\Program Files [x86]\VistA\lmaging\BackProc\LOG\BackProc\BackProc.LOG capture ON

Event Time

Process: Queue |[EN

Process Status o

8/6/2018 10:28:32 AM

8/6f2018 10:28:31 AM
8/6f2016 10:28:31 AM
8/6f2018 10:28:31 AM
8/6f2016 10:28:31 AM
8/6f2018 10:28:31 AM

8/6f2016 10:28:31 AM

4

STOPPED
Requeue result:
Requeuing: 14136
JUKEBOX:14136
Jukebox: 14136
Jukebox: 14136

Jukebox: 14136

Background Processor stop button depressed.

14183

PDF ABS NOT Copied.
ABS : NOT Copied. 997. Overlapped I}O operation is in progress
WYACOLTKIRINGA.DVA VA GOWIMAGE 15\GK0 0000040342 AGKO0DO(

PDF : NOT Copied. 997 Overlapped I}O operation is in progress

-

+

VistA Storage

Name

Description

Network Location Name

Name of the entry in the NETWORK LOCATION file

Storage Type Types of storage:
Tier 1
Tier 2
Group (GRP)
Note: These types are also defined in the Network Location
Properties dialog box.

IEN Internal Entry Number in the NETWORK LOCATION file for the
Storage Type device

Free Space Disk free space available in megabytes

Disk Size Disk space capacity in megabytes

Share Path UNC path of the share
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Name Description

RAID Group RAID share group name

(Queue Activity box)

checked. For details, see Chapter 8 Troubleshooting.

Queue Name of the queue identifying the task being processed
Active Number of active files to be processed
Failed Number of files that failed in processing. Failed queues should be

BP Event Log - {log file location}

Event Time

Date and time of the last run of the log

Process: Queue IEN

Queue type, queue number, and status check info

Process Status

Source and destination of each file transfer, creation, or deletion

4.5.2 Delay Between Queue Processing.

Description

Icon

On the BP Main window, there is a panel to the left of the
Start button. It shows the time of day.

J 14:48:24

—

| Acti

Queue

If the user double—clicks on the time of day, a panel with a
list of selectable delays will show. The user will not have to
stop the BP. The entries in the list are in milliseconds (ms).

14:51:53

Set the pause [delay] thatis implemented

after processing each queue item.

The Delay pane can be shown by clicking on the menu
option: Edit | Set Queue pause (delay)

Imaging Site Pararneters
Refresh Queue Counts

Set Queue pause (delay)

When the BP is started, 1000 ms is selected. The user can delay (ms] [T =~ ~ Close
select a different delay to speed up the processing of 1000
queues. 1533
10
Edit | View Help

If there are “0” active queues, the phrase “(0 Active)” will be
displayed and the delay will change to 3 seconds. When
there are active queues, the “(0 Active)” will be hidden, and
the delay will change back to what is selected in the Delay
drop down list.

14:54:53 [0 Active
[t s 3
AID Group -
Queue | Active |
ABSTRACT O
JUKEBOX 0
JBTOHD 1}
DELETE 1}
PREFET 0

Note: The time of day has been added as a visual indicator that the BP is running and isn't hung or
frozen. The time of day is updated every second (or every 3 seconds if there are 0 active queues).
The time of day will switch between being underlined and not underlined every time the BP checks
VistA for queues to process as another visual indicator that the BP is running. The entries in the list of
queues will not be highlighted and will not flash anymore as the list is updated.
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4.5.3 Getting Help
Help is available from different sources:
e Queue Processor GUI
» Hovering the cursor over the application window and pressing the F1 key
» Selecting Help from the menu bar
e (all customer support at the National Helpdesk.

Note: Be sure to have the information shown in the example of the table that follows and
a copy of the most recent log files.

Name Description
Version Software version, build number and CRC
number.

C:\Program Files\VistA\Imaging\ | Location of the Background Processor

BackProc\Magbtm.exe executable on your hard drive.
6030 KB {date} File size and date of executable.
Mag MakeAbs.exe Executable and version number of the

ABSTRACT queue used to create the
abstracts (thumbnails) of images.

System Installations Version and installation date of Imaging
patches.
Note: The latest patch is listed at the bottom.

4.6 Reports
Three types of output are produced to notify users of important occurrences:
e Log files
e Emails
e Screen-generated output
4.6.1 Log Files

New log files are created as HTML files at the beginning of every session. HTML files are
viewable, printable, and searchable. By default, the BP Queue Processor log files reside in the
C:\Program Files\VistA\Imaging\BackProc\log\BackProc directory. These files can be accessed
by:
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e Selecting File > Open Log on the BP Queue Processor menu bar
e Using an internet browser

Note: The log files can be imported into an Excel spreadsheet.

Important: These files should be kept for historical/troubleshooting reasons and added to the
tape backup process to safeguard the files. (See Appendix B: Backups in the VistA Imaging

System Installation Guide.)
4.6.1.1 Log File Format

BP Queue Processor log files are archived as HTML files and have the year-month-day and

sequence number imbedded in the file name, as shown in the right pane of the window.

@ C:'Program Files',YistA' Imaging'BackProc' log'BackProc
File Edit Wiew Favorites Tools Help l?
0 Back ~ (J - i | ' Search |[= Folders | & 3 X 9 | -
Address IJ C:YProgram Files\VistAlImaging'BackProcilogiBackProc j E’ Su
Folders X || Name - | S\zel Type | Date Modified I Attributes
] | | @leackeroczo0_07_z0.html 2KE  HTML Document 7/20/2000 12:33PM A
BT vistA | | @]Backproczans_oa_o7.heml ZKE  HTML Document (7/2009 5:55 AM A
(DD Broker &]BackPrac2009_08_13.html 2KE  HTML Document 8/13(20098:34 AM A
Bl 1D Imaging &]BackProc2003_08_14.html SKE HTML Document 5/14/2009 10:53 &M A
B 3 BackProc &|BackProc2009_03_14_01.heml 21KE  HTML Document 8/14/2009 3:14PM A
122 Help [Z] BackProc.LoG SKE Test Document /142003 340PM A
=12 log [ EPError.LOG OKB Text Document 7202009 12:32 PN A
)

If more than one log file is run on the same day, the system adds a sequence number such as
“01” following the date in the file name. For multiple runs on the same day, the highest sequence

number is the latest log file run for the day.

The Queue Processor produces multiple log files for a processing run. Each file contains
different information.
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4.6.1.2 BackProc Log

The BackProc.log file records all activity in the Event Log section in the Queue Processor
window.

EP Queue Log - Microsoft Internet Explorer

File Edit Wiew Favorites Tools Help

‘JBaCk'\J'ﬂ@ ul
Address I@ Z:\Program Files\Vista\ Imaging| BackProciloglBackProciBackProc2009_10_29_01.html

) search <7 Favorites 44 | - w =

| D=teMime | Ewent:_Gueus_Ref | Message/Path
[10e28:2008 12:30:52 PM [BP Versian [20.1.20.24

[10/20/2000 12:30.52 P [BP O3 [win Semvers.2 3780

[10e28:2008 12:30:52 PM Wk Station [wHAISIHITEVMZ

[10/20/2000 12:30:52 PM | Vista Imaging Install [3.0P38

[10r28:2008 12:30:52 PM | Victa BrokerSerser  [vhaismuhitevme

[10/28/2008 12:30:52 P |Raid erify [Chedding File Sener Space

[10/20/2000 12:30:54 PM [dukeBosCacheSize [JBCache Percent Spase Available: 03

[10/20/2009 12:30:54 PM [Jukebos: 294 [ HAISIAHITEVM1UMAGE 1FOMM0 11DMO01 167 T GA W HAISIAVHI TEVM1UIMAGEIBIRDMID 1 167. T A
[10/29/2000 12:20:55 PM [Jubebox: 204 [Jukebes copy not ovenuitten.

[10/2a:2009 12:30:55 P [JUKEBOX: 284 [SHAISIAHITEVM 1 MAGE 15.DMMI0 11DMO01 167 . TXT WAHAISIIHITEVITUMAGEJB1H10 MO0 1167 TXT
[10/20/2000 12:30.55 PM [JUKEBDX: 209 [TAT Mot copied.

[10/20:2009 12:30:55 PM [Jukebos: 294 [ HAISIAHITEVM 1 MAGE 15.DMMI0 11DMO01 167 ABS WWHAISIIHITEVMTUMAGEIB1H10 MO0 1167 ABS
[10/29/2000 12:20:55 PM [Jubebox: 204 [Jukebes copy not ovenuitten.

[10e28.2008 12:30:55 PW [JUKEBDX:204 |

[10/20/2000 12:20.56 FM % Server Reserve | Low Water Mark: % Free Space: 17.88%

[10s282008 12:30:55 PM [ JukeBoxCacheSize [JBCache Percent Space Available: 0

| 10429/2009 12:30056 PM |Jukebox: 295 |'\\VHAIS‘LI1I‘LI1I'HITE\-‘M1'\IMAGE1$\.DM\DD'\1 D MO0 162 T GA WHAISMAVHI TEVMAMMAGEJBIFD MO0 1163 TGA

[10s28:2008 12:30:58 PM [ Jukebox: 205 [Jukeb o copy not ovenuritten.

|1D.-‘29."2IJDQ 12:230:56 P |JUKEBDX: 285 |\\VHAIS‘LI1IWHITE\IM1\IMAGE1$\.DM\DD'\‘1 DO T16S. THAT WYHAISWWHITEWVIMAM M AGEJB 1D MO0 1168 T AT

[10e28:2008 12:30:55 PM [JUKEBDX: 205 [TT Hot copied.

|1D.-‘29."2IJDQ 12:230:56 P |Jukebox: 2495 |'\\VHAIS‘LI1I‘LI1I'HITEVM1\IMAGE1$\DM\DD\1 1001168 A S WYHAISWIWHITEVIM MM AGEJB 1D MO0 1565 ABS

[10/20/2000 12:30:56 PM_[Jukeb s 205 [Jukeb os¢ copy not svenitten.

Name Description
Date/Time Actual time when the IMAGE file (#2005) was processed
Event Queue Ref Queue name and entry number and status check info

Message/Path Description of action taken (or statistics for status checks)
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4.6.1.3 BP Error Log

The BPError.log file records error conditions with the operating system and Broker.

B bz o e e ——_____________________________________ B
File Edit Wew Favorites Tools Help | ",'
) Back - €3 - [« [2] A | - Search 7 Favorites 42 | - B
Address I@ CHiProgram Filesi¥istalImagingiBackProcilogiBackProcBPEFror2010_03_30_0001. bkl j Go | Links *

—
[ DateMme [ Event:_Oueue_Ref [ MessagerPath
[330/2010 11:28:01 Amt [eCC cannection [MetcanEmor
[330/2010 11:98:01 Amt [eCC connection [MetcanEmor
[330/2010 11:90:01 Amt [ecC connestion [MetcanEmor
[3302010 11:98:01 am [ecC connestion [Metcanmor
[a202010 11:40:02 Am [ecC sonnestion [MetcanEmor
[a20/2010 11:40:02 Amt [4CC sonnestion [MetcanEmor
[30:2010 11:40:02 Am [6CC connection [HetcanEmor
[30/2010 11:40:02 AM [eCC connection [NetconError
[30/2010 11:40:03 Amt [#CC connestion [etcanEmor
[3:30/2010 11:28:03 Amt [eCC cannection [MetcanEmor
[3:30/2010 11:98:03 Amt [eCC connection [MetcanEmor
[330/2010 11:90:03 Amt [ecC connestion [MetcanEmor
[330/2010 11:90:04 am [ecC connestion [Metcanmor
[a202010 11:40:04 Amt [ecC sonnestion [MetcanEmor
[330/2010 11:20:04 Am [ecC sonnestion [MetcanEmor
[30/2010 11:40:04 Amt [6CC connection [HetcanEmor
[aea0i2010 11:48:05 am [#Ct: cannection [MettonErar
[30/2010 11:40:05 Amt [#CC connestion [etcanEmor
[3:30/2010 11:28:05 Amt [eCC cannection [MetcanEmor
[3:30/2010 11:28:05 Amt [eCC cannection [MetcanEmor
Name Description
P

Date/Time Actual time when the IMAGE file (#2005) was processed
Event Queue Ref Error category

Message/Path Description of error condition

4.6.2 Email Messages

The following messages, listed in alphabetical order, are generated or triggered by the Queue
Processor.

Important: Be sure to add the local Image support staff person to the local MAG SERVER mail
group, and at least one pager number in the MEMBERS REMOTE multiple.

4.6.2.1 Ad_Hoc_Image Site Usage

This message is sent when the menu option Ad hoc Enterprise Site Report [MAG
ENTERPRISE] is used and it has completed gathering information.
Example:
Subj: Ad Hoc Image Site Usage: SALT LAKE CITY"660 [#31177] 10/14/09@15:20
168 lines
From: IMAGPROVIDERONETWOSIX,ONETWOSIX In 'IN' basket. Page 1
SITE: SALT LAKE CITY"660

Reporting Period: Jul 06, 2009 - Oct 14, 2009
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DATE: OCT 14, 2009@15:20:48 EST
DOMAIN: IMGxxxxx.MED.VA.GOV
2005 ENTRIES: 17805
2006.81 ENTRIES: 5
Production Account: O
WS DIS VERS: 3.0.59.31"Win XP.5.1.2600"1
WS DIS VERS: 3.0.72.30"Win Server.5.2.3790"1
WS CAP VERS: 3.0.72.30"Win XP.5.1.2600"1

4.6.2.2 Application Process Failure

This message is sent by several of the Imaging applications when the PLACE value cannot be
resolved for the image entry. The PLACE value is a valid entry in the IMAGING SITE
PARAMETERS file (#2006.1) or a value in the ASSOCIATED INSTITUTION field (#.04) of
this file.

Example:

Subj: Application process failure [#846445] 23 Oct 2009 09:45:30 -0400 (EDT)
18 lines
From: <xxx@DETROIT.MED.VA.GOV>
SITE: DETROIT.MED.VA.GOV
DATE: OCT 23, 2009@09:45:30 EDT
Cannot determine 'place' (location, division, institution) for image.
At: GETPLACE+5”MAGBAPI +3 = I 'PLACE, $SMAXREP (10) D

Called From: PLACE+1"MAGBAPI +1 = Q $SGETPLACE (+$0("MAG(2006.1,"B",IEN,""))

Application Process Failure messages are generated when the Imaging system cannot determine
which Imaging platform to use because it cannot identify the division of either the user or of the

image.

80

Division of user not clear — This indicates that there is not cross reference for the
Imaging user (DUZ(2)) in the SITE PARAMETER file (#2006.1). To correct this, the
VistA Imaging administrator must define the ASSOCIATED INSTITUTION field (#.04)
for that user (DUZ(2)) in the SITE PARAMETER file (#2006.1).

Division of image not clear — When the storage software (the Background Processor
Verifier or the Background Processor Purge) cannot determine the division of an image it
is attempting to store the VistA Imaging administrator must define the division in the
ACQUISITION SITE field (#.05) in either the IMAGE file (#2005) or the IMAGE
ARCHIVE file (#2005.1).

Example 1: Background Processor Verifier Application Process Failure Message

Subj: Application process failure [#52970] 12/19/12Q@13:46 23 lines

From: VistA Imaging $SGETPLACE MAGBAPI In 'IN' basket. Page 1

SITE: IMGDEMO1l.MED.VA.GOV
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DATE: Dec 19, 2012@13:46:08 EST

Production Account: O
At: GETPLACE+5”MAGBAPI +3 = I 'PLACE, $SMAXREP (10) D

Called From: PLACE+1"MAGBAPI +1 = Q $SGETPLACE (+S0("MAG(2006.1,"B",IEN,"")))
Called From: CNP2+27"MAGQBPGl +1 = . S PLACEOK=$S ($$PLACE"MAGBAPI (+ACQSITE)=5%$
PLACE"MAGBAPI ($G(DUZ (2))):1,1:"™)
Called From: CNP2+20"MAGQBPGl +3 = F D SCAN"“MAGQBPGI1 (.IEN,ORDER, .GL) D Q: (((
'OFFLINE) &§PLACEOK) ! ('IEN) ! ($P(RESULT,U,21)="DUPE") ! '$G (ACQSITE) )
Called From: CAPI+11"XWBBRK2 +1 = D @R
Called From: CALLP+18"XWBBRK +1 = . D CAPI"XWBBRK2 (.XWBP,XWB (2, "RTAG"),XWB(2,"
RNAM"), S)
Called From: CALLP+15"XWBBRK +3 = IF '+ERR, (+S=0)! (+S>0) D
Called From: MAIN+30"XWBTCPC +1 = . . D CALLP"XWBBRK (.XWBR, XWBTBUF)
Called From: MAIN+26"XWBTCPC +2 = . IF TYPE D
Called From: MAIN+2"XWBTCPC +2 = F D Q:XWBTBUF="#BYE#"
Called From: RESTART+3"XWBTCPC +2 = U XWBTDEV D MAIN
XWBTBUF: 007XWB;;;;000420MAGQ JBSCN”000250020000503305005033050010
MAGDA: 3305
This is the new example 1 (from Feb. 1, 2013)
Subj: Application process failure [#52970] 12/19/12Q@13:46 23 lines
From: VistA Imaging $SGETPLACE MAGBAPI In 'WASTE' basket. Page 1

SITE: IMGDEMO1l.MED.VA.GOV

DATE: Dec 19, 2012@13:46:08 EST
Production Account: O

At: GETPLACE+5”MAGBAPI +3 = I 'PLACE, $SSMAXREP (10) D

Called From: PLACE+1"MAGBAPI +1 = Q $S$SGETPLACE (+$0("MAG(2006.1,"B",IEN,"")))
Called From: CNP2+27"MAGQBPGl +1 = . S PLACEOK=$S ($$PLACE"MAGBAPI (+ACQSITE)=5$
PLACE"MAGBAPI ($G(DUZ (2))):1,1:"™)
Called From: CNP2+20"MAGQBPGl +3 = F D SCAN"“MAGQBPGI1 (.IEN,ORDER, .GL) D Q: ( ((
'OFFLINE) &§PLACEOK) ! ('IEN) ! ($P(RESULT,U,21)="DUPE") ! '$G (ACQSITE) )

Called From: CAPI+117XWBBRK2 +1 = D @R

Called From: CALLP+18"XWBBRK +1 D CAPI"XWBBRK2 (.XWBP,XWB (2, "RTAG") ,XWB (2,"
RNAM") , S)

Called From: CALLP+15"XWBBRK +3 = IF '+ERR, (+S=0)! (+S>0) D

Called From: MAIN+30"XWBTCPC +1 = . . D CALLP"XWBBRK (.XWBR, XWBTBUF)

Called From: MAIN+26"XWBTCPC +2 IF TYPE D

Called From: MAIN+2"XWBTCPC +2 = F D Q:XWBTBUF="#BYE#"
Called From: RESTART+3"XWBTCPC +2 = U XWBTDEV D MAIN
XWBTBUF: 007XWB;;;;000420MAGQ JBSCN”000250020000503305005033050010
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MAGDA: 3305

Example 2: Background Processor Purge Application Process Failure Message

82

Subj: Application process failure [#52971] 12/19/12Q@15:12 22 lines
From: VistA Imaging $SGETPLACE MAGBAPI In 'IN' basket. Page 1

SITE: IMGDEMO1l.MED.VA.GOV

DATE: Dec 19, 2012@15:12:15 EST
Production Account: O

At: GETPLACE+5”MAGBAPI +3 = I 'PLACE,$SMAXREP (10) D

Called From: PLACE+1"MAGBAPI +1 = Q $SGETPLACE (+$O("MAG(2006.1,"B",IEN,"")))
Called From: FILEREF+77”MAGQOBPRG +1 = I PLACE'=$$PLACE~MAGBAPI (+SP ($G ("MAG (200

5,IEN,100)),U,3)) D Q

Called From: CAPI+11"XWBBRK2 +1 D @R
Called From: CALLP+187XWBBRK +1 = . D CAPI"XWBBRK2 (.XWBP,XWB (2, "RTAG"),XWB(2,"

RNAM") , S)

Called From: CALLP+15°XWBBRK +3 = IF '+ERR, (+S=0)! (+S>0) D
Called From: MAIN+30"XWBTCPC +1 = . . D CALLP"~XWBBRK (.XWBR, XWBTBUF)

Called From: MAIN+26"XWBTCPC +2

IF TYPE D

Called From: MAIN+2~"XWBTCPC +2 = F D Q:XWBTBUF="#BYE#"

Called From: RESTART+3"XWBTCPC +2 = U XWBTDEV D MAIN

XWBTBUF: 007XWB;;;;001160MAGQBP FREF"000980400\\VHAISWIMGSI\IMAGE6S\DMOO\00\00\
00\33\0190DM000000003305.ABS0040abs0230\\VHAISWIMGS1\IMAGE6S\

MAGDA: 3305

This is the new example 2 (from Feb. 1, 2013)
Subj: Application process failure [#52971] 12/19/12Q@15:12 22 lines
From: VistA Imaging $SGETPLACE MAGBAPI In 'WASTE' basket. Page 1

SITE: IMGDEMO1l.MED.VA.GOV

DATE: Dec 19, 2012@15:12:15 EST
Production Account: O

At: GETPLACE+5”MAGBAPI +3 = I 'PLACE, $SMAXREP (10) D

Called From: PLACE+1"MAGBAPI +1 = Q $S$SGETPLACE (+$0O("MAG(2006.1,"B",IEN,"")))
Called From: FILEREF+77"MAGQBPRG +1 = I PLACE'=$S$SPLACE"MAGBAPI (+$P ($G("MAG (200
5,IEN,100)),U,3)) D Q
Called From: CAPI+11"XWBBRK2 +1 = D @R
Called From: CALLP+187"XWBBRK +1 = . D CAPI"XWBBRK2 (.XWBP,XWB (2, "RTAG"),XWB(2,"
RNAM"), S)

Called From: CALLP+15"XWBBRK +3

IF '"+4ERR, (+S=0)! (+S>0) D

Called From: MAIN+30"XWBTCPC +1 = . . D CALLP"XWBBRK (.XWBR,XWBTBUF)
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Called From: MAIN+26"XWBTCPC +2 = . IF TYPE D

Called From: MAIN+2"XWBTCPC +2 = F D Q:XWBTBUF="#BYE#"

Called From: RESTART+3"XWBTCPC +2 = U XWBTDEV D MAIN

XWBTBUF: 007XWB;;;;001160MAGQBP FREF~000980400\\VHAISWIMGS1\IMAGE6S$\DMOO\00\00\
00\33\0190DM000000003305.ABS0040abs0230\\VHAISWIMGS1\IMAGE6S\

MAGDA: 3305

The USER was: IMAGPROVIDERONETWOSIX,ONETWOSIX DUZ: 126

Key elements are used in the messages generated by the Background Processor components to
identify the Internal Entry Number (IEN) of the image and the storage application that generated
the message. These elements and their values are highlighted in the examples.

The value of the label XWBTBUF contains the Remote Procedure call associated with
the storage application.

The value of MAGQJBSCN in Example 1 indicates that the storage application is the
Background Processor Verifier.

XWBTBUF: 007XWB;;;;000420MAGQ JBSCN”000250020000503305005033050010

The value of MAGQBP in Example 2 indicates that the storage application is the
Background Processor Verifier.

XWBTBUF: O007XWB;;;;001160MAGQBP FREF"000980400\\VHAISWIMGS1\IMAGE6S\DM0O0O\00O\0O0\
The value of the labels MAGDA, MAGGDA, and MAGIEN is the image [EN.

In Example 1, the value of the label MAGDA indicates that the IEN of the image is
3305.

MAGDA: 3305

In Example 2, the value of the label MAGDA indicates that the IEN of the image is
3305.

MAGDA: 3305

4.6.2.3 Auto RAID Group Purge

This message is sent by the Queue Processor when the following conditions occur:

The Scheduled RAID Advance Group is scheduled and the Auto Purge is set.

The next share in the RAID group reaches the Percent Server Reserve and a purge is
automatically started.

Example:

Subj: Auto RAID group purge [#31180] 10/27/09@15:04 2 lines
From: VistA Imaging Auto RAID group purge In 'IN' basket. Page 1 *New*
SITE: IMGDEMO1l.MED.VA.GOV

DATE: Oct 27, 2009@15:04:37 EST
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4.6.2.4 GCC Copy Error
This message is sent during processing when GCC queues have connectivity problems.

Example:
Subj: GCC Copy Error [#31157] 10/07/09@20:36 6 lines
From: VistA Imaging GCC Queue Error In 'IN' basket. Page 1 *New*
SITE: IMGxxx.MED.VA.GOV
DATE: Oct 07, 2009@20:36:22 EST

"The GCC queue processor is having difficulty copying files to the network
location. The last copy attempt failed 3 times with an error status of
\\VHAxxxx400\GCC24$: Cannot connect to the Export Share. The next notification
will occur in 6 hours.

4.6.2.5 Get_Next_RAID_Group_Failure

This message is sent by the Queue Processor when the Scheduled RAID Advance is set and it
cannot advance to the next RAID Group perhaps because all the shares in the group are set to
READ ONLY or there is a connectivity problem.
Example:
Subj: Get Next RAID Group failure [#31173] 10/27/09@13:51 4 lines
From: VistA Imaging Get Next RAID Group failure In 'IN' basket. Page 1 *New*
SITE: IMGxxxx.MED.VA.GOV
DATE: Oct 27, 2009@13:51:46 EST

Production Account: 0
The get next raid group function failed!
4.6.2.6  Image_Cache_Critically_Low

This message is sent by the Queue Processor when it determines that the cache is below the
Percent Server Reserve factor and the Auto Purge has not been set.
Example:
Subj: Image Cache Critically Low at [#31158] 10/07/09@21:40 22 lines
From: BACKGROUND,USER I In 'IN' basket. Page 1
SITE: IMGDEMO1l.MED.VA.GOV
DATE: Oct 07, 2009@21:40:01 EST
SENDER: SALT LAKE CITY Imaging Background Processor
Total Cache Free: VistA Imaging RAID storage is Critically Low gigabytes
Total Cache Available: 2131 gigabytes

The Automatic Purge process is NOT configured. The 4 Imaging cache servers will
require operator intervention to ensure continued availability. The following
MAG SERVER members are being notified:

IMAGPROVIDERONETWOSIX, ONETWOSIX
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IMAGPROVIDERONETHREETHREE, ONETHREETHREE

The next notifications will occur in: 0 hours.
4.6.2.7 Image File Size Variance

This message is sent during a purge when a file on Tier 1 has met the criterion for deletion but
the copy of this file on the jukebox is a different size.
Example:
Subj: Image File Size Variance: [#852162] 2 Dec 2009 16:28:45 -0500 (EST)
6 lines
From: Image File Size Variance In 'IN' basket. Page 1 *New*
SITE: IMGxxxx.MED.VA.GOV
DATE: DEC 02, 2009@16:28:45 EST
DOMAIN: IMGxxxx.MED.VA.GOV
Filename: False Positive CopySBY00012248164.TIF
VistA Cache Size: 14650

Jukebox Size: 919190
4.6.2.8  INSTALLATION
This message is sent when the KIDS for this patch is installed.

Example:

Subj: KIDS-MAG*3.0*39 INSTALLATION [#853149] 10 Dec 2009 08:34:54 -0500 (EST)
3 lines

From: INSTALLATION In 'IN' basket. Page 1 *New*

PACKAGE INSTALL

SITE: IMGxxxx.MED.VA.GOV

PACKAGE: IMAGING

VERSION: 3.0

Start time: Dec 10, 2009@08:34:51

Completion time: Dec 10, 2009@08:34:54

Run time: 0:00:03

DATE: 3091210

Installed by: INSTALLER

Install Name: MAG*3.0*39

Distribution Date: 3091005

VistA Imaging V3.0 - Patch 39 - Test 22 10/05/2009 11:16AM ;Created on Oct 05,
2009@11:16:02

4.6.2.9 Monthly_Image Site Usage

This message is sent when the monthly site usage report is finished gathering information. At
completion, the task is re-queued for the next month.
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Example:
Subj: Monthly Image Site Usage: SALT LAKE CITY"660 (Sep 2009) [#31135]
10/01/09Q@Q04:01 143 lines
From: IMAGPROVIDERONETWOONEFOUR, ONETWOONEFOUR In 'IN' basket. Page 1
SITE: SALT LAKE CITY"660
Reporting Period: Sep 01, 2009 - Sep 30, 2009
DATE: OCT 01, 2009@04:01:03 EST
DOMAIN: IMGxxxx.MED.VA.GOV
2005 ENTRIES: 17798
2006.81 ENTRIES: 5
WS DIS VERS: 3.0.59.31"Win XP.5.1.2600"1
WS DIS VERS: 3.0.72.30"Win Server.5.2.3790"1
WS CAP VERS: 3.0.72.30"Win XP.5.1.2600"1
WS VR VERS: 3.0.41.17"Win XP.5.1.2600"2

4.6.2.10 Photo_ID_Action

This message is sent by the Queue Processor when processing a GCC queue that was triggered
from a Photo ID image.
Example of the message when the PHOTO-ID COPY entry is not properly defined:
Subj: Photo I D Action [#31190] 10/27/09@08:57 7 lines
From: VistA Imaging PHOTO ID ACTION In 'IN' basket. Page 1 *New*
SITE: IMGxxxx.MED.VA.GOV
DATE: Oct 27, 2009@08:57:21 EST
Production Account: O

The Photo ID protocol in the IMAGE ACTION file (#2005.86) could not resolve the
target export location as currently defined.

Update the EXPORT LOCATION field for the PHOTO-ID COPY entry in IMAGE ACTION
file.

4.6.2.11 Scheduled_Purge Failure
This message is sent when the Scheduled Purge does not start at the designated time.

Example:
Subj: Scheduled Purge failure [#31195] 10/27/09@12:40 4 lines
From: VistA Imaging MAGQCBP In 'IN' basket. Page 1 *New*
SITE: IMGxxxxx.MED.VA.GOV
DATE: Oct 27, 2009@12:40:01 EST
The SALT LAKE CITY implementation of VistA Imaging has failed to start the sche

dule Purge activity!
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The task is currently assigned to BP Server: ISW-xxxxx-LT

4.6.2.12 Scheduled_RAID_Group_Advance_Failure

This message is sent when the system cannot change to another RAID Group because none of
the groups has enough free space.

Example:
Subj: Scheduled RAID Group Advance failure! [#31783] 04/02/10@03:20 3 lines
From: VistA Imaging MAGQ FS CHNGE In 'IN' basket. Page 1
SITE: IMGDEMO1.MED.VA.GOV
DATE: Apr 02, 2010@03:20:06 EST

The scheduled RAID Group Advance failed!
4.6.2.13  Scheduled_Verifier_Failure
This message is sent when the Scheduled Verifier does not start at the designated time.

Example:
SITE: SALT LAKE.MED.VA.GOV

DATE: Feb 11, 2010@00:30:04 PST The SALT LAKE HCS implementation of VistA
Imaging has failed to start the schedule Verifier activity!

The task is currently assigned to BP Server: VHASLCBP1
4.6.2.14 Site_Report_Task Was_Restarted

This message is sent by the Monitor Background Processor Activity [MAGQ BPMONITOR]
menu option if the monthly Imaging Site Usage report has to be re-tasked.

Example:
Subj: Site report task was restarted [#31231] 10/27/09€07:13 4 lines
From: VistA Imaging MAGQCBP In 'IN' basket. Page 1 *New*
SITE: IMGxxxx.MED.VA.GOV
DATE: Oct 27, 2009@07:13:01 EST
The inactive monthly Imaging Site Usage report task was restarted

The problem was: Inactive

4.6.2.15 VI_BP_Eval _Queue

This message is sent when number of entries on the EVAL queue exceeds a user defined
threshold.

Example:
SITE: SALT LAKE.MED.VA.GOV

DATE: Mar 30, 2010@13:25 EDT The total number of EVAL queues is 9451. Please
review the DICOM Gateways to ensure Routing is appropriately setup with the correct
destination.

If your site is not using DICOM Gateway for Routing then review the Imaging DICOM
Gateway Installation Guide, Section 4.3.
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On-Demand Routing will not generate EVAL queues, if your site is doing only On-
Demand Routing then the DICOM Gateway parameters are set incorrectly.

Check the following DICOM parameters on all your Gateways:

(On-Demand routing does not require these parameters to be set.)

Will this computer be a Routing Processor? // NO Will this computer be part of a
system where 'autorouting' is active? // NO

4.6.2.16 VI_BP_Queue_Processor_Failure

This message is sent by the Monitor Background Process when a user defined threshold for an
activity is exceeded.
Example:
Subj: VI _BP Queue Processor failure [#31186] 10/27/09@06:45 6 lines
From: VistA Imaging MAGQCBP In 'IN' basket. Page 1 *New*
SITE: IMGDEMO1.MED.VA.GOV
DATE: Oct 27, 2009@06:45 EST

VistA Imaging BP Server, ISW-xxxxx-LT has failed to process a JUKEBOX queue for
25 minutes.

The last date/time a queue was processed was on: Oct 26, 2009@11:38:27
Total JUKEBOX queues are: 100.

This BP Queue processor was supporting the VI implementation serving: SALT LAKE
CITY

4.6.2.17 “Rescinded” Watermarking Successful

The following is an example of the email message generated when an image associated with a
Rescinded Advance Directive is successfully watermarked with the text “Rescinded”.

Subj: Import API Report [#31292] 06/22/11Q@08:14 8 lines

From: PROVIDER, ONE In 'IN' basket. Page 1

0) 171 Image(s) Copied OK. 0 Errors.

1) MAGRSND;3110622.081451.3

2) 31

3) RESCINDED IMAGE FILE"\\SERVERI\IMAGE1S$\SLAO\00\00\02\05\SLA00000020542.TIF
The preceding array was generated by
the VistA Imaging Import API while

processing a 'RESCIND' Image action.

Enter message action (in IN basket): Ignore//
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4.6.2.18 “Rescinded” Watermarking Failed
The following is an example of the email message generated when an image associated with a
Rescinded Advance Directive cannot be watermarked with the text “Rescinded”.

Subj: Import API Report [#31341] 06/23/11@09:52 9 lines

From: PROVIDER, ONE In 'IN' basket. Page 1

0) 0"Image is already Rescinded.

1) Image(l) O0"<error message for Rescind Failure>.

2) Image(l) RESCIND Action is Canceled.

3) Image(l) IEN: 20924

4) TIU Note: 697

The preceding array was generated by
the VistA Imaging Import API while

processing a 'RESCIND' Image action.

Enter message action (in IN basket): Ignore//

4.6.3 Screen-Generated OQutput
4.6.3.1 Server Size

This window shows the amount of total space, free space and % Server Reserve space for Tier 1
and Tier 2 as well as RAID Groups.

Select View > Server Size from the menu bar to view this window.

Note: This option can be accessed at any time the Queue Processor is running.
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T-' GO Yista Storage: - 2:09:03 PM - Current Write Location: MAG1H

Edit

Befresh Current Write Group | Refresh All (Tier 1 Shares) | Exit

Tier1 Shares TIE | RAID Gmupsl

WistA Imaging Tier 2 - Gigabytes Free

! LI reeSpace 46,616 |
FreeSpace 37 361 ] [ .

— - T
Feserve 1 T
] !

IMAGEIBT WORMOTG

B IMAGEJDT 42,946
= WORMOTS 203,317

The VistA Storage area on the Queue Processor GUI can be refreshed with the most current
storage utilization statistics for RAID Groups and Tier 1 shares by clicking the buttons Refresh

Current Write Group or Refresh All (Tier 1 Shares).
4.63.2 JBTOHD Report

When selecting View > JBTOHD Report from the menu bar, the following graphic is displayed.
This window displays a summary of all the entries in the JBTOHD queue and the file types that
will be retrieved for all the entries. This report can be saved to the disk with the File menu. The

fields in this window are described below.

Select View > JBTOHD Report from the main menu bar to view this window.

B TOHD Repo 9:29:49 A = : = Do 0 ardd Jue

File Help

] P

Image Quever: BACKGROUND USER |
IMAGING COORDIMATOR-MEDICINE
Number of Queues: 34
MNumber of ABSTRACT : 13
MNumber of BIG : 7
Mumber of FULL : 14
Patient: PATIENT EIGHTSIXZERO - 1040
Patient: PATIENT NINETWOEIGHT - &
Patient: PATIENT,ONEZEROZERDSEVEN - 1103
Patient: PATIENT ONEZEROONEONE - 1036

Curent JETOHD queue: 7 3100311000858 s

Name Description
Current JBTOHD queue Number of entries in the JBTOHD queue and the request
date/time.
Image Queuer User who requested the images and title
Number of Queues Total number of files that will be copied
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Name Description
Number of ABSTRACT | Number of abstract files that will be copied

Number of BIG Number of BIG files that will be copied
Number of FULL Number of Full files that will be copied
Patient: List of patients for the requested images and their patient ID

4.63.3 IMPORT Queue Status Report

The IMPORT Queue Status window displays queue, parameter, and log information for
IMPORT queue entries (processed or unprocessed). When the entry has not been processed, the
window will display the data in the queue entry in VistA and also the parameters that will be
used in extracting the data from the remote location. More information will be displayed after the
IMPORT queue entry has processed. The window will show the progressive steps of the queue
entry processing. It will also show any errors that occur. The field descriptions are described

below.
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Select View > Import Queue from the main menu bar to view this window.
(Windows Session Tab displayed)

?‘4 Import Queue Status

Import Tracking 1D Lookup Import Queue Lookup

|CP:3-3030123 16381 |

{Windows Session (#2006 82) ‘ Acquisition Session file (#2006.041) ] Import Queus File (#2006.034) ]
Windows Session-

Action { Errors

ACTION: IMPORT™

ACTION: Data: ACQD:

ACTION: Data: ACOL: 63

ACTION: Data: ACOS: 6BO

ACTION: Data: GDESC: DENTAL IMAGE Result
ACTION: Data: IDFN: 714

ACTION: Data: FXDT: 303012316381

ACTION: Data: PXIEN: 393

ACTION: Data: PXPRG: 8925

ACTION: Data: STSCE: ISTAT "MDARI
ACTION: Data: TREID: CF:3-3030123.16381
ACTION: Data: TRTYPE: NEW

ACTION: Image: 1: chprogram filas\vista\imagingiimagepatient! \photoid jog "DENTAL IMAGE image 1 outof 1
ERROR: — New Error—

ERROR: 0" Regquirad parameter is null

ERROR: Acquisition Device is Required. |

< >
< >
(Acquisition Session File tab displayed)
7 Import Queue Status =1
Import Tracking 1D Lookup Import Bueue Lookup
’71551;0927741 iasnz ‘
Found in Image file: 2005 Internal entry #:21762 Image file name: GO 000000021 FE2.TIF
Windows Session [#2006.82) Acquisition Session file (#2008.041) | Import Dueue Fil [H2005.034] |
Acquisition Session -
IEN | GUEUE | TRACKING ID [ ACTRITY. |_TIME | GUEUE $TATUS |
02 TEST.0927-4  QUELING APR 22, 2010@1413:49
‘2 7 TEST.0927-4  BP QUEUE STATUS APR 22, 2010@1414:25  IMPORT in progress
02 B TEST.N927-4  BP GQUEUE STATUIS  APR 22, 2010@14-1425  Tracking ID TEST- IMPORT complete VHAISWIMEYMSIMAGE GOGDTIF
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Name Description
Import Tracking ID Lookup | Unique identifier for each IMPORT entry
Import Queue Lookup IEN for IMPORT queue entry in the IMAGE
BACKGROUND QUEUE file (#2006.03).
This number is displayed in the Queue Processor GUI in the
Process: Queue IEN column (e.g., IMPORT:1234).
ACQUISITION SESSION | Logs all pertinent data when a queue entry is process.sed
file (#2006.041)
IEN IEN for IMPORT queue entry in the IMAGE
BACKGROUND QUEUE file (#2006.03).
QUEUE field Sequence # of events for processing the queue entry.
(#.01)
TRACKING ID Unique identifier for the IMPORT entry.
field (#.02)
ACTIVITY field Category of the session output.
(#1)
TIME field (#2) Time stamp for processing step.
QUEUE STATUS | Status logged for each processing step.
field (*#3)
IMAGING WINDOW Displays error information when an attempt to queue an
SESSIONS file IMPORT failed.
(#2006.82)
IMPORT QUEUE file Displays parameter information that was initiated by the
(#2006.034) remote source.

Note: If there are conflicts caused by the volume of imports being processed, it may be necessary
for the IMPORT queue to hold (pause) and try processing the IMPORT queue again. The
IMPORT queue logs this event in the XTMP global and is held there for 30 days.

AXTMP("MAGQBIM 3100702",0)=3100801"3100702*Recording IMPORT Trackid failure
3100702.084918)=Queue ptr: 21207424"De-queue Holding FIVE sec for Station #: “508
3100702.094228)=Queue pir: 21208716"De-gueue Holding FIVE sec for Station # 508
3100702.101945)=Queue ptr: 21210517*De-gqueue Holding FIVE sec for Station # 508
3100702.113004)=Queue ptr: 21213583"De-queue Holding FIVE sec for Station # 508
3100702.124822)=Queue pir: 21217991*De-gueue Holding FIVE sec for Station # 508
3100702.133505)=Queue ptr: 21220844"De-queue Holding FIVE sec for Station # 508

4.6.3.4  Purge ReQueue by Type Entries

Occasionally, some queues build to a large number of entries because the queues are not
assigned to a BP Server or a setting was made unintentionally. For some queue types, the entries
are no longer needed or were erroneously placed on a queue and can be entirely deleted.

When the queue counts are high for any of the queues, the GUI may take an extended period of
time to display the entries. The Queue Management by Type window, which displays the same
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information on the queue counts, opens immediately no matter how many entries are in each

queue.

In addition to deleting queue entries for a particular queue, you can re-queue all the entries in a
particular queue. If specific entries need to be re-queued, use the Queue Manager window.

Select Active or Failed queue entries, as follows:

e Failed Queues = all of the queue types are selectable and their entries can be purged/re-

queued.

e Active Queues = only the Purge option is available and only for the JBTOHD, GCC,

PREFET and EVAL queues. The Requeue option is not available.

Select View > Purge / ReQueue by type from the main menu bar to view this window.

?-" {site} - Queue Management by Type

Failed Queues |Ac‘rive Queuesl

I~} Abstract

I© Delete

I GCC

= rpont

= JETOHD

[~ Jukebox

I~ Prefet

= Eval

Select an Action

0

0

IS[=] E3

Purge | Requeue |
X Cancsl W Anply | ? Help |
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4.6.3.5 508 Compliance

The purpose of this option is to implement section 508 of the Rehabilitation Act of 1973, as
amended (29 U.S.C. 794d). Section 508 requires that when Federal agencies develop, procure,
maintain, or use electronic and information technology, Federal employees with disabilities have
access to and use of information and data that is comparable to the access and use by Federal
employees who are not individuals with disabilities, unless an undue burden would be imposed
on the agency. Section 508 also requires that individuals with disabilities who are members of
the public seeking information or services from a Federal agency have access to and use of
information and data that is comparable to that provided to the public who are not individuals
with disabilities, unless an undue burden would be imposed on the agency.

Select View > 508 Mode from the menu bar to view this option.
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Chapter 5 Verifier

e Application Description

e Setting up

e Tasking

e Understanding Processing

e Starting/Running the application
e Reports

5.1 Application Description

The Verifier validates the VistA Imaging network file references and consolidates Tier 2 image
files. It is used to identify, and in some cases, correct inconsistencies within the VistA database,
as well as identify incorrect image file locations in VistA. Specifically, the Verifier:

e Performs multiple patient integrity checks
e Sets or clears invalid file location pointers in the database
e Checks for mismatches between image file contents and the database
e Checks for mismatches between specific fields in the text files and the database
e Re-creates missing file types, when possible
e Copies files to Tier 2 and de-queues JUKEBOX queues when doing so, if such a queue
exists.
5.2 Setting Up the Verifier

The Verifier software needs to be installed on a Server class machine. The Verifier requires a BP
Server defined for the server on which it will run (section 2.5.2, Adding a BP Server to the VistA
Imaging System). In addition, the Broker port connection needs to be configured. See Appendix A
for configuration information.

Check the network connections to the Tier 1 shares and archive device shares to make sure they
are online and the Windows account that will be used for logging into the workstation has
READ/WRITE permission to those shares.

5.3 Tasking
If the Verifier is to be run on a daily/weekly/monthly schedule, the SCHEDULEDVERIFY task
will need to be assigned to the BP Server.

5.4 Understanding Processing

The process is:
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Select a range of IENSs to be processed.

The Verifier steps through each IEN in VistA and validates the image pointer locations
(Full, abstract and BIG types) for both the Tier 1 shares and Tier 2 devices (jukebox).
The validation is done by physically checking the share for the existence of each file
type. There are two different types of checks:

e When a Tier 1 file is not found, the Verifier clears the appropriate pointer in VistA
for that file type.

e If'the Tier 1 file is found at the pointer location, then no change is made to the
database.

The Verifier also searches all the online Tier 2 shares for the file.

If the file is not found on the Images Tier 2 pointer location, but is found on an alternate
the Tier 2 location the pointer in VistA is updated to that alternate location.

If the archive file is found at the pointer location, then no change is made to the database.

The Verifier creates missing files when it finds other files that can be used to create these
missing files.

The following table shows the specific file extensions needed to create a particular file
type. Those extensions not listed must be resent/recaptured from the source.

Create from master

756
BIG
BM
BW
DCM
JPG
PAC
TGA
TIF

Missing file

Abstract

BIG
¢ DCM

TGA

For sites that use multiple online Tier 2 shares the process is:

1.

September 2018

When a file in the set of images is missing and a master file (see table above) is available
on the network, the verifier creates the derivative file(s) and will then copy the complete
set to the current Tier 2 Write location. The pointers are updated in VistA to reflect this
location change.

Patient data integrity checks are automatically performed on the IENSs as the pointers are
being examined and validated. There are 14 integrity checks. Any inconsistencies found
are reported.

Background Processor User Manual, Rev 17 97
VistA Imaging MAG*3.0*214



54.1 Reasons for Running the Verifier

The following scenarios have happened at the sites and are stated here as justification for running
the Verifier on a regular basis.

1.

Each day, images are saved on the VistA Imaging Tier 1 and Tier 2. There are occasions
when an undetected problem occurs and a file in an image set is not copied to the Tier 1/ Tier
2 device. The Verifier will report these missing files. If done in a timely manner, missing
files can be recaptured/resent from the source before they are removed from those sources.

In cases where image storage application did not complete the file creation, the Verifier will
clean up the database pointers. For example, when capture events time out prior to the file
being copied to Tier 1, they are automatically deleted by the capture application; this results
in an NO ARCHIEVE event. The image entry will be in the IMAGE ARCHIVE (#2005.1)
file with no reason for deletion.

References are set in patient reports for the images in order to support archiving and viewing.
Occasionally, images on a report belong to another patient. The Verifier will detect these
inconsistencies and report them.

Files are removed from Tier 1 to free up storage space and files are recalled from Tier 2
when they need to be viewed. Pointers are reset/set for each of these studies (100°s of
images). The Verifier will detect and possibly repair any inconsistencies.

Resolve inconsistencies in the database that can result because of discrepancies between files
that interact, manual corrections, network anomalies, power outages, hardware failures, and
incomplete database updates.

The BP Verifier can be used to accelerate the process of migrating files to Tier 2 either with a
setting of the manual range of IENs or by through the use of the Scheduled Verifier. As the
verifier copies files to Tier 2 it will check the Queue file for that entry and de-queue
JUKEBOX queue if there is one.

5.5 Maintenance Operations

Verifier scans can be run any time of the day as there is minimal impact on VistA. They should
be run based on the following events:

98

e Routine scanning of newly acquired images

The Verifier should be run every 1 or 2 weeks to verify new entries in the IMAGE file
(#2005). In some cases, if images are missing they can be resent from the modality.

e Periodic maintenance of the VistA Imaging system

The Verifier should be run once a year to verify the entire range of Image Internal Entry
Number (IENs) in the IMAGE file (#2005). During the year, many files will be retrieved
from the jukebox and pointers updated in the database. Allowing the Scheduled Verifier to
run on a regular basis will insure that files on Tier 1 and Tier 2can be accurately located.
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e Large Image Share population events

There may be occasions where files were not copied and incorrect file pointers set in the
database with this large volume of files being moved to Tier 1. Running the Verifier over
the range of Image IENs that were copied back to the Image shares from Tier 2will insure
correct pointers.

e Image share or Tier 2 outages

The Verifier should be run after the resolution of any event that interrupted the flow of
images to Tier 2. The Queue Processor will make three attempts to process JUKEBOX
queues, each queue failure re-queue will go to the end of the queue. Note that these files
ONLY reside on the Image shares and therefore MUST be either re-queued using the
Queue Manager or copied to Tier 2 using the Verifier.

To handle cases where the share is taken off line by a scheduled or unscheduled process:
The BP Verifier will not clear pointers if it cannot detect the folder that the image is
supposed to be in.

5.5.1 Integrity Checks

The Verifier steps through each of the IENs within the range looking for specific types of
problems. The following sections describe the integrity checks performed on these files.

5.5.1.1 File Integrity

Referential integrity of the Database Network pointers and the Imaging Storage system

File location references in the IMAGE file (#2005) and the IMAGE AUDIT file
(#2005.1) are physically checked to determine the existence of the file(s) on their assigned
Imaging Tier 1 and Tier 2 shares. The Verifier checks for the existence of the folder on the Tier 1
shares. If the folder does not exist, then it is presumed either the file server or cluster is off-line
and these Tier 1 file references are left as found and the “Tier 1 File Type location is offline”
event is logged, otherwise, If any file (excluding TXT) is missing from the Image shares, the
pointer will be cleared in the IMAGE file (#2005) record or the IMAGE AUDIT file (#2005.1)
record. If all files are missing on any on-line Tier 2, the Tier 2 pointer will be cleared. The
Verifier will set the Tier 2 pointer if any of the files in the set are found on the current or
alternate Tier 2. The Verifier will also look at the IMAGE AUDIT file (#2005.1) to ensure the
file set exists at the location(s) specified in this file.

5.5.1.2  File Corruption

When IMAGE FILE (#2005) or IMAGE AUDIT (#2005.1) is corrupt or otherwise is
lacking required fields to identify the Image, the Capture events, and/or the patient, the BP
Verifier removes or kills the nodes and logs what was found in an html log file.

These records are expected to result from network latency or image capture failures of other
causes. The entire state of the global node will be logged in a VKILLJournal Date Seq No.html
file and the entire node will be removed from the database.
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Date

| IT University Online l Node\Data_Value

5/9/2013 11:52:14 AM

~MAG{2005.2,0)=

1 http://ituniversityon 'ne.net_fl

5/9/2013 11:52:14 AM

AMAG({2005,2,100)="*680

5192013 11:52:14 AM

AMAG(2005,5,2)=2980316.1609+126""Test Capture*2980316.1608nAAAAN C

5/9/2013 11:52:14 AM

“MAG{2005,5,40)=NONE"1~75~2

5/9/2013 11:52:14 AM

“MAG{2005,5,100)="r580nrnn 1

5/9/2013 11:52:14 AM

“MAG

2005.1,5,2)=2980316.1609"126""Test Capture*2980316. 1608 annnn C

5/9/2013 11:52:14 AM

MAG

2005.1,5,40)=NONE*1~75"+2

5/9/2013 11:52:14 AM

~MAG{2005.1,5,100)="~5805nn1

5192013 11:52:14 AM

AMAG(2005,130, 1)=rnnnnnn

5192013 11:52:14 AM

AMAG({2005,130 2)=2980520.164126++061390-8 ANGIO CAROTID CEREBRAL UNILAT S&I429

5/9/2013 11:52:14 AM

~MAG{2005,130,40)=RAD*1~75*107~29

5/9/2013 11:52:14 AM

(
(.
(.
(.
(
(
(
(.
(.
{
(
{

~MAG{2005,130,100)="7660nnn 1

5.5.13

Patient Integrity Vs. File Integrity

Patient-related values in the IMAGE file (#2005) are checked for consistency within the group
Image entries and the associated report files.

The following table lists the integrity issues that will prevent images from being displayed. The
following integrity error messages will be generated when the image is retrieved for viewing.

Message Generated

Explanation

No Image Ptr in AP

The Clinical Association Report (AP) for this image does
not contain an image entry that points back to this image.

GP has no images

The image series does not contain any images. Group
Parents (GP) are containers for an Image series. A group
parent with NO group objects (GO) is an invalid condition.

Conflicting AP & Image DFNs

The patient file reference (DFN) in the Clinical Association
Report (AP) does not match the DFN in the IMAGE file
(#2005).

Invalid Image Ptr to AP The Clinical Association Report (AP has image references
that are not in the IMAGE file (#2005).

Conflicting GP and GO DFN The patient file reference (DFN) in the Group Parent (GP) is
not the same as the DFN in the Image entry.

GP & GO AP Mismatch The Group Parent and Group Object pointer references to a
Clinical Association Report (AP) do not match.

GP Missing GO Ptr The Group Object multiple of the referenced Group Parent
does not reference this group object.

No AP Mult Ptr This Image entry does not have the clinical application (AP)
image multiple entry number specified. The IMAGE file
(#2005) record is missing the PARENT DATA FILE IMAGE
POINTER for a Clinical Association Report (AP).
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Message Generated Explanation

GO DFN mismatches Some image file Group Objects have different PATIENT
file (#2) references (DFN).

Image entry is structurally The normal structure that distinguishes Image entry Group

abnormal Parents (GP), Group Objects (GO), and Non-Group image
(NG) is corrupt.

Missing Group Objects The Group Parent has Group Object references that are
missing.

DFN Mismatches in AP Image | The Clinical Association Report (AP) references a Group
Mult Parent that has image files with a PATIENT file (#2)
reference (DFN) that is different from the report.

Note: The following integrity issues will not prevent their respective images from being
displayed. These are informational messages.

Message Generated Explanation

No AP Ptr The IMAGE file (#2005) record is missing the PARENT
DATA FILE file (#2005.03) for a Clinical Association
Report (AP). This Image does not have the entry in the
clinical application (AP) specified.

No AP entry Ptr This Image does not have the entry in the clinical
application (AP) specified. The IMAGE file (#2005) record
1s missing the PARENT GLOBAL ROOT IEN for a Clinical
Association Report (AP).

5.5.14 Text File Integrity

When the Check option is selected in the Check Image Text window, the Verifier compares
specific fields in the text file with those in the associated IMAGE file (#2005) record in VistA.
The following is a list of problems that the Verifier detects. Included in the list is a suggested
way of correcting these problems.

e Text file is binary or unreadable.

Correction- Copy the version from the jukebox or get a copy from the backup tapes
e Text file is ASCII but has unprintable characters or truncated.

Correction- Copy the version from the jukebox or get a copy from the backup tapes
e Patients ID (SSN) field in the text file does not match that in VistA.

Correction- Contact the National Help Desk.

The following fields are in the DICOM DATA block (lower section of the text file). These fields
are generated by the modality and should not be altered.
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SOP Instance UID field (DICOM-0008,0018) in the text file does not match the one in
VistA. (“PACS” node — PACS UID field (#60) in the IMAGE file (#2005) )

Correction- Most likely the text file has the correct UID. Make the correction in VistA (PACS UID
field #60 in the IMAGE file (#2005) to match the DICOM field (0008,0018).

Study Instance UID field (DICOM- 0020,000D) in the text file does not match the one in
VistA. (“PACS” node — PACS UID field (#60) on the PARENT IEN.)

Correction- Most likely the text file has the correct UID. Make the correction in VistA (PACS UID
field (#60) in the IMAGE file (#2005) ) to match the DICOM field (0020,000D).

SOP (DICOM- 0008,0018) and/or Study Instance UID (DICOM- 0020,000D) are/is blank in
the text file.

Correction- If these fields are blank and the image is stored in VistA in TGA format, then this
crucial information is lost and it will be impossible to reconstitute the DICOM image. Call the
National Help Desk.

Patient ID (SSN) in the top section (DATA1) of the text file does not match the DICOM
field (0010,0020) in the bottom section (DICOM DATA).

Correction- This file has already been corrected and needs no further correction if the Patients
ID field (SSN) in the top section (DATA1) matches VistA.

5.6 Starting/Running the Verifier

The Verifier can be started as an independent application or can be scheduled to run in the
background at prescribed time intervals (See Section 3.5). The following steps describe how to
run the Verifier in the foreground:

1.
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From the Windows Start > Programs menu, select VistA Imaging Programs > Background
Processor > Verifier.

Log into the application using a valid VistA access and verify code. (The secondary menu
option All MAG* RPC's [MAG WINDOWS]is required for access to the Verifier).

The BP Verifier window opens.

In the Scope box, select one of the following options:

Range - Type a start and stop IEN. The Verifier will process this range of IENS
(inclusively). If the Start IEN is greater than Stop IEN, the Verifier will scan the image
records backwards.

All — Every IEN record in VistA will be processed

Auto — The Verifier will process IENs from the highest backwards to an IEN that was
previously processed.

In the Check Image Text box, select one of the following options:
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e Check - Compare specific fields in the text files on Tier 1 with data contained in the
associated IMAGE file (#2005) records in VistA. (Processing time will increase

moderately.)

e Don’t Check — Do not do any comparison of the text files with VistA.

Note: This is the preferred option as the procedure to correct inconsistencies is under

development.

5. Click the Start button to begin processing.
Processing activity will be displayed in the GUI window.

-
Tes  BP Verifier - 11:37:25 AM - BP Server: GEKGFE - Site: SALT LAKECITY -

User: Garrett Edward Kirin BS -

,

File Help
3.0.2141 Start | Tier 1 Shares Tier 2 Shares
5 hosk | _ A~ .| NETWORK LOCATIO... | PHYSICAL REFEREMCE | [ .| NETWORKLO... | PHYSICAL R
=l B e T e Time: 7/2/2013 115720 A 8 DRKINGHASHED WEWIMGLABAIMAGET, | [87 LOCALJBOR  WVACOLTKIF
“ Range € Check Run Time (Hrs MinSec): 0.0:4 DRKINGNONHASHED  #ISWHMGLABZIMAGET, | |86 STORSIT.B VAALISAPE
@ Al Y Tutal IEMs: 28 37 GCe2 WSWHMGOADBZVGCC28,| |89 STORJBGFE  WWACOLTKIF
NO Befs O T MAGT WACOLTKIRINGADVAY| |8 WORMOTG Waausvimay
Bad YC Refs: ] 2 MAGTH YvaausvimappBl18.aac.d| |68 WORMOTGKAN WSWHMGGC
| Progress: 30227 Bad JE Rafs 15 40 SPKROUTEHASHED  WSW-KINGSSIROUTE,
Range AlJB Refs 0 85 STORSOT WVAALISAPPYIMADT AAC.
From : To: Boggegs 0 88 STORGFE WYACOLTKIRINGA DVAY
|_30zn0__ [_3nee7__ SizaZeras 0
Size Zero Deleted: 1]
Duplicates: 0 1] T v e T v
Tirme Activity 5 Fila: JBFul JBBig W Ful WC Abstract [WC Big oWl JBPath1  [JBPah2 -
MotCered 30214 GKD0D0D00302 B3-OFFLINE 88.ABS TXT.F83.ABS TXT.F 88.ABS THTF
7/2/2018 11 Images JB sha 30214 GKDODODOD302 83-OFFLINE 88.ABS TXT.F88.ABS TXTF 88ABSTHTF
7/2/201811 Mot Certed | 30213 GKD000000302 B3-OFFLINE 88.ABS TXT.J88.ABS TT. 88.ABS THT.
7j242018 11 Imagas JB sha 30213 GRINDONONNZ &3-OFFLINE 88ABS TXT J88 ABS TT BHABS TXT J
7/2/2018 11 Mol Cerled 30212 GKD0D0D00302 83-OFFLINE 88.ABS THT.188.ABSTXT.1 88ABSTHTT -
4 L3
Scope: Range Check Image Text : Don't Check Range: 30200 - 30227

Name Description
Image Shares
IEN Entry number in the NETWORK LOCATION file
(#2005.2)
Network Location Name of the entry in the NETWORK LOCATION file
(#2005.2)

Physical Reference

Network path of this Network Location entry

Scan Controls

Scope Setting:
e Range = Scan records in specified range
e All = Scan all records
e Auto = Automatically scan newly acquired files after
the last scanned record
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Name

Description

Check Image Text

Setting:
e Check = Compare specific fields in the text files on

Tier 1 with data contained in the associated IMAGE
file (#2005) records in VistA.

e Don’t check = Don’t compare fields above.

Progress

Number of records processed

Range

Setting:
e Start = Beginning IEN in range to scan
e Stop = Ending IEN in range to scan

Summary

Start Time

Date/Time this Verifier scan was started

Run Time

Total elapsed time the Verifier ran

Total IENs

Number of image file entries processed in this scan

No Refs

Number records with no Tier 1 or Tier 2 location
references

Bad VC Refs

The number of IMAGE file (#2005) entries with Image
share references that could not be matched to an actual file
stored on an image share.

Bad JB Refs

The number of IMAGE file (#2005) entries with Tier 2
references that could not be matched to an actual file stored
on a jukebox.

Alt JB Refs

The number of files found on multiple Tier 2 share
locations are listed. (These are copied to the current Tier 2
share using the aggregate function).

Size Zeros

The number of zero length files found on the Image shares
and archive Tier 2 shares.

Size Zero Deleted

Number of files deleted that had a size of zero. Only image
share files will be deleted.

Duplicates

Number of Image entries that are duplicated in the IMAGE
file (#2005) and the IMAGE AUDIT file (#2005.1). These
images are not viewable because the image files
themselves have the same file names and therefore have
ambiguous patient and procedure references.

Jukebox Shares box

IEN

Entry number in the NETWORK LOCATION file
(#2005.2)

Network Location Name

The name of the entry in the NETWORK LOCATION file
(#2005.2)
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Name

Description

Physical Reference

Network path of this Network Location entry

Operational Status

Status:

e On-line = READ/WRITE access to this share
e Off-line = no access to this share

Hash Subdirectory

Setting:

e Yes = Directory hashing is used. Files are maintained
in a 5-level deep subdirectory structure where no
directory will contain more than 100 unique filenames
with their various extensions. (Both 8.3 and 14.3
format files are valid)

e No = Image files are stored in the top level folder in a
flat file structure, which means that files are placed and
retrieved from the root directory of the share. Do not
use this structure.

Share Availability

Setting:
e On-line = Software can access shares on the network.

e Off-line = Software cannot access shares on the
network.

Activities box

Time

Actual time when the IMAGE file (#2005) was processed

Activity

Description of the action taken

IEN

IMAGE record number currently being processed

File

Filename in the current IMAGE file (#2005) record being
processed

JB Full

The DISK & VOLUME, WORM (#2.2) value for the Tier
2 share in the IMAGE file (#2005) and\or IMAGE AUDIT
file (#2005.1) where Full image is located. Other
extensions will be listed here except the BIG file (listed in
the JB BIG column).

JB Big

The BIG JUKEBOX PATH (#103) value for the Tier 2
share in the IMAGE file (#2005) and\or IMAGE AUDIT
file (#2005.1) where BIG image is located. The extensions
of all files on Tier 2will be listed

VC Full

The DISK & VOLUME, MAGNETIC (#2) value for the
share in the IMAGE file (#2005) and\or IMAGE AUDIT
file (#2005.1) where FULL image is located

VC Abstract

The DISK & VOLUME, ABSTRACT (#2.1) value for the
share in the IMAGE file (#2005) and\or IMAGE AUDIT
file (#2005.1) share where abstract image is located

September 2018

Background Processor User Manual, Rev 17

VistA Imaging MAG*3.0*214

105



Name

Description

VC Big

The BIG MAGNETIC PATH (#102) value for the share in
the IMAGE file (#2005) and\or IMAGE AUDIT file
(#2005.1) where BIG image is located

CWL

Image share that is the current write location. This will
change automatically if the AUTO WRITE LOCATION
UPDATE option is selected. The check for space is done
after 100 Writes to the share or after 20 minutes since the
last check, whichever comes first.

JB Path 1

The IEN for the entry in NETWORK LOCATION
(#2005.2) file of first alternate Tier 2

JB Path 2

The IEN for the entry in NETWORK LOCATION
(#2005.2) file of second alternate Tier 2

(status bar at bottom)

Parameters for this run are listed.

Note: When the IEN range includes files that have been saved in a flat file structure, there
will be a noticeable increase in the time it takes to complete the scan.

The Verifier stops when it has processed all the IENs in the range specified.

6. Click Stop to terminate processing at any time.

When the Verifier run is complete, enter a new set of Start/Stop IENs in the SCOPE and start

A new Help menu item is provided for debugging purposes.

BP Verifier Help
Integrity Help
About BP Verifier

anew run.
Creating a Debug Log:
Yur  BP Verifier - Q_ST

File Help

3.01981
SCope
* Range
= ALL

v Debugging Log

The user will need to check the menu Help | Debugging Log, to have a Debug Log created with
detailed trace of the Verifier process. Since the debugging logs can get very large, it will only be
selectable when the user selects a range of images to verify. The Log file is named
‘VerifierDebuglog-mmdd-hhmmss.log’. Once the debugging is on, it will remain on until the
user turns it off or changes the Scope to ALL. Also, if debugging is on, and the user selects a
new Range, the current debugging will still be turned on. Debugging is Off by default any time

the Verifier starts.
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Note: This setting is intended to be used when debugging issues in conjunction with CLIN 3

support personnel.

5.7 Reports

Two types of reports are produced:

e Logfiles
¢ Emails

5.7.1 Log Files

New log files are created as HTML files each day and each time the Verifier is run. HTML files
are viewable, printable, and searchable. By default, they reside in the C:\Program
Files\VistA\Imaging\BackProc\log\Verifier directory. These files can be accessed by:

e File > Open Log on the BP Verifier menu bar

e Internet browser

These log files can be imported into an Excel spreadsheet.

Important: These files should be kept for historical reasons and added to the tape backup
storage process to safeguard the files. (See Appendix B: Backups in the VistA Imaging System

Installation Guide.)

Log File Format

Verifier log files are archived as HTML files and have the year-month-day and sequence number
imbedded in the file name, as shown in the right pane of the window.

% C:'.Program Files' YistA'Imaging'BackProc'log' verifier

File Edit W¥ew Favorites Tools Help | o
O Back = ) - bl | - Search | [ Folders ‘ & X 0 | [~
Address I.j C:iProgram Files\VistalImaginglBackProcilogiverifier j a Go
Falders X || Name = Size | Type | Date Modified I Attributes
O 0 vith = | &) Certedz009_0s_15.hem S1KE HTML Document 8/15{2009 3:47 PM a
2 Broker @] Certed2009_08_18_01.html 90KB HTML Document 5/16/2009 3:50 PM a
5 &) imaging [£] certed.Log OKE Text Document B/18/2009 3:50 PM a
B ) BackProc &]DFNErorz009_08_L8.hitml 6KE HTML Dacument B/18/2009 3:47 PM A
) Help & ] DFNErTorz009_08_18_01.html 17KB  HTML Document B/18/2009 3:50 PM A
25 log [Z] DFNError.Log OKE Text Document 8/18/2009 3:50 PM a
) BackProc &]Mokrchive2009_08_18.html 67KE  HTML Document F15/2009 34T PM A
=) purge &]Mokrchive2009_08_18_01.html 74K HTML Document F15/2009 ZEOPM A
) S [Z] Matrechive.Log OKE Text Dacument F15/2009 ZEOPM A
&]5canz009_03_18.html 1KE  HTML Dacument F15/2009 342 PM A
@j Scanz009_05_15_01.html 1,170KE  HTML Document 8/18/2009 3:47 PM &
&]5can2009_08_18_02.html 14KB HTML Document 8/18{2009 3:47 PM f
&]5can2009_08_18_03.html 782 KB  HTML Dacument 8/15{2009 3:50 PM f
[) scan.log 4KB Text Document 8/18{2009 3:50 PM f
@j ScanError2009_08_18.heml 1 KB HTML Document 5/18/2009 3:42 PM A
@j ScanError2009_08_15_01.hkml 481 KB HTML Document §/18/2009 3:47 PM A
@j ScanError2009_08_15_02.hkml 281 KB HTML Document &/18/2009 3:50 PM A
[£] Scan€rror.Log 0KE Text Document B/18/2009 3:50 PM A

If more than one log file is run on the same day, the system adds a sequence number such as
“01” following the date in the file name. For multiple runs on the same day, the highest sequence
number is the latest log file run for the day, as shown for the “Scan2009 08 18 03.html” file.

BP Verifier produces the following types of log files.

September 2018

VistA Imaging MAG*3.0*214

Background Processor User Manual, Rev 17

107



5.7.1.1 Scan Log File

The Scan log file lists entries with potential file integrity problems. The log records the

operational events that take place to correct a particular problem. They are used to determine if
and how the Verifier corrected the faulty condition. The IENS that the Verifier could not fix are
listed in the ScanError log file. For the complete list of messages, see Output HTML Messages.

Note: No action is required on entries found in the Scan.Log file.

Address [ c:\pragram rocijog

an2009_08_18_01. Rl

42:35

|||||||||||

i lagfile is sreated: CoPragral
£0/istalImagingtBackProcilaghverifisnSean.Log

&418/2000
F:92:35

201872000 [App!
3:42:35
Fid

CiProgram
ackPraciMagyerifier. ex

ar1872008

SHE2009 s 1D: DOT - VHAISWAVHITEVMZ JOB 1D:

PID: DEZ KIDS: 2.0F30

||||||||||||||||

11572000
:42:35
Pt

InitLogFile

ar1872008

az.
Fid

41872000
9418

Aggregate: 6.756.ABS. TXT

[
e‘
|
for
|
o
|
F

FuLL_ve_pm | aBs_ve_pme | [onrert_wite_PTR [18_ALT 1

Name

Description

Date/Time

Actual time when the IMAGE record was processed.

Message

Description of action taken.

IMAGE PTR

Image record currently being processed including the
version/dates/log file names.

FILE NAME

Filename for the Image record.

FULL JB_PTR

The DISK & VOLUME, WORM (#2.2) value for the Tier 2share in
the IMAGE file (#2005) and\or IMAGE AUDIT file (#2005.1)
where FULL image is located. Other extensions will be listed here
except the BIG file (listed in the JB BIG column).

BIG JB PTR

The BIG JUKEBOX PATH (#103) value for the Tier 2 share in the
IMAGE file (#2005) and\or IMAGE AUDIT file (#2005.1) where
BIG image is located. The extensions of all files on the jukebox
will be listed.

FULL VC PTR

The DISK & VOLUME, MAGNETIC (#2) value for the share in

the IMAGE file (#2005) and\or in IMAGE AUDIT file (#2005.1)
where FULL image is located. (Other file extensions on this share
are also listed.)

ABS _VC_PTR

The DISK & VOLUME, ABSTRACT (#2.1) value for the share in
the IMAGE file (#2005) and\or IMAGE AUDIT file (#2005.1)
where abstract image is located. (Other file extensions on this share
are also listed.)
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Name

Description

BIG VC PTR

The BIG MAGNETIC PATH (#102) value for the share in the
IMAGE file (#2005) and\or IMAGE AUDIT file (#2005.1) where
the BIG image is located.

Current Write PTR

Image share that is the current write location. This will change
automatically if the AUTO WRITE LOCATION UPDATE option
is selected. The check for space is done after 100 Writes to the
share or after 20 minutes since the last check, whichever comes
first.

JB_ALT |
2,3,..)

Network Location of Tier 2. If a site has 2 or more Tier 2 shares,
then the second, third, etc. are the “alternate” Tier 2.

5.7.1.2 NoArchive Log File

The NoArchive log file contains image file names that are missing on the jukebox and could not
be created from existing files and/or could not be found on the Tier 1. The Verifier examines
both the IMAGE file (#2005) and the IMAGE AUDIT file (#2005.1) for missing files. The
2005.1 column shown below indicates those missing files that have been deleted and the IMAGE
file (#2005) record has been moved to the IMAGE AUDIT file (#2005.1).

Address I@ C:\Program Files\vistal Imaging\BackProchloglverifier\Moarchivez009_08_18_01.html

| Filename [ 20051
[1E00000Z. ABS | l_
[1E0D0002 TXT | [
[1E0D0004 758 | [
[1E0D0004. 2T | [ ]
[IE000005 756 | [ ]
[1E0D0005. THCT | [ ]
[1E0O000G. 758 | [ ]
[1E0O000E. 7T | [ ]
[1E000007 758 | [ ]
[1E000007 . 7T | [ ]
[1E0000DE 758 | [ ]
[1E00000E. 7T | [
[1E0oD010. TR | [

Name Description

Filename Name of the missing file.

2005.1 If the column contains “2005.1”, then the Image has been deleted and the

image information is in the IMAGE AUDIT file (#2005.1).
If the column is blank, the file is missing from Tier 1 and Tier 2 storage and
must be restored using one of the methods listed above.

Note: When the 2005.1 column is blank, the file is missing and must be recovered from the
backup tapes or other means.
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These files must be restored using one of the following methods:

Restore from backup tape(s).

Resend from the gateway.

Re-capture on the Capture workstation.

File restore from platter on the jukebox.

If the missing file cannot be located, the Patient ID information and provided information for

these missing field(s) should be sent to the hospital staff persons for their records.

5.7.1.3

ScanError Log File

The ScanError log file lists problems with IENs that could not be corrected. When a Verifier
scan is completed, the contents of this file are sent as a mail message to the MAG SERVER mail
group.

Note: Action is required to correct any problems listed in this file.

Guidelines on Handling Errors:

The most important columns are FULL JB_PTR and BIG _JB_PTR, shown below, which
display the files that are on the jukebox (there is not always a BIG file with an image).

Important: The FULL, ABS, BIG, and TXT files should reside on the jukebox.

The Message column describes the errors. (See section 8.3.7 Start/Run for the complete
list of messages in the Troubleshooting chapter.)

All file types in a set may not be on the image shares as some may have been purged.

If the Check Text option was used, see “Check Text Option Messages”. These are
potential problems that need to be corrected.

Address I@ C:\Program Files\YistalImagingBackProcilogiverifierScanError2009_08_18_02.html

[oateMime [ Message  [mMaceE_PTR | FILE_NAME [FuLL_se_PTR [B1G_JB_PTR [FULL_vC_PTR [#BS_vc_PTR [BIG_vE_PTR [Currert_write_PTR [ JB_aLT_1
/132008

3:47:51 ':;;””VC 3 |EODO00Z ABS 2 2
Fh

/132008

3:47:51 g:lf;':lee:” 3 |EODO00Z ABS 2
Fh

/132008

34751 |NotCerted |3 |E00003.ABS 2
Fh

/132008

3:47:51 g:lf;':lee:” a |ENO0004.756 2
Fh

/132008

471 |NotCerted |4 |E000004.756 2
Fh

/132008

3:47:51 g:lf;':lee:” 5 |ENO00OS 756 2
Fh
Name Description
Date/Time Actual time when the IMAGE record was processed.
Message Description of problem.
IMAGE PTR IMAGE record currently being processed.
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Name

Description

FILE NAME

Filename for the current IMAGE file (#2005) record being
processed.

FULL JB_PTR

The DISK & VOLUME, WORM (#2.2) value for the archive
(jukebox) share in the IMAGE file (#2005) and\or IMAGE
AUDIT file (#2005.1) where FULL image is located. Other
extensions will be listed here except the BIG file. (It is listed in
the JB Big column.)

BIG JB PTR

The BIG JUKEBOX PATH (#103) value for the archive
(jukebox) share in the IMAGE file (#2005) and\or IMAGE
AUDIT file (#2005.1) where BIG image is located. The
extensions of all files on the archive (jukebox) will be listed.

FULL VC_PTR

The DISK & VOLUME, MAGNETIC (#2) value for the share
in the IMAGE file (#2005) and\or in IMAGE AUDIT file
(#2005.1) where FULL image is located. (Other file extensions
that are on this share are listed, also.)

ABS VC PTR

The DISK & VOLUME, ABSTRACT (#2.1) value for the share
in the IMAGE file (#2005) and\or IMAGE AUDIT file
(#2005.1) where abstract image is located. (Other file extensions
on this share are also listed.)

BIG_VC PTR

The BIG MAGNETIC PATH (#102) value for the share in the
IMAGE file (#2005) and\or IMAGE AUDIT file (#2005.1)
where the BIG image is located.

Current Write PTR

Image share that is the current write location. This will change
automatically if the AUTO WRITE LOCATION UPDATE
option is selected. The check for space is done after 100 Writes
to the share or after 20 minutes since the last check, whichever
comes first.
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Name

Description

JB_ALT |
2,3,..)

The IEN for the Tier 2share in the NETWORK LOCATION

(#2005.2) file. If a site has 2 or more archive devices

(jukeboxes), then the second, third, etc. are the “alternate”

archive devices (jukeboxes).

5.7.14  DFNError Log File

The DFNE-rror log file displays integrity issues with patient data. The Memo column messages,
shown below, are described in checks on Patient Integrity.

Note: Call the National Help Desk for assistance in fixing any of these issues.

112

Address @ C:\Program Files\VistA\ImaginglBackProcilogyverifier\DFMError 2005_05_18.html j Go

[ image_IEN | Patient_Name_1 [DFN_1[ SSN_1 | Patient_Name 2 [DFN_2| SSN_2 [Package [Package_IEN [image_Class [Error_lewvel | Memo
CONFLICTING

&G0 PATIENT,ONEFIV |154 000000154 |PATIENT FIVESE |575 000000675 [HEM |3 N 1 AP & IMAGE
DFNS
DFN

662 PATIENT.FIVESE [575  |000000575 |FATIENT,ONEFIY 154 000000154 [HEM 3 GP 2 Mismatohes in
AF Image
hult
DFH
MISMATCHES

663 PATIENT FIVESE |575 000000575 |PATIENT.ONEFIV 154 000000154 [HEM |2 G0 2 I AP IMAGE
MULT
DFN
MISMATCHES

fifi PATIENT FIVESE |575 000000575 |PATIENT.ONEFIY 154 000000154 [HEM |3 a0 2 AP IMAGE
MULT
DFN
MISMATCHES

665 PATIENT FIVESE (575 000000575 |PATIENT.ONEFIY 154 000000154 [HEM |2 30 2 AP IMAGE
MULT

666 PATIENT,MINESE |975 (000000975 |PATIENT SIXSEYV 672 (000000672 [ENDO |12 GP 1 ‘;“I::;*;”SF’::
CONFLICTING

667 PATIENT,MINESE |975 (000000875 |PATIENT SIXSEY 678 (000000678 [ENDO |12 a0 2 AP & IMAGE
DFNS
CONFLICTING

668 PATIENT,MINESE |975 (000000875 |PATIENT SIXSEY 678 (000000678 [ENDO |12 a0 2 AP & IMAGE
DFNS
DFN

669 PATIENT.SIXSEV (678 |00000067% |FATIENT NINESE (975 000000975 [ENDO |12 GP 2 Mismatches in
AP Image
MUt

Name Description

Image IEN IMAGE record currently being processed

Patient Name 1 Patient name for current [EN

DFN 1 Patient file IEN for current record

SSN 1 Social Security Number for current patient

Patient Name 2 Patient name in linked Radiology report/TIU Note

DFN 2 IMAGE file (#2005) IEN in linked report

SSN 2 Social Security Number of Patient in linked report

Package PROCEDURE, field (#6) in IMAGE file (#2005)
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Name

Description

Package IEN

3.9: MAIL MESSAGE
63: AUTOPSY (MICROSCOPIC)

63.08: SURGICAL PATHOLOGY
63.09: CYTOLOGY

63.2: AUTOPSY (GROSS)

74: RADIOLOGY

130: SURGERY

691: ECHOCARDIOGRAM

694: HEMATOLOGY

699: ENDOSCOPY

699.5: GENERIC MEDICINE
8925: TIU

PARENT GLOBAL ROOT, field (#17) in IMAGE file
(#2005), (the number in the left column)

63.02: ELECTRON MICROSCOPY

691.1: CARDIAC CATHETERIZATION
691.5: ELECTROCARDIOGRAPHY

Image Class

Hierarchy in a study (parent, child)

Error Level Severity level:
1= highest
2 = high
Memo Integrity issues to resolve

5.7.1.5 BP Verifier Kill Journal

The BP Verifier cleans out corrupted Image file and Image Audit file entries. It also
changes the status of automatically deleted images from Deleted to Image Never
Existed. A byproduct of network latency, we see increase in timeouts by capture
software that results corrupt file records and automatically Deleted Image file entries.
The BP Verifier cleans out the corrupted records and corrects the status of the deleted
records. It also reports these actions in the VKillJournal log files, a sample of which

follows.

5/9/2013 11:52:14 AM
£/9/2013 11:62:14 AM
5/9/2013 11:52:14 AM
5/9/2013 11:52:14 AM
5/8/2013 11:52:14 AM
5/9/2013 11:52:14 AM
5/8/2013 11:52:14 AM
5/3/2013 11:52:14 AM
5/8/2013 11:62:14 AM
5/3/2013 11:52:14 AM
5/8/2013 11:62:14 AM
5/8/2013 11:62:14 AM

Node\Data_Value
MAG(2005.2,0/=5

MAG(2005,2,100)=580
MAG(2005.5,2)=2980316.1609*126" Test Captur 316.1
"MAG(2005,5,40)=NONE"*T52

"MAG(2005,5,100)=*"580mAn ]

"MAG(2005.1,5,2)=2980316.1609"126™Test Capf 316
"MAG(2005.1,5,40)=NONE" 752

"MAG(2005 1,5, 100)=215800am ]

MMAG(2005,130,1)=Araanan

"MAG(2005,130,2)=2980520 16*126"061330-8 ANGIO CAROTID CEREBRAL UNILAT 5&1"29
MMAG(2005,130 40)=RADMATEMOTA29

AMAG(2005.130.100)="166044841
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5.7.1.6 Imaging Integrity Check message

This message is sent when the Verifier completes a scan. The message identifies the time span
involved and a summary of integrity errors.

Example:

Subj: Imaging Integrity Check [#31164] 10/26/09@22:32 6 lines

From: VistA Imaging DFN_Summary In 'IN' basket. Page 1 *New*
SITE: IMGxxxx.MED.VA.GOV
DATE: Oct 26, 2009@22:32:51 EST

51 entries scanned.

Summary:

2 occurrences of : NO IMAGE PTR IN AP~1 type errors.

Database scan took 0:0:5
5.7.1.7 Imaging_Site Verification_Issue

This message is sent when there is a network issue that is preventing the Verifier from accessing
shares.

Example:
Subj: Imaging Site Verification Issue [#853534]
14 Dec 2009 08:50:04 -0600 (CST) 8 lines
From: <USER.BGPQ@CENTRAL-ALABAMA.MED.VA.GOV> In 'VERIFIER' basket. Page 1
*New*
SITE: CENTRAL-ALABAMA.MED.VA.GOV
DATE: DEC 14, 2009@08:50:04 CST
12/14/2009 8:50:04 AM
The Jukebox share: \\VHACAVIMMJBI\IMAGEJB1S$ is not available!
All VistA Imaging Jukebox servers should be fully operational
when operating the BP Verifier!
312717CB031271.TGA"7 .ABS.TXT.BIG.TGANT """ 27AAA

when operating the BP Verifier!

5.7.1.8  Verifier Scan_Error_Log message

This message is sent by the BP Verifier at completion of the scan. The report identifies the image
entries in question.

Example:
Subj: Verifier Scan Error log [#31165] 10/26/09@22:32 165 lines
From: VistA Imaging Scan Errors In 'IN' basket. Page 1 *New*
SITE: IMGxxx.MED.VA.GOV
DATE: Oct 26, 2009@22:32:51 EST
10/26/2009 10:32:43 PM"No Full VC Files”21158"QRT00000019369.ASCA A2 " AT4ANNA
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10/26/2009
10/26/2009
10/26/2009
10/26/2009
AqgAnA

September 2018

10:32

10:32:

10:32:

10:32

143

43
43

143

PM"No Jukebox Full Files”21158"QRT00000019369.ASC " " "2T7477

PM"Not Certed”211587QRT00000019369.ASCA" """ "T4 A"
PM"No Full VC Files”21157"QRT00000019368.BMP"""2"2""T74 """

PM"No ABS file VC Ptr Cleared”21157”QRT00000019368.BMP"""""
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Chapter 6 Purge

e Application Description

e Setting up

e Tasking

e Understanding Processing

e Starting/Running the application
e Reports

6.1 Application Description

Image files are part of the patient’s record and must be preserved for the required number of
years. Image files may be kept online indefinitely in long-term storage. However, image files in
temporary storage must be purged periodically to provide ongoing free disk space for new
images. The primary purpose of the Purge is to delete files in temporary storage in order to
maintain a percentage of free disk space at all times. The Purge can be run manually, scheduled
or run automatically. An express purge is available to dramatically decrease the time it takes to
purge a share.

6.2 Setting Up

The Purge software will need to be installed on a Server class machine. The Purge requires a BP
Server defined for the server on which it will run (Section 3). In addition, the Broker port
connection needs to be set up (Appendix A)

Check the network connections to the Tier 1 shares and Tier 2 shares to make sure they are
online and the Windows account that will be used for logging into the workstation has
READ/WRITE permission to those shares.

6.3 Tasking
If the Purge is to be run automatically when a Tier 1/RAID Group exceeds the % Server Reserve
threshold, the PURGE task will need to be assigned to the BP Server.

6.4 Understanding Processing
Guidelines:

1. First determine how much free space is needed on the Tier 1 shares for non-interrupted
processing of new images.

2. Once that has been determined, the Purge Parameters need to be set.
3. Specify which file date the Purge parameters will use. The Windows date options are:
e Modified
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5.

e C(Created
e Accessed

Select the Express Purge option as this will minimize the time it takes to delete files from
the Tier 1shares.

Select which shares (or all) are to be purged.

Purge Process:

1.

6.4.1

When the purge starts, the application begins at the top of the directory tree on a selected
Tier 1 share and traverses to the bottom of the tree before starting on another share.

When the purge finds a file that is a candidate for deletion based on the file date option
selected, it first checks to make sure the file is on Tier 2 and has the same file properties
(size, etc.):

e If the file exists on the archive, then the file is deleted from the Tier 1 share and its

location pointer in VistA is cleared.

o [If the file does not exist on the archive device, the JUKEBOX entry is queued where
the file will be copied to Tier 2. The file is not deleted and no pointer in VistA is
cleared.

e Warning: See section 7.6.1 for circumstances when NOT to run the Purge.

The purge application then moves onto the next file. This process continues until all the
selected Tier 1 shares have been processed at which point, the purge displays a summary
page indicating its processing is complete for this session.

Setting Purge Parameters

Typically the Abstract file parameter is set 99999 days. These files are small in size and are
viewed as thumbnails on the Clinical Display workstations.

Keeping Patient Photo IDs and Advance Directives on Tier 1 can safeguard access to these
images; the loss of which on primary storage can result in delays to patient care.

Locating images for a patient is much less time consuming when these images are available on
Tier 1 versus having to wait for retrievals from the Tier 2.

The keep days for the Full and BIG files should be kept reasonably large to start.

1.
2.
3.

118

Start a test run on one share and determine how much free space is available after the run.
If the free space is adequate, use the current parameters to purge the remaining shares.

If more free space is needed, change the FULL and BIG retention/keep days to a lower
number and start another test run on one share.

When the right settings have been found, start the purge on the other shares.

These values can be kept in place until the rate of images per day increases substantially.
At that time, the FULL and BIG parameters will have to be decreased to remove more
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images from the shares.

Some sites have enough Tier 1 storage to keep 5 years of images. These sites need only purge
once per year to remove the sixth year's images off the Tier 1. The Purge Parameters can be set
to 5 years (in days) for the Abstract, Full, and BIG files.

Recommendation: VistA Imaging Cache or Tier 1 share devices operate more efficiently when
10 percent of disk capacity is available.

Some degradation occurs as the storage devices fill and files become fragmented. The system is
designed to notify the VistA Imaging system manager when VistA Imaging shares resources
have reached a critical level (default is 5% free space remaining). This value is too low for
normal workflow. At this point, the Automatic Write Location update option no longer operates.

6.4.2 File Types for Purge

By default, the file extensions (except TXT) in Appendix B are automatically purged from the
Tier 1 shares. In order to have the TXT files purged, an entry must be made for “TXT” in the
File Types field on the Imaging Site Parameters window on the Queue Processor application
(this is set up by the installation). These files are purged when there is no FULL or BIG file type
in the folder.

6.4.3 Purge by Dates
The Purge uses the following Windows file dates. Every file in Windows has these dates set.
e Date Created
e Date Accessed
e Date Modified

Recommendation: Use the Date Modified for most cases.

6.4.4 Express Purge Options

The Express Purge option can be used for any of the three types of purges described below—
auto, scheduled, and manual. The algorithm is based on the principle that most files that are
deleted during a purge are older files. The newer files remain on the share as they are within the
keep dates for the Purge Parameters. The time it takes to traverse through these newer files can
be lengthy with no files being deleted in the process. Some sites have a large number of shares
and this “dead’ time for purging can be extreme. The Express option causes the purge to stop the
file traversal on a share when the number of consecutive files that have not been deleted is
greater than the Purge Rate (measured in file count).

The three ways to initiate a purge are:
e Auto

The application monitors the amount of free space on the current RAID Group and
determines if there are multiple RAID Groups. If only one RAID Group exists, when all
the shares have reached the high water mark indicated by the % Server Reserve, a purge
is initiated on all the shares. If multiple RAID Groups are present and all the shares in the
next RAID Group are above the high water mark, the purge on that next RAID Group
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will start when the free space on the current RAID Group falls below the %Server
Reserve times the Purge Factor. The Purge Factor is a whole number and is set to a value
that allows enough time for the purge to complete on the next RAID Group before the
application moves the current write location to that group. It is recommended that the
Express Purge option be set on the Auto Purge. These parameters are specified on the
Imaging Site Parameters window.

Note: A BP Server must be assigned the PURGE task to run the Auto Purge.

e Scheduled

The Purge will run at set intervals over all the Tier 1shares starting at a specified
date/time as specified on the Imaging Site Parameters window.

Note: A BP Server must be assigned the PURGE task to run the Scheduled Purge.
e Manual
User-initiated Purge. Select one or more Tier 1 shares. The Purge Parameters and Express
Purge options apply.
Note: A BP Server does not have to be assigned the PURGE task to run a manual Purge.

6.4.5 Purge Events Table

The following table lists the result codes for the Purge. Each file that is traversed is listed in
either the Purge.html or PurgeError.html log file with its corresponding result code (See the
Reports section)

Purge.html/PurgeError.html (TGA, ABS, BIG extensions only)

Position |Field Comments

1 Action -3 = Foreign file. Not a valid file extension, do not purge

-2 = Queued for jukebox copy, do not purge
-1 = Do not purge
1 = Purge given normal date criteria + confirmed on jukebox

3 = Purge if file is at alternate network location site else
purge & update Tier 1 pointer

5 = Purge if at alternate site, queue jukebox if not on jukebox

2 File Type |0 =no file

1 =ABS

2=FULL

3 =BIG

4 = Photo ID

5 = Advance Directive
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Status

1 =No 2005 entry. No Purge.

6 = Tier 2 pointer set. File on Tier 2. Tier 1pointer incorrect
location. Purge if image at other location

7 = Tier 2 pointer set. File on Tier2. No Tier 1 pointer set.
Found file on Tier 1. Set Tier 1 pointer. No purge.

8 = Tier 2 pointer set. File on Tier 2. Tier 1 pointer set. File
on Tier 1. Purge file.

9 = Record not in the IMAGE file (#2005). No Purge.

10 = File extension is not a valid Imaging file extension. No
Purge.

14 = Duplicate 2005/2005.1 entry. No Purge

15 = Foreign PLACE. No Purge

16 = Record only in Audit (2005.1) file. No Purge
17 = Tier 2 offline. No Purge.

(File Types files - TXT extension is required - only)

Position

Field

Comments

1

"AltLastFile" Last non-ABS file on the share Neither a Fullnor

BIG file present in the share folder. Purge. Previous
versions kept the File Types files in support of the
ABS file.

6.5 Starting/Running the Purge

The purge can be started as an independent application, can be configured to run automatically in
the background (see section 3.5./ Purge Settings), or can be scheduled to run in the background
at prescribed time intervals (see section 3.5./ Purge Settings). The following steps describe how

to run the purge in the foreground:

Note: The Purge Retention Days and Purge By file dates are used by all the options listed
below. Set these parameters before any of the purge options are run / scheduled.

1. From the Windows Start > Programs menu, select VistA Imaging Programs > Background
Processor > Purge.

2. Log into the application using a valid VistA access and verify code. (The secondary menu
option All MAG* RPC's [MAG WINDOWS] is required for access to all the BP Storage

applications).

The Purge application window opens.
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3.

4. Highlight the shares to be purged and click OK.

S.

122

% BPPurge - BP Server GEKGFE - Site: SALT LAKECITY - User Garrett Edward Kirin BS - User Diﬁsim

Eile Edit Help
Purged Files -

T

@ | 302141

Activities
Start Date: <
Start Tine: <

Run Time [Hrs:min:secs]

Total Files: <
Purge Count:

<
JB Busues: <
Purge Criteria: <

<

IEM Count:

Purge Parameters

b3
>

>
b3
>
>

Share Processing

Refresh

Original File Counts

]

Purged Files

Select Edit > Select Shares.

The Purge Share Select window displays the shares.

it Purge Share Select

----- 2 MAGT - MWHAISWIMGYMS 4040 MAGE TS
----- 2 MAGTOH - WWWHAISWIMGY M S 404MIMAGETO$
----- S MAGTA - \WHAISWIMGVYMS 04N MAGE 2185
----- e MAGTH - MWWHAISWIMGWMS 404\ MAGE 1§,
----- = MAGZ - WMWHAISWIMGYMS 404\ MAGE 284

- - WHAISWIMGYM S 4040 MAGE 334
- WWHAISWIMGYM S 4040 MAGE 454
- SWYHAISwWIMGYM S 404N MAGE 53
- SWYHAI S WM GYM S 4040 MAGE B3
- WWHAISWIMGYM S 4040 MAGE 734
- WHAISWIMGYM S 4040 MAGE B3
- WWHAISWIMGYM S 4040 MAGE 35

W Epply |

o 0K

7 Help |

3 =

0] x|

Click the Start button.

Background Processor User Manual, Rev 17
VistA Imaging MAG*3.0*214

September 2018



6. Click OK in the message to confirm the shares to be purged.

Confirm

::/J Do you wish ko purge these RAID shares with these parameters?
-

Ok | Cancel |

The window closes and the purge starts. When the purge is complete, a summary sheet is
displayed.

PurgeResuIts M=l

File

[Manual Purge Fun Summarny]
Start Date: 7/A18/2013
Start Time; 4:46:34 PM
Run Time: 0:0:3
JB Queues: 0
[Purge Site Parameters]
Site File Prefis: D GO IE k&
Abztract keep days: 333
Full keep days: 333
Big keep days: 2891
Photo 1D keep days: 9999
Purge Crtenia: DATE MODIFIED
ExpressPurge: OFF
[RAID Share Count]
Total Share Files: 0
Total sbstracts: 0
Tatal Full; 0
Total Big: 0
Total Text: 0
Phiota 1D 0
Advance Directive: 0
Fargign: 0
[Purge File Count]
Total Share Files Deleted: 0
Purged Abstracts: 0
Purged Full: 0
Purged Big: 0
Purged Text: 0
Purged Phato 10 0
Purged Advance Directive; 0
Purged Foreigr: 0
[iztd RAID Shares Purged)]
WWHAISWIMGRPT VMHA MED VA, GOVYIMAGESSY - Purged

Note: View the results in a log by selecting File > Open log from the menu bar.

The purge results are displayed by file type in the lower section of the window, along
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with a purge results summary. The resulting data is described in the table that follows.

BP Purge - BP Server:BP1 - Site: SALTLAKECITYUT - User:0 - User Division: 660

File Edit Help
rPurged Files - DATE MODIFIED

AADDOMO0L0T0MADDDN0001 0372, 8bs - 4/15/2005
YAADDODO0\0 1 03WADDD00001 0372 TGA - 4/15/2005
IAADDOMO0L0TY0NMADDDN000T 037 2.0 - 31 472007
YAADDYDOI0L0 TR 03WADDON0001 0373 abs - 4/18/2005
AADDOMO00T0AMADDD0000T 0373 TGA - 4/19/2005
YADDOOO0,0 TR 0WADDON0001 0373 bat - 341 472007
AADDOMO0L0T0MADDDN00010374.8bs - 4/15/2005
YAADDODO0\0103NADDD00001 0374 TGA - 4/15/2005
IAADDOMO00TY0NMADDD0000T 037 4.0 - 31 472007
YAADDY0OI0,0 TR 03\WADDON0D01 0375 abs - 4/18/2005
AADDOMO00T0AMADDD0000T 0376 TGA - 4/19/2005
YAADDDO00,0 TR 03\WADDON000T 0375 bat - 341 472007
AADDOMO0L0T0MADDDN00010376.abs - 4/15/2005
YAADDODO0\0103WADD000001 0376 TGA - 4/15/2005
IAADDOMO0L0TY0MADDD0000T0376.04 - 31 472007
YAADDYDOI0,0 TR O3WADDON0D01 0377 abs - 4/18/2005
AADDOMO00T0AMADDD0000T 0377 TGA - 4/19/2005
YADDOCO0,0 TR 0WADDON0001 0377 bat - 371 472007
AADDOMO0L0TY0MAODDN00010378.abs - 4/15/2005
YAADDY0MO0\01403WA000000010378 TGA - 4/19/2005
AADDOMO0L0TY0NMAODD0000T 0376 04 - 31472007
YAADDY0 0,01 03\WADD000001 0379 abs - 4/18/2005
AADDOMO0\0T0AMADDD00001 0378 TGA - 4/19/2005
i

© Start 1 & Stop

[~Share Processing

- Activitie:
Start Date: 84842013

StartTime:  4gq5anam
Frun Time [Hrs:minsecs] oea

Tota Files: g5
Puige Count peg
JB Queves g
Furge Ciiteria

IEN Count:

DATE MODIFIED

Purge Parameter

Site File Prefic DM, GOLIE MA,

Abstract keep days: 333

Fullkeep days: 333

Big keep days: 2891

Fhota 1D/ Advance Directives keep days: 3999
Minimum keep days: 333

Furge Criteria: DATE MODIFIED

Express Purge: ON

Express Purge Rate: 100000

W HAISWIMGRPT VHA MED VA GOVIMAGERS, -

Original File: Counts

Abstract Full mage

5

Phato |0 Advance Directives

]

Foreign

B 55 Abstract

I =5 Full Image:

0 By

I 55 Text

10 Phato ID

[ 0 Advance Directives
[ 0 Forsign

—[Phot D | AGVanCe DItBCtives |~ ] FOrSIGN humy o]

I 55 Abstract
I 55 Full Inage

[ 0 Photo ID
[ 0 Advance Directives
I 0 Foreign

Name

Description

Purged Files — DATE
MODIFIED

Other possible values:
DATE ACCESSED
DATE CREATED

List of files on the current Tier 1 share (highlighted in
the Share Processing window) that are deleted because
they met the Purge criteria.

Activities
Start Date Start date of purge.
Start Time Start time of purge.

Run Time (hrs: mins: secs:)

Time to complete the purge.

Total Files

Number of files checked.

Purge Count

Number of files purged.

JB Queues

deleted.

Number of files that were purge candidates, but not
found on Tier 2. A JUKEBOX queue entry was
created to copy the file to the archive. The file is not
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Name

Description

Purge Criteria:
DATE MODIFIED

Other possible values:
DATE ACCESSED
DATE CREATED

Date criterion used to determine which files to delete.

IEN Count

Number of unpurged IENSs traversed since the last IEN
purged on the current share. When the Purge operation
is traversing through an IEN range that is rich with
purge candidates, this number will be rapidly reset to
zero. A continually growing IEN Count indicates that
the Purge utility is in a range low in purge candidates.
During a manual purge, the user may opt to stop the
purge at that point.

The IEN Count is used in conjunction with the
Express Purge Rate when Express Purge is active.

Purge Parameters

Site File Prefix: DM, IE, QRT

Namespace and multi-namespace names for the site.

Abstract keep days Purge parameter indicating the time frame for keeping
abstract files on Tier 1.

Full keep days Purge parameter indicating the time frame for keeping
Full files on Tier 1.

Big keep days Purge parameter indicating the time frame for keeping
BIG files on Tier 1.

Photo ID / Advance Purge parameter indicating the time frame for keeping

Directives keep days

Photo ID / Advance Directives files on Tier 1.

Purge Criteria

Date criterion used to determine which files to purge.
Options are Date Modified, Date Created or Date
Accessed.

Express Purge

Indicates if the Express Purge feature was used in this
purge.

Express Purge Rate

The Express Purge will stop on a share when the IEN
Count value reaches this threshold value.

Share Processing

Tier 1 share paths

Location of shares being processed.
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Name Description
Original File Counts
Abstract, Full Image, Big, Breakdown by file type of original files processed
Text, Photo ID, Advance Note: Legend on the right displays the count by file
Directives, Foreign type. Text refers to File Types (extensions).
Purged Files
Abstract, Full Image, Big, Breakdown by file type of files purged.
Text, Photo ID, Advance Note: Legend on the right displays the count by file
Directives, Foreign type. Text refers to File Types (extensions).
6.6 Reports
Three types of reports are produced to notify the site of important occurrences:
e Log files
e Emails

e Screen-generated output
6.6.1 Log Files

New log files are created as HTML files at the beginning of every session. HTML files are
viewable, printable, and searchable. By default setting, the BP Purge log files reside in the
C:\Program Files\VistA\Imaging\BackProc\log\purge directory. These files can be accessed by:

e Selecting File > Open Log on the BP Verifier menu bar
e Using an Internet browser
They can be imported into an Excel spreadsheet.
6.6.1.1 Log File Format

Purge log files have the year-month-day and sequence number imbedded in the file name, as
shown in the right pane of the window.

Address I.,_"'| C1\Program FilesivistaiImagingBackPracilogipurge
Folders » || Mame =
= 1) wiska a &]Purgez009_08_18.html
3 Broker &]PurgeError2009_08_16. html
[ [5) Imaging @}PurgeErrurZDD?_ﬂB_lB_ﬂl.html
= 1) BackProc
I) Help
=12 log
| BackProc
oM
| werifier

If more than one log file is run on the same day, the system adds a sequence number such as
“01” following the date in the file name, as shown for the “PurgeError2009 08 18 01.html” file.
For multiple runs on the same day, the highest sequence number is the latest log file run for the
day.
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The Purge run produces two types of log files shown—Purge{date}.html and

PurgeError{date}.html.

The Purge.html log file records the current share being purged as well as all of the successful
deletions and the reason they were deleted. The following example shows a copy of the purge

6.6.1.2

Purge Log File

results.
Address I@ CH\Program Files)vistaImaging\BackProcilogipurge\Purge2009_0&8_13, html
| DateTime | Ewent_Type | Message
|8.l’18.l‘2EIDQ F:158:39 Phi |Elegin Furging Share |\\VHAIS‘LI1I‘LI1I'HITE\-"M1\IMAGE1$
|8."18.QUDQ 32046 P |F'urge Criteria: 3r1~6 |\.\\-’HAIS‘LI'U‘LI’[I'HITE\-‘huH\IMAGE1$\DM\DD‘D§\DMDDD§QZ.ABS 4852009
|8.l’18.l’2009 F:20:46 P |F’urge Criteria: 3nz2~b |\.\\JHNSUUWHITE\-‘M1\IMJ’-‘\GE1$\DM\DD‘D§\DMDDD§QZ.TIF igi2003
|8.l’18.l‘2EIDQ 2046 Fhd |AItLastFiIe |\.\\-"HAIS‘LI'U‘LI'U'HITE\-"M‘i\IMAGE1$\DM\DD\05\DMDDDSQZ.T>{T Gi5/2009
|3."18."2EIDQ 220046 P |Purge Criteria: 2~ 1~6 |\.\VHAISIIW’U’HITEVM'1\IMAGE1$\DM\DD‘D§\DMDDD§QS.ABS 422009
|8.l’18.l’2009 F:20:46 P |F’urge Criteria: 3nz2~b |\.\\JHNSUUWHITE\-‘M1\IMJ’-‘\GE1$\DM\DD‘D§\DMDDD§QS.TIF igi2003
|8."18.QUDQ 32046 P |AItLastFiIe |\.\\-’HAIS‘LI'U‘LI’[I'HITE\-‘huH\IMAGE1$\DM\DD‘D§\DMDDD§QS.TKT 4852009
|3."18."2EIDQ 220046 P |Purge Criteria: 2~ 1~6 |\.\VHAISIIW’U’HITEVM'1\IMAGE1$\DM\DD‘D§\DMDDD§QS.ABS 422009
|8.l’18.l‘2EIDQ 2046 Fhd |Purge Critaria: ZrZnf |\.\VHAIS‘LI'U'LI'U'HITE\-"M1\IMAGE1$\DM\DD\05\DMDDDSQS.JPG Q22009
|8."18.QUDQ 32046 P |AItLastFiIe |\.\\-’HAIS‘LI'U‘LI’[I'HITE\-‘huH\IMAGE1$\DM\DD‘D§\DMDDD§Q§.TKT 4852009
|3."18."2EIDQ 220046 P |Purge Criteria: 2~ 1~6 |\.\VHAISIIW’U’HITEVM'1\IMAGE1$\DM\DD‘D§\DMDDD§QB.ABS 422009
|8.l’18.l‘2EIDQ 2046 Fhd |Purge Critaria: GrZad |\\VHAIS‘LI'U‘LI'U'HITE\-"M1\IMAGE1$\DM\DD\05\DMDDDSQB.JPG Q52008
|8."18.QUDQ 32046 P |AItLastFiIe |\.\\-’HAIS‘LI'U‘LI’[I'HITE\-‘huH\IMAGE1$\DM\DD‘D§\DMDDD§QB.TKT 4852009
|8.l’18.l’2009 F:20:46 P |F’urge Criteria: 3 1~G |\.\\JHNSU'UWHITE\-‘M1\IMJ’-‘\GE1$\DM\DD‘D§\DMDDD§Q?.J’-‘\BS igi2009
Name Description
Date/Time Date and Time of purge.
Event Type Displays the final purge criteria for the file listed. (See
Purge Criteria section.)
Message Image file and access, creation, or modified date
depending on the criteria.
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6.6.1.3 PurgeError Log File

The PurgeError.html log file records the current share being purged as well as all of the files that
were not deleted and the reason they were not deleted or other details related to the event. The
following example shows a copy of the purge results.

Address I@ Ci\Program Files\viska) ImagingBackProcilogipurge\PurgeErrar2009 _0S_18.html
| D=teMime | Ewent_Type | Message
EFE:IIS'QDDQ FATES InitLogFile A onew logfile iz created: CAProgram Fileswisttimaging\BackProchlogipurgerPurge.Log
8872000 2:12:40 A MOT PURGEDWYHAISWMALHIT EWIA T MAG E 1AW HADMOMOOD 1V 1S HADDDDOD 1 1425 ABS
Furge Criteria: -3~0~10
Fhi 2009
8/8/2009 3:18:40 - NOT PURSEDWWYHAISWALHIT EWhA 14 hidod E 40 HADWIOOW 14 1M S HADDD0001 1435.D Thi
Furge Criteria: -3~0~10
Fhd 42009
882009 3:18:44 A NOT PURGEDWWYHAISWALHIT EW AT A0S E WG HADOIMOOD 11 ACHADODD001 1435 TXAT
Furge Criteria; -3~0~10
Fhd 42009
8/M8/2009 3:18:d4 - NOT PURGEDWWYHAISWALHIT EWhA 14 hidos E RS HADWIOOW 14 1M C HADDD0001 1426 ABS
Furge Criteria: -3~0~10
P hid 42009
8/18/2009 3:18:44 - NOT PURGEDWWYHAISWALHIT EW A T4 hA0G E WG HADOIOON 131400 HADOD0004 14360 Ch
Furge Criteria: -3~0~10
Fhd 2009
2M8/2000 31844 L NOT PURGEDW/HAISWAVHITEVM AW MAG E1FCHADIIIOW VR HADDO0001 1426, T AT
Furge Criteria: -3~0~10
F il f2008
8/18/2009 3:18:44 - NOT PURGEDWWYHAISWALHIT EW A1 AG E 1T HADOMOOD 1410 C HADOD0001 1437 ABS
Furge Criteria: -3~0~10
Fhd 42009
S/M8/2000 21244 A MOT PURGEDWYHAISWALUHIT EWRA T MAG E1FWC HADMOMOOD 1100 HADDDD001 1427 .0 T
Furge Criteria: -3~0~10
Fhi 2009
8/M8/2009 3:18:44 L HOT PURSEDWWYHAISWALHIT EWhA 14 hidos E 40 HADWIOOWD 14 1M C HADDDD001 1437 TXT
Furge Criteria: -3~0~10
Fhd 42009
882009 3:18:44 A NOT PURGEDYWWHAISWALHIT EWRA T A0S E 1AW HADOIMOOD 1V 1A CHADOD0001 14328 ABS
Furge Criteria; -3~0~10
Fhd 42009
8/M8/2009 3:18:d4 L NOT PURGEDWWYHAISWALHIT EWhA 14 hidod E 40 HADWWOOW 14 1M S HADDD0001 14380 Thi
Furge Criteria: -3~0~10
P hid 42009
o 4
Name Description
Date/Time Date and Time of purge.
Event Type Displays the final purge criteria for the file listed and/or
the share path on which the file was found. (See Purge
Criteria section.)
Message Image file and access, creation, or modified date
depending on the criteria.
2 .
6.6. Emails

The following e-mail messages are generated or triggered by the purge.
6.6.2.1 Scheduled Purge Failure Message

This message is sent by the Monitor Background Processor Activity [MAGQ BPMONITOR]
menu option to indicate that the Scheduled Purge did not run. The BP Server may not have been
assigned the PURGE task, therefore there is a risk that the shares will run out of free space. Run
a manual purge, if necessary, until the problem is resolved.

Example of the message when the Purge is scheduled but fails to start:

[#31195] 10/27/09@12:40 4 lines

'IN'

Subj: Scheduled Purge failure

From: VistA Imaging MAGQCBP In basket. Page 1 *New*
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SITE: IMGxxxxx.MED.VA.GOV
DATE: Oct 27, 2009@12:40:01 EST

The SALT LAKE CITY implementation of VistA Imaging has failed to start
the sche

dule Purge activity!

The task is currently assigned to BP Server: ISW-xxxxx-LT

Example of the message when the PURGE task is not assigned to a BP Server:
Subj: Scheduled Purge failure [#31199] 10/27/09@12:55 4 lines
From: VistA Imaging MAGQCBP In 'IN' basket. Page 1 *New*
SITE: IMGxxx.MED.VA.GOV
DATE: Oct 27, 2009@12:55 EST

The SALT LAKE CITY implementation of VistA Imaging has failed to start
the schedule Purge activity!

The task is currently assigned to BP Server: Auto Purge is not
currently assigned

6.6.3 Screen-Generated Qutput

When the purge completes the Stop button is clicked, the results are displayed in a summary
window. Use the option print to file to save this data.

6.6.3.1 Purge Results
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PurgeResuIts [_ (O]

File:

[Marual Purge Fun Summary]

Start D ate: 8/20/2013

Start Time: 4:45:37 PM

Rur Time: 0:0:6

JB Queuss: 4
[Purge Site Parameters]

Site File Prefix: OM,GOJE Ma

Abstract keep days: 333

Full keep days: 333

Big keep days: 2891

FPhato 1D keep days: 9333

Purge Criteria: DATE MODIFIED

Express Purge: ON

Express Purge Term: 100000
[R&ID Share Count]

Tatal Share Files: 10

Total Abshracts: 2

Tatal Ful: 0

Tatal Big: 0

Total Text: 4

Photo ID: 3

Advance Directive: 1

Foreign: O
[Purge File Count]

Total Share Files Deleted: 0f

Purged Abstracts: 0

Purged Full: 0

Purged Big: 0

Purged Text: 0

Purged Photo [D: 0

Purged Advance Directive: 0

Purged Foreign: 0
[Wistd RAID Shares Purged]
WWHAISWIMGRPT VHAMED VA GOVSMAGE 14 - Purged
WWHAISWIMGRPT WHAMED WA GOVSMAGESS - Purged
WWHAISWIMGRPT WHAMED WA GOVSMAGEES - Purged
WWHAISWIMGRPT WHAMED WA GOVAMAGE 74 - Purged
YWHAISWIMGRPT WHAMED WA GOVSMAGESS - Purged
YWHAISWIMGRPT WHAMED WA GOVSIMAGE 3% - Purged

Name ‘ Description
[Purge Run Summary]
Start Date Start date of purge.
Start Time Start time of purge.
Run Time Time to complete the purge (hrs: mins: secs:).
Total Files Number of files checked.
JB Queues Number of files that were purge candidates, but not found

on Tier 2 A JUKEBOX queue entry was created to copy
the file to the archive. The file is not deleted.

[Purge Site Parameters]

Site File Prefix: DM,
IE, QRT

Namespace and multi-namespace names for the site.

Abstract keep days Purge parameter indicating the time frame for keeping
abstract files on Tier 1.

Full keep days Purge parameter indicating the time frame for keeping
Full files on Tier 1.

Big keep days Purge parameter indicating the time frame for keeping
BIG files on Tier 1.

Photo ID keep days Purge parameter indicating the time frame for keeping

Photo ID files on Tier 1. (Includes Advance Directives)
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Name Description

Purge Criteria: DATE | Date criterion used to determine which files to delete.
MODIFIED

Other possible values:
DATE ACCESSED
DATE CREATED

Express Purge

Indicates if the Express Purge feature was used in this
purge.

Express Purge Term This value is file count. The purge will stop on a share

when it processes this number of files and none have met
the purge criteria to be deleted.

[Tier 1 Share Count]

Total Share Files Total number of files traversed on the shares.
Total Abstracts Total number of .ABS files found.
Total Full Total number of Full files found.
Total Big Total number of .BIG files found.
Total Text Total number of . TXT files found /TXT refers to File
Types (extensions).
Total Photo ID Total number of Photo ID files found.
Total Advance Total number of Advance Directive files found.
Directive
[Purge File Count]
Total Share Files Total number of files deleted on all the shares processed.
Deleted
Purged Abstracts Total number of .ABS files deleted on all the shares.

Purged Full Total number of Full files deleted on all the shares.
Purged Big Total number of .BIG files deleted on all the shares.
Purged TXT Total number of .txt files deleted on all the shares.
/TXT refers to File Types (extensions).
Purged Photo ID Total number of Photo IDs deleted on all shares.
Pgrgeq Advance Total number of Advance Directives deleted on all shares.
Directive
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Chapter 7 System Monitoring

e Description of the BP Server Monitor Utility
e Configuring the BP Server Monitor

e Scheduling the BP Server Monitor

e Monitoring the BP Queue Processor

e Monitoring the BP Verifier

e Monitoring the BP Purge

Important: The Imaging Coordinator's primary tasks involve monitoring the BP by reviewing
the log files on a daily basis.

7.1 Description of the BP Server Monitor Utility

The BP Server Monitor is a utility that sites can configure to monitor the activity of BP Server(s)
in the VistA Imaging system. The utility sends an e-mail when one or more BP Servers are not
operating properly and it monitors the assigned tasks of BP Server(s) to determine if:

e A task is lagging behind.
e The task has too many failed queues.
e A scheduled task has not executed.

The utility enables the Imaging Coordinator to evaluate the BP Server(s) to determine whether a
network traffic problem exists, and to maintain the tasks effectively.

7.1.1 Evaluating EVAL Queues

The BP Server Monitor does not evaluate unassigned tasks with the exception of the EVAL task.
The EVAL queues are generated by DICOM Gateways where the Routing parameters have been
set. Occasionally, sites mistakenly set the Routing parameters and thus create EVAL queues
inadvertently. The BP Server Monitor utility reports on unprocessed EVAL queues when they
reach a specified quantity. A site having a large number of EVAL queues may slow the BP
Server client software when displaying the Queue Manager window.

7.1.2 Reporting Using Mail Messages
All reporting by the BP Server Monitor uses the following Mail Messages subject texts:

VI BP_Queue Processor failure
Scheduled Purge failure
Scheduled Verifier failure

VI BP EVAL Queue

Descriptions of these messages are in the Mail Messages section of the chapters Queue
Processor, Verifier, and Purge.
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Recommendation: These Mail Messages should be configured to include the appropriate
personnel responsible for resolving a problem, and to set up the message interval to control the
number of messages sent. For details, see section 3.3 Configuring Mail Messages.

7.2 Configuring Mail MessagesConfiguring the BP Server Monitor

The BP Server Monitor is a menu item in VistA, Monitor Background Processor Activity
[MAGQ BPMONITOR] . This menu option must be executed on a regular basis and should be
tasked using the VistA TaskMan Management menus.

The BP Server Monitor can be configured with site specific values when the utility is scheduled
using the Kernel Scheduling menu (explained in the next section). The site configurable
parameters are:

¢ MAGMIN - determines the lapse time between processing tasks. If the variable is
undefined, then the default value is 15 minutes. If an active queue has not processed
within specified minutes then a mail message is sent.

e MAGFQ — determines if failed queues per queue type have reached this limit. If the
variable is undefined, then the default value is 1,000. If failed queues are above this
limit, then a mail message is sent.

e MAGEVAL - determines if EVAL queues have reached this limit. If the variable is
undefined, then the default value is 10,000. If EVAL queues are above this limit, then a
mail message is sent.

7.3 Scheduling the BP Server Monitor
7.3.1 Example of Scheduling

If MAGMIN minutes have transpired since processing the last queue and there is another queue
to be processed, then a MailMan message with subject text “VI_BP_Queue Processor failure”
will be sent.

Recommendation: Schedule this task to run every 10 to 15 minutes (site configurable).

134 Background Processor User Manual, Rev 17 September 2018
VistA Imaging MAG*3.0*214



7.3.2 Tasking BP Server Monitor Menu Options

Recommendation: Task the menu to run daily using the Kernel Scheduling menu option in the
following example.

7.3.2.1 Example 1

On VistA, use the Schedule/Unschedule option [XUTM SCHEDULE] to task the activity:
Add the MAGQ BPMONITOR.
Set the date and time to run the monitor the first time.
Set the Rescheduled Freq., for example, 600S for 10 minutes. If the time is set for 10
minutes then the job will execute every 10 minutes. The S must be capitalized.
Example:
Select Taskman Management Option: Schedule/Unschedule Options
Example:
Select OPTION to schedule or reschedule: MAGQ BPMONITOR Monitor Background
Processor Activity

Are you adding 'MAGQ BPMONITOR' as a new OPTION SCHEDULING (the 39TH)? No// Yes

Option Name: MAGQ BPMONITOR
Menu Text: Monitor Background Processor Act TASK ID:

QUEUED TO RUN AT WHAT TIME: OCT 20,2009@24:00
DEVICE FOR QUEUED JOB OUTPUT:
QUEUED TO RUN ON VOLUME SET:

RESCHEDULING FREQUENCY: 600S

TASK PARAMETERS:

SPECIAL QUEUEING:

If this field is blank then the job will run only once.

7.3.2.2  Example 2

The following example is obtained by entering NEXT at the COMMAND prompt. Arrow down
to the bottom to see the COMMAND: prompt. This example uses the parameters mentioned in

section 7.2, Configuring the BP Server Monitor to configure the utility to meet the needs at your
site.

Important: When configuring the MAGMIN parameter, consider your site’s Imaging network
topology. If your site’s Imaging network has remote network locations, then 15 minutes may be
too low for the lapse time and should be adjusted accordingly.
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MAGFQ, the variable for the sensitivity value for failed queues.
MAGMIN, the variable for the sensitivity value for the time lapse between queue

processing.

MAGEVAL, the variable for the sensitivity value for EVAL queues.

Optional parameters are:

Edit Option Schedule
Option Name:

MAGQ BPMONITOR

USER TO RUN TASK:

VARIABLE NAME: MAGFQ VALUE: 50
VARIABLE NAME: MAGMIN VALUE: 25
VARIABLE NAME: MAGEVAL VALUE: 50000
VARIABLE NAME: VALUE:
VARIABLE NAME: VALUE:

COMMAND :

Arrow down until “Command:” appears and then enter E for Exit, answer YES to Save changes
that have been made.

7.4 Monitoring the BP Queue Processor

The BP Server Utility handles all the entries that exist in the BP SERVER file (#2006.8) and the
BP queues assigned to each server.

Note: The following procedures are not required. They are suggested as efficient ways to
monitor the BP Queue Processor as a preventative measure.

7.4.1 Precautionary Guidelines

|
*” The BP Queue Processor should not be run under the following conditions:

e When network outages or VistA Hospital Information System outages occur

e During upgrades and file server malfunctions that result in the loss of connectivity to all
VistA Imaging shares or to all Tier 2 devices

¢ When jukebox maladies occur such as configuration management tool outages, jammed
picker arms, or shortages of newly formatted platters

7.4.2 Daily Monitoring

1. Make sure the BP Server Monitor is running in the background in TaskMan.
2. If BP Monitor is not used, verify queue entries are being processed.

3. Monitor email for alerts that were set up through the application.

4. Check Queue Manager for any failed JUKEBOX, IMPORT, JBTOHD or GCC entries
that need to be re-queued.
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. Run the Verifier daily or weekly over the range of images that were processed in that

time period. This can be scheduled to run for your chosen interval.

Examine the Verifier log file No Archive.log for entries with a blank in the
“2005.1”column. These files are missing on your Imaging system (Tier 1 and Tier 2
storage).

7.5 Monitoring the BP Verifier

Verifier scans can be run any time of the day as there is minimal impact on VistA. They should
be run based on the following reasons:

Routine Scanning Of Newly Acquired Images

The Verifier should be run every 1 or 2 weeks to verify new entries in the IMAGE file
(#2005). In some cases, if images are missing, they can be resent from the modality.

Periodic Maintenance of the VistA Imaging System

The Verifier should be run several times each year to verify the entire range of Image
Internal Entry Numbers (IENs). During the year, many files will be retrieved from Tier 2
and pointers updated in the database. This will ensure that files on the Tier 1 and the Tier
2 can be accurately located.

Large Image Share Population Events

The Verifier should be run over the range of Image (IENs) that were copied back to the
Image shares from the Tier 2. There may be occasions where files were not copied and
incorrect file pointers set in the database with this large volume of files being moved to
the Tier 1.

Tier 1 share or Tier 2 outages

The Verifier should be run after the resolution of any event that interrupted the flow of
images to Tier 2. The Queue Processor will attempt to copy files to Tier 2 three times. At
that point it will indicate failure and begin processing the next entry in the queue.

Note: These files reside ONLY on the Image shares and therefore MUST be copied
promptly to Tier 2 using the Verifier.

Offline Platters

When the jukebox is physically full and space is needed to add additional platters, the
OFFLINE IMAGE utility MUST be used (See Chapter 9 Jukebox Archive in the VistA
Imaging System Technical Manual) prior to physically removing the platters. This utility
will mark the IENs as being archived and the Verifier will skip these while processing.
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7.6.1

|
*” The BP Purge should not be run under the following conditions:

138

7.6 Monitoring the BP Purge

Precautionary Guidelines

When Tier 2or VistA Imaging shares access is compromised

When excessive jukebox copies will automatically be queued by the BP Purge because

copies cannot be verified on Tier 2

When the BP Purge does not have access to the VistA Imaging shares it is intended to

purge
When the VistA hospital system is not available
When the RPC Broker Listener is not active

When the network is down
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Chapter 8 Troubleshooting

e General Startup

e Queue Processor

e Verifier
e Purge
e Import API

8.1 General Startup

8.1.1 Network Connection

Check all the online VistA Imaging Tier 1 shares and Tier 2 shares by one of the following
means to determine if the BP has access to the folders/files on the shares. There are several
methods to test the connectivity:

1.

From the Main BP window, select the View > Server Size option.
The free space should display for each share.

: SALT LAKE CITY BP Queue Processor
Fie Edi | view Help

Server Size

JETOHD Repart

Metwor  Irport Queus
Furge | Redueue by tvpe

Using Windows Explorer on the destination device (Image cluster or Windows-based Jukebox
server), show the properties of the VistA Imaging Tier 1 shares and Tier 2 shares.

The VHAxxxIA account that is used to log into the BP Server should have READ/WRITE
access to both the shares and folders/files on those shares.

Note: For sites using the Archive Appliance (AA), contact the HP Expert Center.

. Open a DOS window. At the command prompt type dir \\server\share (the server could be a

cluster server or the jukebox server). Traverse down a couple folders under the main level the
folders/files should be visible

. If any of these methods fail, open a DOS window and use the DOS ping command to see if

the server is accessible on the network.

If the server is accessible, try mapping the share thru Windows Explorer. Explorer will
display any error messages. If the server is not accessible, contact the network admin to
troubleshoot.
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8.1.2 Broker Failures
When the connection to the Broker fails:
e Verify the PORT and Server are correct in the registry
e Close and restart the application.
e Open a DOS window and use the ping command to see if the VistA server is available
e Verify that the listener is running in VistA
e Validate that the Access/Verify codes have not expired.
e Check the security on the Access/Verify account. Make sure:
- The MAG SYSTEM security key is assigned
- The All MAG* RPC's [MAG WINDOWS]menu option is assigned
8.1.3 Not Enough Server Cache
This message indicates that:

e The share on the server is not accessible. Follow the steps in section 8././ Network
Connection to troubleshoot.

e The free space on the Image shares is below the % Server Reserve.
- Disable the Auto Write Location Update option.
- Set the write location manually to a share with cache space available.

- If no share has adequate free space, create a second BP Server and manually
launch a Purge (in Chapter 6 Purge) to run on all shares. When the Purge has run
and generated free space on a share, set the Write location manually to that share.

8.14 Not Enough Process Memory

Close all the applications and reboot the server. If the problem persists, contact the National
Helpdesk.

8.1.5 Not Enough Write Cache Available

This message refers to the DiskXtender cache on the jukebox and indicates there is no free space
on the jukebox share, or for Archive Appliance sites a possible space issue exists.

e Verify the share is accessible. Follow the steps in section §././ Network Connection to
troubleshoot.

e C(lick the Extended Drive in DiskXtender to see if there is free space available. Also, use
Windows Explorer on the JB server to see if Windows is properly reporting free space.

e Check the Move Group within the DiskXtender application to see if there are platters
with available space. If not, add additional optical platters to the Move Group. See the
DiskXtender User Manual.

e Run a Drive Scan on the share. See the DiskXtender User Manual.
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8.2.1

8.2 Queue Processor

Startup

Message

Explanation

Action

Create Process
failed+ProgramName

A system error occurred staring
the process

Follow your local, VISN, or
regional procedures for problem
resolution/escalation

Increment queue name
Ptr Failed

The QUEUE POINTER (#1) in
the IMAGE BACKGROUND
QUEUE POINTER file
(#2006.031) in VistA could not
be updated

On the main BP window, use the
Edit > Refresh Queue Counts to
correct the current counts. Close
the BP and restart the application.

Initialization Failure”Log Files
at: C:\Program
Files\Vista\Imaging\BackprocLo
g\BackProc\BPError.log

Log file could not be created

Check permissions on the log
folder

RAID groups not properly
configured

An active RAID Group has no
online shares

Make sure online RAID Group has
online shares.

Use the Network Location
Manager to reset your RAID
groups

Requeue Failure trying to
Requeue:

An attempt to re-queue a failed
queue entry failed

Use the Queue Manager and step
past the queue entry. Determine the
problem with the entry that would
not re-queue.

SetTime Handle — Destin:
C:\Program
Files\Vista\Imaging\BackprocLo
g\BackProc\BPError.log Access
is Denied

Could not write the Access Date
on the log file

Check the file permissions on the
log folder listed.

The Background Processor client
software is version n.n.n.n.
VistA Imaging Host system has
version m installed. Please
update to compatible client and
host software. Shutting down the
Background Processor...

The client software that is
installed does not match the
KIDS version installed on VistA.

Install the correction version of the
KIDS and client software.

The Patch 135 KIDS install on
the VistA host system is required
for this Version of the: site name
BP Queue Processor

The KIDS file for this most
recent patch has not been
installed in VistA.

Install the KIDS file on VistA.
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Message

Explanation

Action

The Site parameter context could
not be determined. The
application will terminate.

The PLACE global is corrupt

Follow your local, VISN, or
regional procedures for problem
resolution/escalation.

¥ista Imaging Background Processor

'0' "is not a walid integer walue,

The Broker is not properly
configured in the registry of this
server.

Edit the registry on this server to
meet the connection requirements
on the host server with proper host
server name and port number.

Note: on 64 bit OS the hive is

[HKEY LOCAL _MACHINE\SO
FTWARE\Wow6432Node\Vista\B
roker\Servers]

This server is not yet configured
for BP queue task processing!

There is either no BP Server
name with this network name in
the BP Server file (#2006.8) or
there are no task(s) assigned to
this server

Create a BP Server through the
GUI and assign tasks to it BP
Servers menu/tab

InitLogFile: procedure
NewCreationDate | SetFileTime
Failed WIN32 Error

Log File Initialization error

See above The log files should not
have a local drive in the BP Server
Parameters. The designated path
should be a network share. Note:
The Computer name is
automatically set by the application
software. Setting the server name
in the parameter will create a
confusing duplicate descendant
server tree on the Network share.

8.2.2 Runtime
Message Explanation Action
0"Accusoft Control creation The Import APT uses the The AccuSoft controls are installed
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error : < error message >

AccuSoft Image Gear Toolkit to
create the watermarked image. If
an error occurs during the
creation of AccuSoft controls,
the error message displays
describing the error.

during MAG*3.0*135 installation.
If this error message occurs,
contact the VistA Imaging system
manager.

0"Image is missing from input
data.

The image to be watermarked is
not in the Import Queue Data.

Check the IMAGE file (#2005) to
see if the data is corrupt.
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Message

Explanation

Action

0"Watermark failure : <error
message>

The process of burning the
“Rescinded” watermark onto the
image file failed.

The AccuSoft ToolKit could not
create the watermarked image.

Check if the rescinded bitmap
exists in the image directory
C:\Program
Files\vista\Imaging\Bmp\MagRe
scinded.bmp.

You may need to reinstall
MAG*3.0*135 to correct AccuSoft
ImageGear problems.

An Abstract for this file is on the
Jukebox, a JBTOHD is being
queued

ABSTRACT - The abstract

pointer on the Tier 1 is empty.
The abstract will be copied from
the jukebox

None

Could not complete

DELETE - file could not be
deleted

Check permissions on Tier 1
share

Could not complete/Requeued

DELETE - file could not be
deleted

Check permissions on Tier 1
share

Current Tier 1
Shares“Exception: No RAID

The Tier 1 share must be
assigned to a RAID Group

On the BP main window, use Edit
> Network Location Manager to

group Assigned assign the Tier 1 share(s) to a
RAID Group.

False Positive Copy File sizes on source and Determine if images are for

filename(Source), destination don’t match. File not | different patients

filenames source file size, file
size(jukebox)

copied.

File copied was of size zero

IMPORT - The file size is zero

Resend image from import source

File of size zero created then
deleted

MAKEABS - file of zero length
was created by
Mag_MakeAbs.exe. It was
deleted.

Follow your local, VISN, or
regional procedures for problem
resolution/escalation

File was not found

IMPORT - file does not exist on
the image share

Resend image from import source

filename Source file does not
exist.

Could not find source file

Run Verifier to correct VistA
pointers

fileshare: Cannot connect to the
Export Share.

EXPORT - Cannot map to the
remote share

Check for network connectivity.
Check permissions..

ForceDirectories failed:

DELETE - could not create

directory on jukebox share

Check permissions on jukebox
share
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Message

Explanation

Action

Image File type: filename.ext is
an Unsupported Format

ABSTRACT - The Full file is
not a supported Imaging file
type. So the abstract cannot be
created.

Examine the "foreign" file and
determine if the extension was
misnamed.

Invalid Imaging Network
Username or Password.

The BP processor operator does
not have write permissions on
Tier 1, Tier 2, the Network Log
file share, or the IMPORT share.

Check permissions on the share the
write share associated with this
error.

Jukebox is not available: filepath
Volume label

Tier 2- the jukebox share is not
available

Ping the jukebox server. Check the
jukebox share permissions.

Jukebox sourcefile unavailable

JBTOHD - There is no abstract
file on the jukebox. The abstract
pointer in VistA is not set.

None

JUKEBOX: queue pointer
~Mile_extension
Not copied

JUKEBOX - Alternate file
extension (i.e. . TXT) was
not copied

Check file permissions

Login Message”Pausing 3
minutes and will then retry

AUTOLOGIN - could not relog
into the Broker

Check for network connectivity.

Login Message”Silent Login
attempt failed!

AUTOLOGIN - could not relog
into the Broker

Check for network connectivity.

Make AbstractError / abs is
already present

ABSTRACT- file already exists
at the Tier 1 location specified
in VistA

None

Make AbstractError / filename

MAKEABS- the
Mag_MakeAbs.exe could not
create the abstract file

Follow your local, VISN, or
regional procedures for problem
resolution/escalation

NetConError Using User
credentials WIN32_ Error

GCC - Could not logon to the
remote location with the
Username/Password in VistA

Correct the Username/Password
for the
GCC location in VistA

NetConError, There is no
password associated with this
Network Location: share name

GCC - The password field is
empty for this Network Location

Enter a password for this GCC
location

No Image file entry was created!

IMPORT - an IEN was not
created in the image file

Resend image from import source
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Message

Explanation

Action

No Jukebox sourcefile available
/ Attempting Abstract Queue

JBTOHD - There is no abstract
file on the jukebox. The abstract
pointer in VistA is set. The
Queue Processor will attempt to
make on from the Full or BIG
file.

None

No Tracking ID IMPORT failed

IMPORT - unique Tracking ID
parameter is missing from
IMPORT

Resend image from import source.

Use the Queue Manager to check
the Import queue Properties for
failed IMPORTS.

Problem renaming log file:
filename

Could not rename log file to a
versioned copy

Check permissions on the existing
folder/files

queue_pointer "Size Mismatch

File sizes on source and

Determine if images are for

queue_type copy not destination don’t match. File not | different patients
overwritten. copied.
SetFileTime Failed Could not set Access date on the | None

log file.

The BP Queue executed a
scheduled RAID Group Advance

The Queue Processor performed
a the scheduled RAID Group
Advance to the next group with
adequate free space per the site
parameter configuration

Verify that the tape backup
schedule are synchronized with
this Tier 1 write location update

The BP Queue executed an
automatic RAID Group Advance

The Queue Processor performed
an automatic RAID Group to the
next group with adequate free
space per the site parameter
watermark configuration

Verify that the tape backup
schedule are synchronized with
this Tier 1 write location update

The jukebox copy: filename does
not exist -- attempting a copy...

DELETE -Could not find the file
on jukebox shares. Try to copy

from Tier 1 shares to jukebox

None

The RAID share is not on-line

IMPORT - The Tier 1 share is
not available

Check the permissions on the
image share indicated

The src_filename to
dest filename copy failed.

EXPORT - file could not be
copied

Check for network connectivity.
Check permissions.

The VistA cache file: filename
not found

DELETE -Could not find the file
on Tier 1share to delete

None

This Server is not yet
configured!

A BP Server has not been
associated with this server.

Create a BP Server for this
processor
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Message

Explanation

Action

Unable to copy to the Jukebox:
Not enough write cache
available

JUKEBOX - The Tier 2 share
is not available or is full

Add new platters to the jukebox.
Determine why the Tier 2share is
full. Possibly add new platters to
the jukebox.

Zero size queue_type copy NOT
overwritten

Zero size file on the destination
could not be overwritten

Remove zero size file

No Connection to VISTA

The VistA Access and Verify
codes of the user or service
account are invalid.

Update the Access and Verify
codes on the BP Site parameter
window.

8.3.1

146

8.3 Verifier
Start/Run
Message Explanation Action
About to exit without There are no IEN records within | Choose another IEN range
processing: 0 the range.
Broker Connection to server VistA RPC Broker is not Close the application and restart.

could not be established!

currently in a listening state OR
the application has timed out.

Check with the VistA system
manager for the status of the
Broker listener.

CC:createcontext
("MAG WINDOWS") could not
be established!

The user does not have All
MAG* RPC's [MAG
WINDOWS] menu option
assigned.

Assign the user this menu option.

IbCacheShare.items.Count < 1:
MAGQ SHARES

There are no online, non-router
VMC shares.

Use the Queue Processor’s
Network Location Manager to
check/add the shares.

Invalid Input Range

The From and To values entered
in the Range are not correct (e.g.
Start: 0 End: 0).

Enter a valid From and To range.

jukebox shares are not setup

The Tier 2 share(s) are offline or
don’t exist in the NETWORK
LOCATION file (#2005.2).

Create/Edit the Tier 2 shares in the
Network Location Manager on the
Queue Processor.

This workstation is not currently
setup as a Background
Processor.

There is no BP Server set up for
this machine.

Use the option BP Servers on the
Queue Processor to register this
server.

Verifier client software is
version nnn. VistA Imaging Host
software is version mmm. Please
update to compatible client and
host software. Shutting down
Verifier...

The version of the KIDS file
installed on VistA does not
match the executable version on
the workstation.

Install the latest KIDS and client
software.
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Message

Explanation

Action

VistA shares are not setup

The image share(s) are offline or
don’t exist in the NETWORK

Create/Edit the shares in the
Network Location Manager on the

LOCATION file (#2005.2). Queue Processor.
8.3.2 Output HTML Messages
Message Explanation Action
Aggregate JB Copy Error: Could not copy from alternate Check permissions
Tier 2 to the current Tier 2 Write
location.
Abs to JB: Abstract has been created and None
copied to the jukebox
Aggregate Function - Enabled Software is enabled to copy files | None

from secondary jukebox, if
necessary

BIG Aggregate Failed

Could not copy BIG file from
secondary jukebox

Check file existence/permissions

Create Process failed

Could not create process on
VistA for Verifier

Check Error Trap

Empty FBIG node

"FBIG" node has no pointers set
in IMAGE file (#2005) record.

Check shares for existence of BIG
file. If not found, restore BIG file
from backup tapes.

File of size zero created then

Abstract file created of size zero.

None

secondary Tier 2.

deleted Then it is deleted.
(Likely corruption of BIG and/or
TGA file)

FULL Aggregate Failed Could not copy FULL file from | Check file existence/permissions
secondary Tier 2.

FULL Aggregate Failed Could not copy FULL file from | Check file existence/permissions

Images JB share is OFF-LINE:

Tier 2 is offline

Set Tier 2 back ONLINE

Make AbstractError

Abstract file could not be created
from TGA/BIG

(BIG/TGA not found or image
file corruption).

Check shares for existence of
BIG/TGA file. If not found, restore
BIG/TGA file from backup tapes.

Image share

New Abs to CWL An abstract file has been created | None
and copied to the current write
image share

No ABS file VC Ptr Cleared Abstract file not found on the None

No ABS file VC Share OFF-
Line

Image share is offline at location
of abstract file

Set share back online and re-run
Verifier

No ABS JB Files

No abstract file found on Tier 2

Check shares for existence of ABS
file. If not found, restore ABS file
from backup tapes
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Message

Explanation

Action

No Acquisition Site in Image file

The ACQUISITION SITE field
#100 in the IMAGE file (#2005)
is missing. This is a required
field.

Contact IRM
Update the field with the proper
site ID.

No FULL JB Files

FULL file not found on the Tier
2

Check shares for existence of Full
file. If not found, restore Full file
from backup tapes

No FULL VC Files FULL file not found on the Tier | None
1 share
No jukebox BIG Files BIG file not found on the Tier 2 | Check shares for existence of BIG
file. If not found, restore BIG file
from backup tapes.
No jukebox FULL Files FULL file not found on the Tier | Check shares for existence of Full

2

file. If not found, restore Full file
from backup tapes.

No Network References

No IMAGE file (#2005) record
exists for this image

Re-import image thru the Capture
client

No Network References: Image has been archived, resides | None
Archived Image in the IMAGE AUDIT file
(#2005.1)
No VC BIG Files Could not find the BIG file on None
the Tier 1 share
Not Certed Could not find/create file type on | Check shares for existence of BIG

Tier 2

file. If not found, restore BIG file
from backup tapes.

Problem rename log file:

Permission problem with log file

Set WRITE permissions set on
share/folder/file for Windows login
account.

Text file Patient ID not in VistA | Could not locate patient ID in Contact IRM
VistA

TXT to BIG VC Copy TXT file to same share as | None
BIG file

TXT to FULL VC Copy TXT file to same share as | None

FULL file

"Check Text" Option Messages

Text File Corruption Error Type
1:

Text file is binary or unreadable

Restore file from Tier 2/backup
tapes

Cannot determine Text file type:

Foreign text file was not likely
generated on the image gateway

Restore file from Tier 2/backup
tapes

Text File Corruption Error Type
2:

Text file is ASCII but has
unprintable characters or
truncated

Restore file from Tier 2/backup
tapes

Text/Image DFN Mismatch:

Patient ID in text file does not
match that in VistA

Future utility patch

Text/Image SOP/UID Mismatch

The Series Instance UID in the
text file does not match the one
in VistA

Future utility patch

Text/Image Study/UID
Mismatch

The Study Instance UID in the
text file does not match the one
in VistA

Future utility patch
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Message

Explanation

Action

Text/Image UID Mismatch

SOP and/or Study UID are/is
blank in text file

Future utility patch

Updated Text file

Text file has been edited

Validate file has been copied to
Tier 2

No SSN Found

Patient ID field missing in text
file

Future utility patch

8.3.3

Integrity Messages on Patient Data

There are integrity issues that will prevent their respective images from being displayed and
others that will not impact the viewing. See Appendix C for sample output.

8.3.3.1

An integrity error message will be generated when the image is retrieved for viewing on these

Conditions Preventing Viewing

conditions and the patient image will not be viewable until the condition is corrected or the user
has the proper key to view these images.

Message

Explanation

Action

No Image Ptr in AP

The Clinical Association Report
(AP) for this image does not
contain an image entry that
points back to this image.

Future utility patch

GP has no images

Image series that does not
contain any images. Group
Parents (GP) are containers for
an Image series. A group parent
with NO group objects (GO) is
an invalid condition.

Future utility patch

Conflicting AP & Image DFNs

The patient file reference (DFN)
in the Clinical Association
Report (AP) does not match the
DFN in the IMAGE file (#2005).

Future utility patch

Invalid Image Ptr to AP

The Clinical Association Report
(AP) has image references that
are not in the IMAGE file
(#2005).

Future utility patch

Conflicting GP and GO DFN

The patient file reference (DFN)
in the Group Parent (GP) is not
the same as the DFN in the
Image entry.

Future utility patch

GP & GO AP Mismatch

The Group Parent and Group
Object pointer references to a
Clinical Association Report (AP)
do not match.

Future utility patch
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Message Explanation Action

GP Missing GO Ptr The Group Object multiple of Future utility patch
the referenced Group Parent
does not reference this group
object.

No AP Mult Ptr This Image entry does not have Future utility patch
the clinical application (AP)
image multiple entry number
specified. The IMAGE file
(#2005).record is missing the
PARENT DATA FILE IMAGE
POINTER (#17) for a Clinical
Association Report (AP).

GO DFN mismatches Some image file Group Objects | Future utility patch
have different PATIENT
references (DFN).

Image entry is structurally The normal structure that Future utility patch
abnormal distinguishes Image entry Group
Parents (GP), Group Objects
(GO), and Non-Group image
(NQG) is corrupt.

Missing Group Objects The Group Parent has Group Future utility patch
Object references that are
missing.

DFN Mismatches in AP Image The Clinical Association Report | Future utility patch
Mult (AP) references a Group Parent
that has image files with a
different PATIENT reference
(DFN) than the report.

8.3.3.2 Conditions Allowing Viewing

The following integrity issues will not prevent their respective images from being displayed.
These are informational messages.

Message Explanation Action

No AP Ptr The IMAGE file (#2005) record | Future utility patch
is missing the PARENT DATA
FILE# (#16) for a Clinical
Association Report (AP). This
Image does not have the entry in
the clinical application (AP)
specified.
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Message Explanation Action
No AP entry Ptr This Image does not have the Future utility patch
entry in the clinical application
(AP) specified. The IMAGE file
(#2005) record is missing the
PARENT GLOBAL ROOT DO
(#17) for a Clinical Association
Report (AP).
8.4 Purge
Message Explanation Action
; Check network.
Broker Reconnection failed Apto login afFer a Broker
disconnect failed Contact IRM

Create Process failed
ProgramName,

Windows failed to create a
process.

Reboot the server.

Express Purge Rate limit
reached: PurgeRate on share:
CurrentShare

The purge terminated on the
given share because Express
Purge was active and the Purge
process exceeded the user
defined purge rate.

None

File Delete failure: filename

The file listed could not be
deleted.

Check permissions on the
share/folder/file

File in use: filename

The log file is in use

Exit from the Purge and restart

File purged: filename. 'The
Image file (#2005) was not
updated'

The file was deleted on Tier 1,
but the pointer in VistA could
not be updated.

Validate the IEN record exists in
VistA.

Findfirst failed filename

The directory traversal failed

Exit from the Purge and restart

Log File Archival reset to:

The logs files are now being

September 2018

FilePath? instead of: FilePathl stored at another location. None
Login MessageBroker Afte'r a Broker disconnect, the
. application was able to None
Reconnection Successful .
reconnect to VistA.
Login Message"Pausing 3 Afte'r 2 Broqu dlscgnnect, the
. . application tries 3 times to None
minutes and will then retry .
reconnect to VistA
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Message

Explanation

Action

Login Message”Silent Login
attempt failed!

After a Broker disconnect, the
application was not able to
reconnect to VistA.

Check network connections.

NewCreationDate”SetFileTime
Failed filename

Could not set the date of last
Access on filename

None

Non-Connection related Broker
error

Broker disconnected

Check VistA for error trap

NOT Purged criteria:
EvalCriteria NOT PURGED-
JUKEBOX QUEUED filename
date

File was not deleted. See Section
6.4 Purge Criteria.

None

Problem renaming log file
filenamel -> filename?2

Could not rename log file to
versioned log file name

Check permissions.

Purge Criteria: EvalCriteria

filename filedate See Section 6.4 Purge Criteria None
Purge Criteria: EvalCriteria File was deleted. See Section 6.4 None
NOT PURGED filename filedate | Purge Criteria

Silent Login attempt Broker was disconnected. Auto None

login is initiated.

Start Date failure

Problem with Date of Last Purge
on Scheduled Purge

Contact IRM to clear the record in
the Imaging Site Parameter file
(#2006.1).

8.5 Import API

The Import API OCX (IAPI OCX) traps System Error Codes in all of the Windows function
calls that are made during Import processing. When an Error occurs, the Error Code and Error
Description are listed in the Result Array that is returned by the Import API.

Descriptions of the error codes are returned using the Windows function: GetLastError.

Note: The System Error Codes are very broad. Each one can occur in one of many hundreds of
locations in the system. Consequently the descriptions of these codes cannot be very specific.
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Use of these codes requires some amount of investigation and analysis. Make note of the run-
time context in which these errors occur.

Along with the System Error code and description, the values of other IAPI parameters will also
be listed in the Result Array when an error occurs. The other values will help determine the exact
cause of the error.

Not all of the values listed below will be returned in the Result Array. Depending on the type of
error, some values will be listed while others may or may not exist at the point in the process
when the error occurred.

An example of this is the Access Verify codes. These values will be listed if an error occurs
during login to the dabatase only.

Other values include:
e Import Queue number
e Image Share File Path
e Password
e Tracking ID
e Server\Share Name
e Access Code
e File to Import Full Patch
e Username
e Verify Code
Example
The following is an example of returned Error array

(0): O~<description of error> <<< see below for list of most common errors.

(1): MAG135;20130122 12:31:21-43 << Tracking ID

(2): 21 << Import Queue Number

(3): ------ Image Security for Filename: \\vhaiswclu4\User1$\TestImages\CardioMR.jpg

(4): --—--- ParseServerShare: Input= \\vhaiswclu4\User1$\TestImages\CardioMR .jpg

(5): ------ ExtractFilePath : \\vhaiswclu4\User1$\TestImages\

(6): --—--- Result \\Server\Share: \\vhaiswclu4\User1$

(7): ------ Confirming UserName and Password...

(8): --—--- Username: vhamaster\vhaiswIU Password Accessl.

9): ------ OSConnectToServer Start : 1/22/2013 12:32:35 PM
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(10): -—---- GetLastError: 1219 - Multiple connections to a server or shared resource by the
same user, using more than one user name, are not allowed. Disconnect all previous connections
to the server or shared resource and try again

(11): =-—--- Credential conflict, continuing as current User...
(12): -—---- OSConnectToServer Success: 1/22/2013 12:32:35 PM
(13): --—--- Success: Image Directory is accessible. \\vhaiswclu4\User1$

(14): Error copying \\vhaiswclu4\User1$\TestImages\CardioMR .jpg
to Server : 30168~\\isw-kirin-It\image 1 $\GFB0\00\00\03\01\~GFB00000030168.JPG
(15): :File doesn't exist : \\vhaiswclu4\User1$\TestImages\CardioMR .jpg
(16): 1~VistA Image Entry deleted: 30168
(17): 1~Status Callback was called

The most common types of errors that will occur in the IAPI OCX are network connection errors
and network read/write errors.

The exact errors that may occur at a site are unknown, but the most probable are listed below:

2 : The system cannot find the file specified

3 : The system cannot find the path specified

4 : The system cannot open the file

5 : Access is denied

8 : Not enough storage is available to process this command
12 : The access code is invalid

14 : Not enough storage is available to complete this operation
15 : The system cannot find the drive specified

19 : The media is write protected

20 : The system cannot find the device specified

21 : The device is not ready

25 : The drive cannot locate a specific area or track on the disk
26 : The specified disk or diskette cannot be accessed

29 : The system cannot write to the specified device

30 : The system cannot read from the specified device

31 : A device attached to the system is not functioning

32 : The process cannot access the file because it is being used by another process

33 : The process cannot access the file because another process has locked a portion of the file
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36 : Too many files opened for sharing
39 : The disk is full

51 : Windows cannot find the network path. Verify that the network path is correct and the
destination computer is not busy or turned off. If Windows still cannot find the network path,
contact your network administrator

52 : You were not connected because a duplicate name exists on the network. Go to System in
Control Panel to change the computer name and try again

53 : The network path was not found

54 : The network is busy

57 : A network adapter hardware error occurred

59 : An unexpected network error occurred

64 : The specified network name is no longer available

65 : Network access is denied

67 : The network name cannot be found

70 : The remote server has been paused or is in the process of being started

71 : No more connections can be made to this remote computer at this time because there are
already as many connections as the computer can accept

80 : The file exists

82 : The directory or file cannot be created

86 : The specified network password is not correct
88 : A write fault occurred on the network

89 : The system cannot start another process at this time Import API : System Error Codes

This page intentionally left blank.
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Chapter 9 Abstract/Thumbnail Maker

* Application Description
* Setup

* Process Flow

* Logging

9.1 Application Description

The thumbnail maker (MagThumbnailMaker.exe) is the BP utility application that creates
thumbnail/abstracts on the BP workstation. The thumbnail maker and another utility application,
mag_makeabs.exe, work together to create thumbnails. The thumbnail maker uses Accusoft
ImageGear controls to create thumbnails. These are the same components used by VistA Imaging
Capture to create thumbnails.

9.2 Setup

MagThumbnailMaker.exe is installed into the ...\VistA\Imaging\Backproc directory when the
patch is installed. No other setup is needed.

The thumbnail maker can be started on its own but this is not necessary. The thumbnail maker will
be started by the BP, as needed. Windows messages from mag makeabs tell the utility which
thumbnail to create.

When it is run, it will display as shown below. The BP user can decide to leave the thumbnail
maker displayed, or it can be minimized to the taskbar. The size and position of the panels in the
main window can be changed and the thumbnail maker can be minimized. The size, position and
minimized state are saved, and will be maintained each time it is started. The last created abstract
will be displayed in the image box. A list of the current abstracts it has created is maintained in the
memo area.

A sample page of the new MagThumbnailMaker.exe is shown in the figure below:
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Y05 Imaging Thumbe e

Eile Opticns  Help

3.0.214.1
Processing Image : II

waiting....

Last Image :
WWACOLTKIRINGA.DVA. VA, GOVIIMAGE 18\GKOOY00Y00Y03 24\GKO00000032423. PG

Status: 0-5uccess

Start ime 7218 11:47:22 AM # Successful IB # Failed IU

Metwork Share:  \WACOLTKIRINGA.DVA.VA. GOViIMAGE 181GKD0\D0\00\0 3124,

Abstract: GKO00000032423. ABS 0~5uccess

—File: GKO00000032423.JPG 36KB  24Bit IPG 138w 134h Cmp: JPEG [Fmt:21 - Cmp:6]
Abstract: GKO00000032422, ABS 0"Success

—File: GKOOOODO0032422,0PG 23KE  24EBit JPG 128w 127h Cmp: JPEG [Fmt:21 - Cmp:€]
Abstract: GKOO0000032421.ABS 0~5uccess

—File: GKO00000032421.TIF 27KB  1Bit TIF 1700w 2202h Cmp: CCITT_G4 [Fmt:40 - Cmp:4]
Abstract: GK000000032419, ABS 0~Success

—File: GKOOOD00032419.PDF 40KE 246t PDF 612w 792h Cmp: NOME [Fmt:56 - Cmp:d]

Abstract: GKOO0000032413,ABS 0~5uccess
—File: GKOOOOD00032418,JPG 271KE 8Bt EXIF_IPEG 1700w 2202h Cmp: JFEG [Fmt:71 - Cmp:g]

9.2.1 Menu
File Closes the application.
Exit.
Options
Clear memo The memo area of the display will be cleared.
Create Log A log file will be created for all activity.
Open Explorer window to the log directory:
C:\program files
(x86)\vista\imaging\backproc\log\utility
Help Displays the About Box for the application.
About
Versions... Clicking “Versions...” will display a message
window that contains the versions and
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application date times of all BP and BP Utility
applications.

An exmaple of the Help | Versions... path is given below:

P ™

Vist& Imaging - Background Processor (BP)
and BP Utility Versions:

BP Queue Processor

C:\Program Files (x86)\wvista\imaging\backprocimagbtm.exe
6030 KB 06/28/18 10:26 am

30.53.2141

Mag Verifier

C:hProgram Files (x86)\wista\imaging\backprocimagVerifier.exe
4450 KB 06/27/18 911 am

30.53.2141

Mag Purge

C:\Program Files (x86)\wista\imaging\backproc\magPurge.exe
4550 KB 06/27/18 9:18 am

30.53.2141

Thumbnail/&bstract utility

C\Program Files (x86)\wista\imaging\backprociMagThumbnailmaker.exe
2609 KB 06/27/18 10:23 am

30.53.2141

Abstract utility

C:\Program Files (x86)\wista\imaging\backprochmag_makeabs.exe
A20KB 06/27/18 10:12 am

30.53.2141

Vist& Imaging Import API

C\Program Files (x86)\wista\imaging\lib\magimportxcontroll.ocx
5421 KB 06/27/18 9:37 am

30.53.2141

9.3 Process Flow

The process starts when the BP Queue Processor processes an Abstract queue.

BP Queue Processor
- Executes the mag MakeAbs.exe program and sends the full path to the Image file and the

name of the abstract file as command line parameters.
- Waits for the mag_makeabs process to terminate.

mag_MakeAbs.exe:
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- Sends windows message to MagThumbnailMaker.exe
- Message contains reference to Full Image file, and name of thumbnail to create.

MagThunbnailMaker.exe
- Creates the thumbnail from the Image file.

- Writes status of the operation to MagAbsError.txt file.
- Sends windows message to mag MakeAbs.exe

mag MakeAbs.exe
- Receives windows message

- Terminates

BP Queue Processor
- Gets notification that mag_makeabs has terminated.

- Reads the status of the abstract creation from MagAbsError.txt file

far each Ahstract:

- mag_makeahs is executed

- sends msg ta ThumbnailMaker

- waits for msg from ThumbnailMaker
- mag_makeahs terminates.

- Thumbnailmaker creates thumbnail
- saves thumbnail to storage
- sends msg to mag_makeabs

BF mag_makeAbs exe IagThumbnailllaker exe

> > —>
L Storage
magabserror txt o

\-.3 /"H

9.4 Logging

When the application is installed, logging is turned off. The logging mechanism of
MagThumbmailMaker.exe is intended to be used when issues arise with the creation of
thumbnails/abstracts.

The log messages produced from these two BP utility applications are:

e the date and time of the abstract request
e the success or failure
e the time the process ended

The main window of the application will display the last five Thumbnail attempts. If an error
occurs, details of the error message are always saved to the Log File. To record all history of
successful and failed abstracts, check the menu options ‘Create Log File’. To see the log, click
the menu option: Options >Open Log directory. The Log file is named ‘MagThumbLog.log’
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ﬁ;f: Imaging Thumbnail Mak

|| File | Options | Help

Clear messages

Create Log File

Open Log directory...

Also on the main window, the total number of successful and failed abstracts is
displayed. The numbers include all abstract attempts since the Start Time of the
MagThumbnailMaker application. The current TIER1 Share is also displayed.

- - Bl
"':_li:: Imaging Thumbnail Maker =

Eile Opticns Help

3.0.214.1

Processing Image :

waiting....

Last Image :
WWACOLTKIRINGA.DVA. VA.GOV\IMAGE 18\GKO0Y00\00Y0 3\ 24\ GE

Status: 0-"Success

Start ime  7/2/18 11:47:22 AM # Successful |2 #Failed |0

Metwork Share:  \\WACOLTKIRINGA.DVA.VA.GOVIIMAGE 1£\GK00Y00100Y03\24)

9.4.1 Log Files

Below is an example log for one successful abstract:

05 14:42:21 - mma- Message sent: MAKETHUMBNAIL"7867678"<Full FileName> "
<Abstract FileName>

05 14:42:21 - 03/05/15 14:42:21 DXP00000034156.ABS  Success
05 14:42:21 - mma- Recieved message: THUMBNAILDONE"<Abstract FileName>
05 14:42:21 - mma- Terminating

Note: “mma” is a code that means this message was logged from the mag MakeAbs utility.
Messages without “mma” were logged from the MagThumbnailMaker utility.

Logging is turned on or off by changing the DebugON setting in the MagThumbnailMaker.ini file.
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Below is an example from MagThumbnailMaker.ini:

[SETTINGS]
DEBUGON=TRUE
LogFileSizeKB=300

Set DebugON=TRUE to turn on logging.

The application handles maintenance of log files by deleting older log files. Magl.ogThumb*.log
files that are older than 24 hours are deleted.

9.4.1.1 Log File Format
MagLogThumb.log is the name of the current log file. When this file size is greater than

LogFileSizeKB, it will be saved as a time stamped file. MagLogThumb is then cleared and reused.
MagLogThumb.log is always the current log file.

Format: MagLogThumb yymmdd hhmmss.log

Address |20 CiiProgram Files)vistalImagingtBackProchlogiutilicy

Folders X Mame Size  Type
= |C5) Imaging S E%j MagLogThurb.log 2KB Text Docume
= [5) BackPrac ) MagLogThumb150407_111919.lag 276G KB Text Docume
# 5 Help EE_] MagLogThumb150406_131630.l0g Z7GKE  Text Docume
=l 1) log
() BackProc
[ ukility
9.5 Error Messages

The Imaging Thumbnail Maker examines the image file first. If the file is valid, image properties
will be displayed. If the file is invalid, a detailed message will be displayed and the abstract will
not be attempted. The detailed message will be returned to the BP giving support personnel a
detailed reason why the abstract failed.

Imaging Thumbnail Maker

Example of successful abstract creation:

Image Properties and the status of abstract creation are displayed.
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File: DXPOD0OO042564.FDF 40 KB 24Bit POF 612w 792h Cmp: MOME [Fmt:56 - Crpe0]
09/24/15 03:42:12 Abstract: DXPOOOO0042554, ABS 0Success

Example failed abstract creation:

File access error message is displayed. Abstract not attempted.

File: D¥POOO00042565.PDF 1 File access error: Exception: Invalid floating point operation
09/24/15 05:42:13 Abstract: Mot attempted.

File: D¥POOO00042567,. PG 1-File access error: Exception: Could not detect the format of this file
09/24/15 03:42:15 Abstract: Mot attempted.

BP Failed Abstract Queue:

7 SALT LAKE CITY - Queue Management: ABSTRACT
Imaging Site Farameters | Mail Messages | Mail Groups | Purge /Verifier/ RG Settings | BF Servers | | Queue Manager

-5 ABSTRACT
=44 Failed: 3
= Make AbstractError File acces - 3
Q 14726 ABSTRACT _...... Make AbstractError File access error Exception Desired operation cannot be peformed on this object 42562
& 14739 ABSTRACT ... Make AbstractError File access error Exception Desired operation cannat be performed on this object 42565
<3 14740 ABSTRACT ... Make AbstractError File access error Exception Could not detectthe farmat of this file 42567 2
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Chapter 10 Import OCX

* Application Description
* Setup

* Process Flow

* Logging

* Log File Management

* Log File Format

10.1 Application Description

The VistA Imaging Import API is an application developed to enable other VA and Non-VA
applications to import documents and images into VistA Imaging without user interaction. The
scope of that functionality is beyond the needs of this manual. The details of developing
applications  to  interact with the Import APl are contained in  the
VistA Imaging System_ Import API

Programmer Guide.

This section will detail the interaction between the BP and one of the Import API components:
the Import OCX.

Import OCX is an Active X component that is called by the BP to import Images into VistA
Imaging. The BP calls the ImportQueue function of the OCX, passing the Import Queue number
as a parameter. The BP will then wait for the OCX to process the import and return a result array.
Details of the returned array are described in the troubleshooting section, 8.5 Import API.

10.2 Setup

MagImportXControll.ocx is installed into the ...\VistA\Imaging\lib directory when the patch is
installed. During install, the OCX is automatically registered using operating system (OS) Active
X registration functions. For Win OS, this is the regsvr32.exe registration utility. No manual setup
1s needed.

10.3 Process Flow
BP — Import OCX interaction

BP Queue Processor

- Calls the ImportQueue function of the Import OCX
- Waits for the return array

Import OCX

- Processes the Import Queue. Copies the imported image to the Image Network Tier2 storage
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defined for the site.
- Returns a result array with success or failure of the process.

BP Queue Processor

- Uprates the status of the Import Queue in VistA Database
- If Import failed, the Import is re-queued up to three times.

All image copies are processed in a secondary thread. The main thread of the OCX maintains
active communication to VistA while the secondary thread is processing the copy. This enables
the connection to VistA to remain active even when the time it takes to copy an image is longer
than the Kernel Broker connection timeout.

If the Kernel Broker connection to Vista is broken, the Import OCX silently re-connects to VistA.

If an import fails, the Import OCX returns a descriptive error message to the Background
Processor. Imaging personnel can see why the import failed, and can take actions on all imports
that failed for the same reason, at the same time. An example is given in the figure below:

Four imports were processed and failed. 7 SALT LAKE CITY - Queue Management: IMPOR
The error messages returned to the BP Imaging Site Parameters | Mail Messages | Mz
describes the cause of the error: S MPORT
) . -4 Failed: 4
FATAL Falled to connect. No + Q FATALFailed to connect Mo ne : 2
Network +-4¢ File Size Zera: 1
_ File Size Zero * <3 File doasnt exist: 1
. , . < Active: 0
- File doesn’t Exist

10.4 Logging

When the Import OCX is installed, logging is turned off. The logging mechanism of the Import
OCX is intended to be used when import queues are failing.

The log messages produced from the import OCX include detailed history of all internal function
calls of the OCX.

10.4.1 Log Files

Messages from the Import OCX have always been saved to the IMAGING WINDOWS SESSION
File (#2006.82). Messages are saved after the process is finished.
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10.4.1.1 Debug Modes

There are two debug modes that can be used by site personnel to debug failed imports.

A) DebugON: This debug mode creates more detailed messages from the entire Import Process.
Messages are saved to the IMAGING WINDOWS SESSION file (#2006.82); the detailed
information will enable support personnel to determine the cause of the issue.

B) DebugToLogFileON: This second debug mode saves debug messages to a log file on the BP
local drive. Messages are saved to the log file as the process is running. If the application
crashes or hangs, support personnel will be able to view the message history up to the time

of the crash.

10.4.1.2 Registry Entries to Control Debugging

The default registry entries are created by the application. The registry path is:
HKEY CURRENT USER\software\vista\imaging\importOCX\debugoptions

The user can modify the registry entries to turn debugging on or off.

Key Default Value Description
DebugON FALSE If TRUE, then detailed log messages will be
saved to IMAGING WINDOWS SESSION File
in addition to normal messages.
DebugToLogFile | FALSE If TRUE, then detailed log messages will be
ON saved to the log file in real time.
LastDebugRunTi | <empty> This is managed by the application. This is the
me date time when DebugON was set to TRUE.
After 24 hours DebugON will be set to FALSE,
and detailed logging to the IMAGING
WINDOWS SESSION file is stopped.
LogFileDirectory | ....\vista\imaging\back | This is set by application. Its purpose is purely
proc\log\utility informative so that users can know where the log
files are created.
LogFileSizeKB 300 Size of log file to be created. If the current log file
is greater than this value, the new log file is
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started with date time stamp of “Now”. For
example: MagOCX 150305 143158.log

10.4.1.3 Debug Off

After 24 hours, DebugON will be set to FALSE and detailed log messages will no longer be
saved to an IMAGING WINDOWS SESSION file.

10.5 Log File ManagementLog files are stored in the: \VistA\Imaging\backproc\log\utility
folder.

The Import OCX manages the log files. When a file reaches the size limit, a new log file is created.
Log files older than 24 hours are deleted from the folder. To store log files for future review, they
will have to be moved to a different folder.

10.6 Log File Format

MagOCX_*.log is the format for Import OCX log files. The log file with the most current date/time
is the active log file. When this file size is greater than LogFileSizeKB, a new log file is created
with the current date/time in the following format: MagOCX yymmdd hhmmss.log. Files are
stored in the \log\utility subdirectory of the Application Directory.

For an example, see the following figure:

Address (L2 C:\Program Files\vist&'Imaging|BackProclogiutilicy

Folders X MName Size  Type
= [ Imaging A E] MagQC¥_150407_112941.log SEE  Text Docurnent
= [ BackProc Ej Magioy_150407_112312.log SO0KE  Text Document
# 5 Help E] MagQC¥_150407_111549.log 258 KB Text Document
= i log Ej Magioy_150407_111049.log 162 KB Texk Document
) BackProc
L ukiliby -
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Appendix A: Broker Server Configuration

The BP communicates with the VistA database by using the VistA RPC Broker. The following
steps briefly explain the installation of the RPC Broker Client Agent software. For more detailed
information, see the RPC Broker Installation Manual.

1. Log in to the workstation as an administrator, start the Registry editor (Start > Run >
Regedit) and navigate to
For 64 bit OS:
HKEY LOCAL_ MACHINE\SOFTWARE\Wow6432Node\Vista\Broker\Servers
2. Create a new string value (Edit > New > String Value) and use the remote server name
and port number as the name of the value.
Note: Separate the name and the port number with a comma.
64 bit OS
¥ Registry Editor G Emdeiteld & ¢+ G D e =S .
Eile Edit View Favorites Help
McAfee “ || Name Type Data
Microsoft ab)(Default) REG_SZ (value not
g m:;;::i”a” 26)VISTAIMMISC.MED.VAGOV,19284 REG_SZ
>~ | MozillaPlugins
D - Network Associates
Nevrona Designs
ODBC
Policies
Rational Software
RegisteredApplications
Remedy
Seagate Software
Shortcuts
p - SilverStream Software Inc.
D - SourceCodeControlProvider
VAVAL
4 Vista
4 Broker
Servers
VMware, Inc.
Windows =
WRQReflection
3 ZANTAZ
SYSTEM = = .
Compx;ter\:?:;’iggilMA(HINE\SOFTWARE\Waw643ZNGde\\/lsia\Bmker\Servers
3. Close the Registry Editor.
4. If the server name is not resolved through DNS, open the HOSTS file (located in either
WINNT\system32\drivers\etc. or WINDOW S S\system32\drivers'etc.).
5. Add a line to the file that includes the IP address and name of the remote site’s Broker
server.
September 2018 Background Processor User Manual, Rev 17

VistA Imaging MAG*3.0*214

167



#HOSTS

10.2.1.1 Washington
10.2.1.2 Baltimore
#END

6. Save and close the HOSTS file.

7. If you set up servers to connect to a server that can be resolved automatically through
domain name server (DNS) (e.g. alpha3.yourva.gov), no entries are needed in the server’s
HOSTS file.

8. Reboot the server and run the Kernel Broker test program.

RPCTest.exe is a test program distributed and installed on your PC in the C:\Program
Files\VISTA\BROKER folder when the Kernel Broker Client Agent software is installed.
When executed, it can be used to test the connection to the VistA System. This is
valuable in troubleshooting problems with the VistA Imaging System. Please review the
Kernel Broker documentation for more information and examples on the test application.
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Appendix B: File Formats

The BP Processor can process the following file formats typically used in the VistA system.

File Extension

Description

ABS

A graphics file used to contain abstract data. The file can normally be
accessed through the VistA Imaging Clinical Display application.

ASC

A text file containing text in ASCII code. The file can normally be
accessed by most text editors on multiple platforms.

AVI

A video file containing compressed data and normally accessed by
Windows-based applications.

BIG

An image file containing full diagnostic resolution data normally accessed
through the VistA Imaging Clinical Display application.

BMP

An image file containing an uncompressed bitmap of the image. The file is
normally accessed through Windows-based applications.

BW

An image file containing an uncompressed or compressed bitmap of the
image. The images can be either monochrome or color and are generated
by Silicon Graphics Inc equipment. The file can normally be accessed
through the VistA Imaging Clinical Display application.

DCM

An image file created using the Digital Imaging and Communications in
Medicine (DICOM) format. These files will normally contain both image
data and metadata about the patient and the image. The file can be accessed
on multiple platforms but can require the use of specialized readers to
separate and properly display the image and the metadata.

DOC

A text file containing data, formatting instructions and possibly some
image data created by Microsoft Word, WordPerfect or WordStar
applications. The file can be accessed by various word processor or text
editor applications on multiple platforms.

HTM or HTML

A text file containing both data and Hyper Text Markup Language
(HTML) which describes the structure of the data. HTML is usually a set
of tags which describe structural information, such as text, paragraph or
document formatting information. The file can be accessed through either
numerous text editors or browser applications on multiple platforms. When
displayed through a browser, the tag information will be used to format the
data in the file.
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File Extension

Description

JPG or JPEG

An image file containing a compressed bitmap of the image. The degree of
compression can be adjusted during file creation and is performed using
algorithms developed by the Joint Photographic Experts Group. This
format is a standard image format that can be accessed by numerous
applications on multiple platforms.

MP3

An audio file containing encoded digital audio data based on the MPEG-1
Audio Layer 3 standard. The files will normally contain lossy compressed
data and is a standard sound format that can be accessed by numerous
applications on multiple platforms.

MP4

A multimedia file containing encoded digital audio and video data based
on the MPEG-4, part 14 standard. The files can be streamed over the
internet and can be accessed by numerous applications on multiple
platforms.

MPG or MPEG

A media file based on one of several encoding methodologies created by
the Moving Pictures Experts Group. Some of the more common
methodologies are:

. MPEG-1, or MP3, used for audio data
. MPEG-2 used for broadcast quality television
. MPEG-4, or MP4, used for video and computer graphics

PAC

An image file used in earlier versions of VistA imaging similar to a TGA
file. The file can normally be accessed through the VistA Imaging Clinical
Display application. PACS files are files imported through the DICOM
Gateway and shown by the Clinical Display workstation.

PDF

A document file containing document text, images, fonts and formatting
information developed by Adobe.. Once the document has been created it
will retain its format and style across multiple applications and platforms.
Numerous applications are available for viewing the file; however a lesser
number of applications are available for creating the file.

RTF

A text file containing text and some formatting information developed by
Microsoft. The file can normally be accessed by most word processors or
text editors on multiple platforms.

TGA

An image file containing uncompressed or lossless compressed raster
graphics data developed by Truevision. The file can be accessed through
several paint applications on multiple platforms.
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File Extension

Description

TIF or TIFF

An image file containing an uncompressed or lossless compressed bitmap
of the image. The degree of compression can be adjusted during file
creation. This format is a standard image format that can be accessed by
numerous applications on multiple platforms.

TXT

A text file containing data and very limited formatting instructions. The
file can be accessed by all text editors and word processors on multiple
platforms. Unless the TXT file is a designated primary or full Image source
file it is necessary for TXT to be in the File Types array on the Image Site
parameters. It will be purged when the Tier 1 folder it is in does not
contain either a full or big file of the same file name.

WAV

An audio file normally containing uncompressed waveform data. The file
is normally used with Windows based audio applications.
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Appendix C: Verifier Integrity Samples

A. Text file is binary or unreadable

1] 1 =% 1 TUOOOOOOO OO0 OO0 OO oo TOOOOOOTOOTD
oooOoDODOODODODODOOODODOOOOOODOOOODODOOOOOOO0O0O00o00naononn

PO g et OO0, —m - A/ 00011122233 3444555 6667 FFEEE0091 11§ carmpnn 7T P@AAAAMBEBCC
cnnnEEEFFFGGGHHHIIIJJJ|<|<|<LLLMMMNNNDDDPPPQQQRRRSSSTWUUUMWWZZ[[[\\\]]]AM_" aaabbbcccdddesef
ffggghhhiiijjjkkk]11nnnmnnooopppqqqrrrssstttuuuvvvmmmmxxyyyzzz{iil[[1}}-~uuu€€€uuu,,,fff“““ waTTHEFE T
WNNEEE < dEEEDODZZZ00000D0F ¢ ¢ P P wma CmmmEEE sy »RREIONZZZYYY | g¢¢{{{nnnm' o EE ENEE 22 g g
gomm———@EET bbby EERE I T 117000 RRKIIA, s ARRAARAR R A AR RAAARE £ ECCCEEEEEEREEEEETTITILE
iiIIIDDDﬁﬁﬁDDDdddﬂﬂﬂﬁﬁﬁDDDxxxmmmUUUUUﬂGGDUUUYYYDDDEEEaaaaaaaaaaaaaaaééé&aagggeeeeeeeeeeee111111111111&&&
AAADOA00ODGDAAEA68-=+aaa i 00iLn00oywwhb by noonoononooooonooonoonnon
ooooooODOoODODODOOOOOO oooooooOoooOOoOOO0OODOO0OOOOOOOOOOOOOOOOOOOna

noonooooonon OO00o0no0nnno0no0nnnn0noononnnnoaononn "#'' s

0oooooooooo o

0ooooooono oooooonoonooon 000000000no0oon
O0000000000D0O0O0OOOO0OO '(&$!4%" OOOOODOOOOOODOOOOOO#O gooooooooooon

gooooooooon oooooooOoooOoOoOOOOOODOOOOn ooooooooOoO&+=' (&% 0000O0O0OOOOOOOD

pooDOooOoDDOO#!'00DOO0OOOD

ooo ooooo0o00000 ODOOOODOODOOOOOODODOCOODODOODOO
0oOO0!"&)+2240000000000000000000000000!000000000000000O0O0O00

ooooooooo oooooooo0O0O0OoO0O0O0OOOOOOoOoOoOoOoOoOoOoOoOn'&,021-(000004000000000000000000000

gooooOoDOODODODOOOOOO oooooooooooonn oo 1]
Text file

B. Text file is ASCII, but has unprintable characters or is truncated.

[FEEGI DRATAT
PATIEMTS_MAME=MAGPATIENT, 12345
PATIEMTS_ID=000-81-8251
PATIEMTS_BIRTH_DATE=1921
PATIEMTS_AGE=S1
PATIEMTS_SEx=h
InAGE_DATE=0AM 0i2001
InAGE_TIME=14:47:40
FEEND DATA1

FEEEGIN DICOM DATA
FSEND DICOM DATA

Text file
C. Patients ID (SSN) field in the text file does not match that in VistA.
o 1EN for this sample is /800

FSBEGIN DATAT
PATIENTS_MNAN NT, 98765
PATIENTS_IG2000 66 6698
PATIENTS_BIRTH_DATESDRG 12,1942
PATIENTS_AGE=58
PATIENTS_SEM=M

Text file

“MAG(2005,1800,0)=MAGPATIENT, 93765\000827312°DM0O01 300D Chtrent
a0

BOA35M0OPHM 794

23=3010820.2245M 26 0OPTHOMOLN
AM=NOTEM 7587
100p=""660

-- NOTE: translation in effect

)=MAGPATIENT,98?65"M"234DDDD1

ATET536 CHIPEWA STREET™*SALT LAKE CITy"49%3240428% 232404

3T

(361)=rennnn3040000°660]

GZ)=nanapnan

"LR"=57

"MPIM=66000000024359491 660
"TYPE")=13

VistA Global
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D. SOP Instance UID field in the text file does not match the one in VistA.

0008,0008]Image Type*CS|4,1|FAG
0008,0016|S0P Class UIDMJI1,11.2.8 St T

0002,0018|S0P Instance UIDAUIMCT[1.2.826.0.1.23680043.2.139.2.310.1.247 259905281 .2@
0008,0020|Study DateDAJ1,1|2002042

0008,0021|Series Date*DA1,1120020423 /

0008,0023(Image Date"DA|1,1]20020423

Text File

7

BAR SPINE WICONT"DMOD1 500 TGA 242634 007 CT" 45840
F41)"3020208.1321°74473

“WAG(2005,1800,00=MAGPATIENT, 2468 000BE5698 CT

Global *MAG{2005,1800 -- MOTE: translation in effect ’\%A
L
2)=3020213.141133CT LUMBAR SPINE WICO

VistA Global

E. Study Instance UID field in the text file does not match the one in VistA.

0020,0010|study IOAMSH|L1,1|576
o0zo,0011 | Series Numherﬁlsll,llzn
00z20,0013 |Instance WumberAIS|1,1(|1
0o0z0,0020|FPatient Orientation™Zs|1,1|R
00z20,0020|Patient OrijentationAZsS|2,1|F
o0zo, 0060 | Laterality 5|1, 1| <unknown:

001ls, 7052 [Filter Thickness MinimumaDs|1,1]|0

001%, 7054 |Filter Thickness Ma<imumADS|1,1]|0

0015, 7060 |Exposure Control ModeAcs|1,1|AUTOMATIC

001%, 7062 |Exposure Control Mode Des ET L T sE__alTI_CEl 15

0020,0000 | Study Instance UIDAUI|L, iiﬁiﬁfgzgil;§?54 1.4.452.6955455.5545.1.51001
00z0,000E|Series Instance UID—"‘\UIll 1]1.2.840, 113619, 2.67. 215 BZ0.48620105810144727.10002.3

Text file

AWAGI2005,1546 D)=MAGPATIENT, 34567 0008277312 ABDOME
“MAG(2005,1546,1,00="2005.04P"2"2
AMAGI2005,1546,1,1,00=1547"20"
AMAGI2005,1546,1,2 0)=1548"21"
AAGI2005,1546,1 "ADCM",20,1,1547 1=
AAGI2005,1546,1 "ADCM" 21 ,1,1548 2)=
AWAGI2005,1546,2)=3020301.1011 58" ABDOMEM 1 VIEW" 3020221 170774477

100)=""g
"PACEN=1.2.840113754.1.4. 452 6989480.8548.1.561001 57677172

1 WIEWy 1 12860MRAD CR

VistA Global (Note the Study Instance UID is found in the parent file.)
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F. SOP and/or Study Instance UID are/is blank in the text file..

000z, 0016 Source Applicartion EAtity TitleAaE|1l,1|DICOM_TEST
0o0s, 0005 | Specific Character SetAIS|1,1|ISO_IR 100
000&, 0008 | Image TypeACsS|1l,1|0RIGIMAL
ooo0s, 0005 | Image TypeACS|2 1|SECDNDﬂRY
0008, 0008 | Image Fegpedes{3+1
, 001 |SOF Class UID—‘\UI|1,1|1 2.840.10008.5.1.4.1.1.1
015|50P Instance UIDAUT|
0008, 002 0 [ SEOTy Trarte- st S0
o00&,0021|Series DatesDA|l,1|z0010510
000&, 0022 [Acquisition DatesbDa|l,1|20010510
ooos, 0023 |Image DateADs|1,1|20010510
0008, 0030 Study TimeATM|1,1|144727.000000

Text file

G. Patients BIRTH DATE in the top section (DATAI) of the text file does not match DICOM-
0010,0030 field in the bottom section (DICOM DATA).

FFEEGIN DATAT
PATIEMTS_MNAME= MAGPATIENT 98765

PATIENTS AGE a1
PATIEMTS_SEX=M
IMAGE_DATE=05M10/2001

RESCALE_INTERCEFT=0
RESCALE_SLOPE=1
$FEMND DATAT

FFBEGIN DICOM DATA
0002,0000|Group Length®JL1 Y202
00o2,0001|File Meta Infarmation\Wersion*OB[1,1]0

00oa,2218|Anatamic Region Sequance™5a||
0010,0010|Patient's Name*PN|1, 1| GPATIENT"12345
0010,0020|Patient IDALO iy 4
0010,0030|Fatient's Bi
0010,0040|Patient's Sex*C5[1,1[M
0010,1010|Patient's AgeAS]1,1]053Y

$SEND DICOM DATA

Text file
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Glossary

Term Definition
AA Acronym for Archive Appliance
Abstract A “thumbnail” version of an image, which requires less computer

processing resources to display than the actual image. Abstract images
typically have an *.abs extension. One of the queues of the BP queue
processor is also called the ABSTRACT queue.

Aggregate To gather together as into a single referenced location. The parent term
“aggregate function” is triggered by any action that causes a portion of an
image set to be copied to the current jukebox location. The aggregate
function ensures that the entire image set is copied to the same location.

Archive Long-term storage of data or images. A jukebox is the most common
archive type presently used at sites.

Archive Appliance A brand of enterprise-level archival storage software.

Auto Write update Process that checks each Image share and designates the share with the

most free space as the current write location. The check for space is done
after 100 Writes to the share or after 20 minutes since the last check,
whichever comes first.

BP Acronym for the Background Processor in the VistA Imaging System.

BPWS Former term for a Background Processor Workstation, now called a
Background Processor Server.

Cache Short name for the arcane term VistA Magnetic Cache or VistA Imaging
Cache, alternative terms for RAID and Tier 1. See Raid. Contrast with
Caché.

Caché Commercial product name of the software used to install and set up the
VistA database. Contrast with Cache.

CBOC Acronym for community based outpatient clinic.

Critical low message | Email to alert key personnel that free space on an Image share has fallen
below the %Server Reserve watermark.

Current Queue Queue type specific database reference to the next file copy, create, or
pointer destroy request.

Current Write Reference to the network share where images and associated files are
location (CWL) stored that are newly acquired or retrieved from Tier 2.

DFN Internal entry number (IEN) of a PATIENT file (#2) entry.

DICOM Acronym for Digital Imaging and Communications in Medicine, a protocol

for sharing and viewing medical images. DICOM has traditionally been
used for radiology images, and recently has been used for images in other
specialties such as cardiology, dental, gastrointestinal endoscopy, and
ophthalmology.
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Term

Definition

Directory hashing

Process of storing files in multiple subdirectories based on the filename, as
follows:

If hashing is used, files are maintained in a 5-level deep subdirectory
structure where no directory will contain more than 100 unique filenames
with their various extensions.

If hashing is not used, files are placed and retrieved from the root directory
of the share.

VistA Imaging recommends using hashing.

EHR Electronic Health Record

File In the VistA database, the equivalent of a database table, as well as a file in
the generic sense.

File types In VistA Imaging:

ABS = Abstract or thumbnail image file

BIG = Large image file that takes up a lot of storage space
FULL = Full size/full resolution image file

TXT = Site-specific installation or setting file

Hash See Directory Hashing.

HIS Acronym for hospital information system, which is a comprehensive,
integrated information system designed to manage a hospital’s
administrative, financial and clinical information related to patient data
(electronic patient records).

IEN Acronym for Internal Entry Number.

IMAGE file File in the VistA database that contains entries of images.

IMAGE AUDIT file

File in the VistA database that keeps a record of any image entries that
were deleted or missing. Also, used by the Verifier to ensure that a file set
exists at the location(s) specified.

Image Set

Includes the FULL/ABS/TXT files and possibly the BIG file.

Imaging server

Server used to store the most recently acquired and accessed image files

Internal Entry

Unique record number for a specific entry in a FileMan file. Depending on

Number the context, IENs can serve as identifiers for an image set, a single site, or
other unique records in files in the VistA database.

IRM Acronym for Information Resources Management, the Imaging support staff
at a VA hospital.

Jukebox Long-term storage device in VistA that holds multiple optical discs or

platters and can load and unload them as needed. Also called Archive, and
with version of the software it is now referred to as Tier 2.

Magnetic cache

Same term as Tier 1. See Tier 1.

Namespace First three characters of the 14-character name given to image files
captured at a site. Each VHA facility has its own unique 3-character
namespace.

Offline VistA Imaging shares designation used to isolate shares from auto-write
candidacy and the purge function.

Online Connected to, served by, or available through a system and especially a

computer or telecommunications system (as the Internet).
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Term

Definition

PACS

Acronym for Picture Archiving and Communication System. If a site has
integrated a commercially available PACS with VistA Imaging, images from
that PACS are treated in a manner similar to images produced by
modalities such as a CT or MR.

Purge

One of the three applications in the Background Processor used to process
the removal of files from Tier 1 shares when the last access date exceeds
the age specification within the local site parameters. The purge process
will not delete a file if it cannot locate a copy of that file on the archive. If
such a file is detected, purge will create a JUKEBOX queue entry for that
file. See also Verifier and Queue Processor.

Queue

A request by the VistA Imaging System to create, move, or delete a clinical
image file for the purpose of system efficiency.

Queue pointer

Database file reference to the next queue to be processed within the queue
file.

Queue Processor

One of the three applications in the Background Processor used to handle
requests by the VistA Imaging System to manage clinical Tier 1 files for the
purpose of system efficiency. Managing the files involves processing
multiple queues (tasks). See also Verifier and Purge.

RAID or RAID
shares

Acronym for Redundant Array of Inexpensive Disks, the primary storage
area for recently acquired and recently accessed clinical images. Also the
term used to identify a specific type of Network Location defined using the
Background Processor Queue Manager.

We are retiring this term in this version of the software.

Referenced network
files

Image Tier 1 pointers to the network locations of each of the file types
stored within the VistA Imaging System.

Routers Specific type of Network Location defined using the Background Processor
Queue Manager.

RPCs Acronym for Remote Procedure Calls.

RPC Broker Short name for the VA Kernel RPC Broker, the Client-Server interface

component. RPC Broker 1.1 is required for interfacing with the hospital
database.

Site Parameters

A set of specifications that is configurable to meet the individual needs of
each VistA Imaging System implementation.

Tier 1 Primary storage shares where Images are first held at capture time and are
available to Display applications; previously referred to as RAID.

Tier 2 Secondary storage, previously referred to as JUKEBOX refers to the
configured secondary storage shares.

UNC Universal Naming Convention indicated by the format
\SERVER\SHARENAME

Verifier One of the three applications in the Background Processor used to validate

the VistA Imaging network file references in the IMAGE file (#2005) and to
consolidate files on Tier 2. See also Purge and Queue Processor.

Veterans Health
Information System
Technology
Architecture

VistA is built on a client-server architecture, which ties together
workstations and personal computers with graphical user interfaces at
Veterans Health Administration (VHA) facilities, as well as software
developed by local medical facility staff.
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Term

Definition

VIC Veteran ID card, one of several images that the IMPORT queue can import
from external applications.

VISN Veterans Integrated Service Network(s)

VistA Acronym for Veterans Health Information System Technology Architecture.

VistA Imaging Also called VistA Magnetic Cache, an alternative term for Tier 1. See Tier 1.

Cache Contrast with Caché.

VistA Imaging Same as VistA Imaging Cache. Contrast with Caché.

shares

VMC Acronym for VistA Magnetic Cache, an alternative term for RAID. See
RAID, Tier 1. Contrast with Caché.

Win32 The set Microsoft Windows operating systems internal function calls which
support all operating system activity.

WORM Acronym for Write Once Read Many.

Write Once Read
Many

Once written to the disc, data is only available for reading and cannot be
altered. Tier 2should be:

WORM-DG for Data General Jukeboxes under OpenNetware
WORM-PDT for Pegasus Jukeboxes

WORM-OTG for OTG Disk Extender

Note: WORM-DG and WORM-PDT are for backward compatibility only.
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BIG_JB_PTR- 114,117
% BIG_VC_PTR - 114, 117
BP Server Monitor
configuring - 140

% Free Space DICOM Messages - 26 daily monitoring - 142
% Server Reserve - 5, 36, 39, 88, 94, 123, 125, 146 description - 139
% Tier 1 Reserve - 22 email message sent - 92

monitoring the BP Purge - 144
monitoring the BP Queue Processor - 142

monitoring the BP Verifier - 143
scheduling - 140

...508 Compliance - 100 BP Servers
adding - 11
assigning tasks - 13

A assigning tasks to - 44

configuring - 10
required for processing - 67
server properties - 15
BPError log file - 83
Broker failure - 146

ABS_VC_PTR- 114,117
Abstract Files - 35
ABSTRACT queue - 14, 70
Access/Verify codes - 9, 146
Active parameter - 36, 37

Active queue list - 44

Active queue pointer - 44 c
Active queues - 99
Ad Hoc Enterprise Site Report - 83 Capture Keys, use - 24
Ad Hoc Image Site Usage message - 83 Check Image Text - 108
Alt JB Refs - 110 Check text files - 40, 42
Annotation diagrams - 52 Clinical Association Report (AP) - 105, 106, 155
Annotation tool - 61 Compression/decompression - 56
Application Process Failure message - 84 Configuring
Applications of the BP Processor - 1 BP applications, overall guidelines - 18
Archive Appliance - 145, 146 mail groups - 28
ASSOCIATED INSTITUTION field (#.04) - 84 mail messages - 26
Associated Institutions - 21 site parameters - 19
Auto option in BP Verifier - 108 Conflicting AP & Image DFNs - 105
Auto Purge - 36, 88 Conflicting GP and GO DFN - 106
AUTO PURGE queue - 14 Current_Write_PTR - 114, 117
Auto Write Location Update - 22 CWL - 112
Auto_RAID_Group_Purge message - 87
AutoRouter - 51
D
B Delay Between Queue Processing, Patch 196 - 79
DELETE queue - 14, 74
Background Processor Deleting queues - See Purging queues
applications of - 1 DFN Mismatches in AP Image Mult - 106
features - 4 DFN_1-118
VistA Imaging, in - 2 DFN_2-118
What is? - 1 DFNError log file - 117
BackProc log file - 82 Diagram Annotation tool - 61
Bad JB Refs - 110 Diagrams
Bad VC Refs - 110 annotation - 52
Big Files - 35 in Network Location Manager - 52
180 Background Processor User Manual, Rev 17 September 2018

VistA Imaging MAG*3.0*214



storage type - 62
DICOM Gateway
BP Server processing - 76
EVAL queue - 76
full and abstract files - 35
Interface Switch Update - 25
PAC files - 175
Write Location - 25
Domain, in adding mail groups - 30

E

EKG
in network location - 52
strips for viewing - 52

strips from local and remote MUSE servers - 59

where data is stored - 59
Email messages
Ad Hoc Image Site Usage - 83
Application process failure - 84
Auto_RAID_group_purge - 87
GCC Copy Error - 88
Get_Next_RAID_Group_failure - 88
Image Cache Critically Low - 89
Image_File_Size_Variance - 89
Imaging Integrity Check - 120
Imaging Site Verification Issue - 120
INSTALLATION - 89
listing - 83
Monthly Image Site Usage - 90
Photo ID Action - 91
Scheduled Purge Failure - 91
Scheduled RAID Group Advance Failure - 91
Scheduled Verifier Failure - 92
Site Report Task Was Restarted - 92
Verifier Scan Error log - 121
VI BP Eval Queue - 92
VI BP Queue Processor Failure - 93
Error_Level - 119
EVAL queue - 13, 76, 92, 139
EVAL, task in BP Server Monitor - 139
Excel spreadsheet - 81, 113, 132
Extensions on missing files - 102

GCC
Copy Error message - 88
Generic Carbon Copy field - 21
in Network Location Manager - 52
queue - 14, 74
queue for photo IDs - 66
window - 58
Generic carbon copy - See GCC
Get Next Raid Group Failure message - 88
GO DFN mismatches - 106
GP & GO AP Mismatch - 106
GP has no images - 105
GP Missing GO Ptr - 106

H

Hardware requirements - 7

Hash subdirectory - 51, 53, 54, 55, 56, 58, 111
Help, getting - 79

HTML files - 81, 112

F

F1 key for Help - 80

Failed image or entry - 48

Failed queue list - 44

Failed queues - 99

File types - 23, 174

Full files - 35

FULL_JB_PTR- 114, 117
FULL_VC_PTR - 114, 117
Functional flow of VistA Imaging - 3

IEN
count tranversed in Purge - 131
for IMPORT queue - 98
for processing in Verifier - 102
image record currently being processed - 111
in NETWORK LOCATION file - 78
in Process Queue - 79
in record number in Network Location - 62
in Scheduled Verify - 15
in the NETWORK LOCATION file - 109, 110
integrity checks - 104
marked by Offline Image utility - 144
patient data integrity check - 103
range to set in Verifier - 108
record in Network Location - 53

record number in Network Location - 54, 56, 58, 59, 61

text file integrity check - 107

verifying - 103

verifying range - 143

verifying range copied to Image shares - 143
IMAGE AUDIT file

file integrity - 104
IMAGE AUDIT file (#2005.1)

duplicate image entries - 110

Full image - 111

No Archive log file - 115
Image Cache Critically Low message - 89
Image entry is structurally abnormal - 106
IMAGE file (#2005)

file integrity checking - 104
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Full image - 111
patient integrity checking - 105, 106
running Verifier - 103

validating network file references - 183

Image File Size Variance message - 89
Image_Class - 119

Image_IEN - 118

IMAGE_PTR - 116

IMAGING SITE PARAMETERS file (#2006.1) - 9, 84

Imaging Site Usage report - 92
IMPORT queue - 14, 72, 96
Import queue properties - 50
Import Queue Security - 21
IMPORT Queue Status report - 96

Installation - See the Background Processor Patch

Description
INSTALLATION message - 89
Integrity

checks - 101

image file - 104

patient - 105

text file - 107
Internal Entry Number - See IEN
Invalid Image Ptr to AP - 105

J
JB Big - 112
JB Full - 111

JBPath1-112

JB Path2-112

JB_ALT_1-114

JBTOHD queue - 14, 69

JUKEBOX
in Network Location Manager - 51
queue - 14,73

Jukebox Write Location - 22

L

log directory, default - 16
Log files
BackProc - 82
BPError - 83
DFNError - 117
NoArchive - 115
Purge.html - 133
PurgeError.html - 134
Scan Log File - 113
ScanError - 116

specifying location and size on a BP Server - 15

MAG SERVER - 83
MAG SYSTEM security key - 8, 9, 25, 30

MAG WINDOWS secondary menu option - 8, 25, 77

MAG WINDOWS security key - 9
MagBPSetup.exe - 7
Magbtm.exe - 7
MagDexter utility, description of - 6
MAGEVAL - 140
MAGFQ - 140
MagKat utility, description of - 6
MAGMIN - 140
MAGnNH - 51
MagPurge.exe - 7
MAGQ BPMONITOR - 92, 140
MAGQ BPMONITOR menu option - 92
MagUtility utility, description of - 6
MagVerifier.exe - 7
Mail groups
adding members - 30
adding remote members - 30
configuring - 28
deleting members - 31
displaying lists of users - 29
domain - 30
guidelines for adding - 30
MAG SERVER - 83
MEMBERS REMOTE - 83
specifying properties - 31
Mail messages - 26
adding names - 27
configuring - 26
displaying lists of users - 27
fields descriptions - 28
notification intervals - 28
removing names - 27
transmission frequency - 28
MEMBERS REMOTE - 83
Memo - 119
Mismatches - 101
Missing files in Verifier - 102
Missing Group Objects - 106
Monthly Image Site Usage message - 90
MUSE
default site number - 24
locations on EKG tab - 59
remote GE Muse server - 52
server - 59
setting for site location - 21
site # - 60
version # - 60

M
MAG ENTERPRISE - 83
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N

Namespace - 21
NameSpace, multiple - 23
Network bandwidth - 8
Network configuration - 2
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Network connection, troubleshooting - 145
Network Location Manager
adding a new network location - 62
configuring - 51
modifying properties - 64
window - 50
No AP entry Ptr - 106
No AP Mult Ptr - 106
No AP Ptr - 106
No Image Ptrin AP - 105
NoArchive log file - 115
Not enough process memory - 146
Not enough server cache - 146
Not enough write cache available - 146

o

operational status - 53, 55, 56, 58, 60, 61, 62, 111

results output - 135
retention days, configuring - 36
retention times, guidelines for setting - 34
Scheduled - 126
scheduled and express, configuring - 37
scheduled settings - 36
scheduled, running - 38
setting parameters - 124
settings - 33
troubleshooting - 157
What is? - 1
Purge Error log file - 134
Purge Events Table - 126
Purge Factor - 36, 37, 39
Purge log file - 133
Purge queue by type entries - 98
Purge Rate - 37

P

Package - 118
Package_IEN - 119
PACS UID - 107
PACS UID field #60 - 107
PARENT DATA FILE file (#2005.03) - 106
Partition, queue - 49
Password, Windows - 25, 56
Patient ID - 107
Patient_Name_1-118
Patient_Name_2 - 118
Percent Server Reserve - 89, See % Server Reserve
Permissions
EXPORT share - 8
IMPORT share - 8
READ/WRITE on the domain acct - 8
READ/WRITE on the share/folder/file - 8
Photo ID Action message - 91
Photo IDs - 35, 58, 66, 91, 131
Physical reference - 53, 54, 56, 58, 60, 61, 62, 109, 111
PLACE value - 84
pointer - See Queue partition
PREFET queue - 14, 70
Purge
Auto - 125
auto purge, running - 39
automatic - 37
date criteria, configuring - 38
description - 123
express - 125
express settings - 36
file types purged - 125
manual - 37,126
processing, understanding - 123
queues - 47
result codes - 126
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Q

Queue Management by Type option - 76
Queue Manager
active/failed status counts - 44
description - 44
priority order - 44
window - 45
Queue Processor
description - 44, 67
setup guidelines - 67
starting the application - 77
tasking - 68
understanding processing - 76
What is? - 1
Queues
ABSTRACT - 70
accessing failed Import Queue properties - 50
active queue pointer - 44
assigning to BP Servers - 13
concept of - 68
corrupted entry - 49
DELETE - 74
EVAL - 76
GCC-74
IMPORT - 72
JBTOHD - 69
JUKEBOX - 73
PREFET - 70
purging - 47
re-queuing - 48
setting partition - 49

R

RAID Group Advance - 5
RAID Groups
advance settings - 42
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automatic RAID Group advance - 5
current - 21
description - 4
guidelines for setting parameters - 43
guidelines on shares - 4
in Network Location Manager - 51
running the Scheduled RAID Group Advance - 43
setting parameters for RAID Group Advance - 43
Write Location - 21

Range - 108, 109

Rehabilitation Act of 1973 - 100

Reports - See Log File, Emails, and Screen-Generated
Output

Re-queuing a failed image - 48

Re-queuing entries to be kept - 99

Retention Days DICOM Messages - 26

Retention Days HL7 — Modality Work Lists - 26

Retention days, configuring - 36

ROUTE.DIC - 51, 56

Router in Network Location Manager - 51

Routing rules file - 51

RPC Broker, configuring - 172

SSN_1-118

SSN_2-118

Status counts, active/failed - 44
Storage Type - 78

Study Instance UID - 107

S

Scan - 108
Scan log file - 113
ScanError log file - 116
Scheduled Purge Failure message - 91, 135
Scheduled RAID Group Advance Failure - 91
Scheduled Verifier Failure message - 92
SCHEDULED VERIFIER task - 101
SCHEDULED VERIFY queue - 15
Screen-generated output
508 Compliance - 100
IMPORT Queue Status - 96
JBTOHD Report - 95
Purge Queue by Type entries - 99
Server Size - 94
Section 508 - 100
Security
Windows - 8
Security keys
MAG SYSTEM - 8, 9, 25
MAG WINDOWS - 9
Server Size, output - 94
Setting up your BP system - 7
Setup requirements - 8
Site
code - 21
configuring parameters - 19
name of remote location - 57
Site Report Task Was Restarted message - 92
Site usage report - 90
Software requirements - 7

T

Tape backup - 81
Tasks
ABSTRACT - 70
assigned as queues - 14
assigned to BP Servers - 67
DELETE - 74
EVAL - 76
GCC-74
IMPORT - 72
JBTOHD - 69
JUKEBOX - 73
PREFET - 70
Timeout VistARad - 24
Timeout Windows Capture - 24
Timeout Windows Display - 24
Transmission frequency, mail messages - 28
Troubleshooting
broker failure - 146
general startup - 145
integrity messages on patient data - 155
network connection - 145
not enough process memory - 146
not enough server cache - 146
not enough write cache available - 146
output HTML messages - 153
Purge - 157
Verifier - 152

U

UlID field - 107
UNC - 56, 58, 60, 62, 78
URLs - 52
in Network Location Manager - 52
storage type - 61
WEB service location - 61
window - 60
User Preference, default - 24
Username, Windows - 25, 56

4

Variance -89
VC Abstract - 112

SOP - 107 VC Big - 112
SOP Instance - 107 VCFull - 112
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description - 101

integrity checks - 104
integrity samples - 178
maintenance operations - 103
manual - 41

missing files - 102

processing - 102

reasons for running - 103
scheduled, guidelines for setting - 41
scheduling - 41

setting up - 101

settings - 40

starting - 108

tasking - 101
troubleshooting - 152

What is? - 1

VI BP Eval Queue message - 92
VI BP Queue Processor Failure message - 93
VistA Access - 25
VistA Imaging

functional flow - 3

VistA Verify - 25
VistARad Grouping - 21

Watermarking Successful messsage - 93
WEB service - 60, 61

Windows
BP Verifier - 108
Diagrams - 61
EKG - 59
Event Log - 82
GCC-58

GO VistA Storage - 94

Imaging Site Parameters - 19
IMPORT Queue Status - 96
JBTOHD Report - 95

Jukebox - 54

Mail Groups - 29

Mail Message Manager - 26
Network Location Manager - 50
Purge / Verifier / RAID Groups - 33
Queue Management by Type - 99
Queue Manager - 45

Queue Processor application - 77
Routers - 55

URLs - 60

WORMOTGnRH - 51

w

Watermarking Failed message - 94
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